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Part I: Introduction






Chapter 1: Introduction to D-Command

Welcome to the D-Command®worksurface for Avid® ICON
systems. D-Command provides hands-on control of

Pro Tools® and offers powerful options for customizing the
Pro Tools mix environment.

D-Command Features

D-Command provides controls for Pro Tools
recording, editing and mixing tasks, and a versatile
remote-controlled audio monitoring system.

Control Features
o Touch-sensitive, motorized 100mm faders
o Touch-sensitive, multi-purpose rotary controls

 Dedicated controls for assignment and activation of inputs,
outputs, inserts and sends

« Flexible display of pan, insert, send, plug-in and mic pre
controls

« Dedicated EQ and dynamics plug-in control sections

 Dedicated controls for all channel strip functions including
recording and input monitoring modes, mute, solo, and
channel select

o Dedicated controls for automation mode, enable and safe
status

« Flip Mode for transfer of parameters from rotary controls to
faders

« Custom Fader Mode for flexible channel and parameter
mapping

o Full transport and navigation controls, including location
commands and scrub/shuttle capability

Monitoring Features

+ 6-channel control room monitoring system supports mono
through 5.1 surround monitoring, with up to five possible
input sources and three selectable output paths

o 2-channel cue system with 4 separate outputs and selectable
talkback feed

o Built-in talkback microphone and external talkback mic
input

« Standalone mode for monitoring without Pro Tools

« External source metering

D-Command System Components

The following components are included in a D-Command
8-channel, 24-channel, or 40-channel system:

Main Unit
o D-Command Main Unit
« AC power cord
« Standard Ethernet cable

« Ethernet “crossover” cable (for direct connection to CPU
without a hub)

o Ethernet loopback plug (for Ethernet testing)
 9/64-inch hex driver (for removing side panels)

+ 5/32-inch hex driver (for connecting Main Unit and Fader
Module)

Fader Module

(Required for 24- and 40-Channel Systems)
o D-Command Fader Module unit
« AC power cord
o Ethernet cable

XMON Monitoring System
« XMON Interface
« AC power cord
« XMON cable

System Expansion Options

One or two additional 16-channel Fader Modules can be added
to D-Command, for a total of 24 or 40 faders.

A D-Command Producer’s Desk option with integrated com-
puter keyboard, USB hub, and computer display shelf is also
available.

For details on D-Command expansion and customization
options, visit www.avid.com.
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Operational Requirements

Temperature and Ventilation

D-Command should be installed and operated in a cli-
mate-controlled environment, away from heat sources, and
with adequate ventilation. D-Command should be operated at
an ambient temperature that does not exceed 100 degrees F
(35 degrees C).

The back panel and the front half of the bottom panel of each
unit should be exposed to ambient air. Blocking or partially
blocking the back panel or bottom panel of a D-Command unit
may cause the unit to malfunction and may void your war-
ranty.

Water and Moisture

D-Command units should be operated away from sources of
moisture or humidity and should be protected from liquid
spills.

Cleaning and Maintenance

If you need to clean the D-Command top surface, apply a
non-chlorine bleach based cleaning solution to a cloth or
paper towel, then carefully wipe the surface. Do not use
abrasives, cleaning solutions with chlorine bleach, or spray
cleaners.
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Connection Requirements

Power Connections

Each unit (D-Command Main Unit, Fader Module, and XMON
Monitor Interface) requires its own power connection.

Make sure your power source is correctly rated for the number
of units you are connecting. A surge protected power source
(not included) is highly recommended.

Ethernet Connections

Each D-Command unit communicates with Pro Tools using
Ethernet. A single Main Unit can be connected to the host
computer with the included crossover Ethernet cable (no
Ethernet hub is required).

To connect multiple D-Command units to the host computer,
an Ethernet hub (not included) and standard Ethernet cables
are required.

Audio Connections

All external analog audio inputs and outputs for control room
monitoring and studio communication are connected to the
XMON interface. D-Command connects to the XMON inter-
face with a single 15-pin cable (included). All analog inputs
and outputs on the XMON use DB-25 connectors.

Audio Cables for D-Command Monitoring

Avid offers a range of cabling options for connecting inter-
faces and external sources to the XMON monitoring system.
For details, visit www.avid.com.

System Requirements and
Compatibility

D-Command requires a qualified system running Pro Tools
HD or Pro Tools with Complete Production Toolkit.

An expanded HD-series system is required for higher track
counts.

For complete system requirements and a list of qualified
computers, operating systems, hard drives, and third-party
devices, visit www.avid.com/compatibility.



Mechanical Specifications
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Chapter 2: D-Command Overview

D-Command Main Unit

Main Unit Top Panel

Talkback Microphone Main Time Scale display

Meter
section

Miscellaneous
controls

Rotary Encoder.
section

Channel Strip____|
Mode controls

Channel Strip
Function
controls Soft Keys
[ section
Session
Management
Channel section
faders
2 E Transport | Zoom/Navigation
= = Section section
Modifier o oool | seee
keys

Global Automation Mode Custom Fader Window Nudge/Bank
controls controls controls Management section
section

Figure 1. D-Command Main Unit top panel
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Meter Display

The Meter display on the D-Command Main Unit can be set to
show the output levels, or levels associated with a track or
plug-in. See “Meter and Timecode Displays (Main Unit)” on
page 103.

Main Time Scale Display and Location Indicator

The Main Time Scale display and Location indicator mirrors
the Main Time Scale in Pro Tools. See “Meter and Timecode
Displays (Main Unit)” on page 103.

Dynamics and EQ Sections

The D-Command Main Unit provides dedicated Dynamics and
EQ sections for plug-ins that support Dynamics and EQ
plug-in mapping. See Chapter 7, “Plug-In Controls.”

Monitor Section

The Monitor section on the D-Command Main Unit includes a
full set of controls for the control room, headphone/cue, and
talkback/listenback sections of D-Command. See “Monitor
Section Controls” on page 95.

Zoom/Navigation Section

The Zoom/Navigate section on the D-Command Main Unit is
used to control navigation, display, and selections in the

Pro Tools Edit window. See “Zoom/Navigate Section” on
page 80.

Nudge/Bank Section

The Nudge/Bank section on the D-Command Main Unit is
used to control the display of Pro Tools tracks on the control
surface. See “Nudge/Bank Section” on page 80.

Window Management and Session Management
Sections

The Window Management and Session Management sections
on the D-Command Main Unit include controls for opening
and closing Pro Tools windows, and managing and saving
Pro Tools sessions. See “Window Management Section” on
page 83 and “Session Management Section” on page 84.
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Soft Keys Section

The Soft Keys section on the D-Command Main Unit provides
access to a wide range of Pro Tools commands directly from
the control surface. It also provides access to preferences and
settings specific to D-Command. See “Soft Keys Section” on
page 85.

Transport Section

The Transport section on the D-Command Main Unit includes
a full set of transport controls, switches for setting the trans-
port mode, scrub/shuttle controls, as well as advanced audi-

tion and locate controls. See “Transport Section” on page 75.

Global Controls

The Global controls are a set of channel-related controls in the
center of the D-Command Main Unit, allowing easy access to
powerful assignment, display, and channel function controls.
See “Global Controls Section” on page 42.

Custom Fader Controls

The Custom Fader mode switches on the D-Command Main
Unit invoke a special set of D-Command modes, called Custom
Fader modes, which let you set aside and customize channel
strips for display and editing of a variety of functions. See
“Custom Fader Controls” on page 48.

Automation Mode Controls

The Automation Mode controls mirror the function of the
on-screen Automation Mode selector for each track, and let
you change automation modes during playback. See “Automa-
tion Mode Controls” on page 49.



Main Unit Back Panel

Power switch

|
—I-

0@6

AC Power

Figure 2. D-Command Main Unit back panel connectors

AC Power

The AC Power connector accepts a standard AC power cable.
The D-Command Main Unit is auto power-selecting (100V to
240V) and automatically works with a standard modular
power cord when connected to an AC receptacle in any
country.

Power Switch

The Power switch applies power to the D-Command Main
Unit.

Footswitch Jack

The footswitch jack on the back panel of the D-Command
Main Unit is a 1/4-inch TRS jack that supports two footswitch
connections. See “Footswitch Connections” on page 19.

XMON Monitoring System

Footswitch jack
connector

Ethernet connector

Ethernet Connector

The Ethernet connector on the back panel of the D-Command
Main Unit provides communication to Pro Tools. See “Ether-
net Connections” on page 19.

XMON Monitoring System Connector

The 15-pin connector on the back panel of the D-Command
Main Unit provides remote control of all audio monitoring
functions from the D-Command Monitoring section. See
“XMON Monitoring System Connection” on page 20.

Chapter 2: D-Command Overview 9



D-Command Fader Module

Fader Module Top Panel

Meter
section

Rotary Encoder
section

Channel Strip
Mode controls

Channel Strif)
Function controls

Channel Strip

Channel faders

Modifier keys

Figure 3. D-Command Fader Module top panel

Meter Section

The Meter section on the D-Command Fader Module can dis-
play track levels, plug-in meters, and other parameters de-
pending on D-Command metering preferences.

Channel Strip

Each channel strip on the D-Command Fader Module has
identical channel controls, including two touch-sensitive ro-
tary encoders, display and mode controls, and a touch-sensi-
tive fader. See “Channel Strips” on page 35.

Modifier Keys

Each D-Command Fader Module has a set of four switches in
its lower left corner that duplicate the function of the

Pro Tools computer keyboard modifiers. See “Modifier Key
Switches” on page 42.
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Fader Module Back Panel

AC Power

The AC Power connector accepts a standard AC power cable.
The D-Command Fader Module is auto power-selecting (100V
to 240V) and automatically works with a standard modular
power cord when connected to an AC receptacle in any
country.

Power Switch

The Power switch applies power to the Fader Module.

Ethernet Connector

The Ethernet connector on the back panel of the D-Command
Fader Module provides communication to Pro Tools. See
“Ethernet Connections” on page 19.



XMON Interface

D-Command monitoring is based on the XMON analog interface, which is remotely controlled from the D-Command

monitoring section.

XMON Front Panel

Power
switch

Mute MIDI Receive
indicator indicator

Mute button

Figure 4. XMON front panel

Power Switch

The Power switch applies power to the XMON Interface.

Mute Indicator

The Mute indicator shows the mute status of XMON.

MIDI Receive Indicator

The MIDI Receive indicator shows MIDI activity between
XMON and D-Command.

Mute Button

The Mute button mutes all XMON outputs. It is not possible to
unmute XMON with this button. The XMON mute state can
only be cleared from the D-Command Monitor section (see
“Monitor Section Controls” on page 95).

Chapter 2: D-Command Overview 11



XMON Back Panel
The back panel of the XMON interface includes connectors for all external analog audio inputs and outputs for D-Command. See

“Audio Connections” on page 20.

Cue Inputs Main Inputs Surround Inputs Stereo Inputs

STERE(| INPUTS.

cuE I[ipuTs MAIN [VPUTS SURROUI|D INPUTS

C([( ‘‘‘‘‘‘‘‘‘‘‘‘‘‘‘‘‘‘‘‘‘‘‘‘‘ )])D C([( ''''''''''''''''''''''''' )])3 C([( ''''''''''''''''''''''''' )])3 9d.igidesign Iy

SERAL NUMBER

ACIO024005060HZ, 54450

C([( ............. )]> C([( ............. )]> C([( ........................ )]b C([( ......................... )]b | @ é é é é é é é| T @

Cue Outputs Main Outputs Alt Outputs  Talkback/ Meter Calibration Control Surface ~ AC Power
Listenback/ Screws
Utility

Figure 5. XMON back panel
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Chapter 3: Setting Up Fader Modules

This chapter explains how to add Fader Modules to the
D-Command Main Unit.

Placement of D-Command Fader Modules

When placing the D-Command Fader Module in studio furni-
ture or on a table top, make sure to account for the dimensions
of the assembled system, allowing for at least 1 inch (2.5 cm)
of open space behind the finished unit. This meets the venti-
lation requirements for the D-Command units.

When bracketing together your system, you will need addi-
tional clearance on either side of the unit to push the Fader
Module and the Main Unit together, as well as sufficient clear-
ance in front and behind the units to allow you to attach the
brackets. You will also need access to the rear of the unit to
make cable connections.

Assembling an Expanded System

The D-Command Main Unit can be attached to the D-Com-
mand Fader Module using the front, middle, and rear brackets
included with the D-Command Fader Module.

Rear bracket

Center bracket

Front bracket

Figure 1. D-Command with Fader Module (bottom view)

Assembly Hardware

The following hardware is provided with the D-Command
Fader Module (spare pieces may be included).

Brackets
« Front Bracket
« Center Bracket

o Rear Bracket

1

9420138690

L

Front bracket Center bracket Rear bracket

Figure 2. D-Command expanded system connecting brackets

Screws
 (4) 6-32 x 3/8-inch Philips pan head screws
e (10) 10-32 x 3/4-inch socket cap screws

6-32 x 3/8-inch
Philips pan head screw

10-32 x 3/4-inch
socket cap screw

Figure 3. Screws for D-Command connecting brackets

Chapter 3: Setting Up Fader Modules 15



Positioning the D-Command Units 40-Fader System plus Producer’s Desk

Options for positioning your D-Command Main Unit and If you are building a 40-fader D-Command, you can place the
Fader Module depend on the size of your D-Command con- Main Unit in the following positions relative to the Fader
sole. Modules.
24-Fader System
If you are building a 24-fader D-Command you can place the Fad Mai Fader Main in center
Main Unit to the left or to the right of the Fader Module. ader an
Fader Main Main on right
Fader Fader Main Main on right
Main Fader Main on left
Figure 4. 24-fader system (possible configurations)
Main Fader Fader Main on left

Figure 5. 40-fader system (possible configurations)

A If you are placing the Fader Module to the right of the Main
Unit, you need to move the spacer plate from the Fader
Module to the Main Unit. Refer to “Moving the Spacer
Plate” on page 17 for detailed instructions on moving the
spacer plate.

16 D-Command Guide



Attaching the Units

To attach the D-Command Fader Module to the Main Unit:

1 Using a 9/64 hex wrench, remove the plastic end cap from the
side of the Main Unit where you want to install the Fader Mod-
ule.

2 If you are installing the Fader Module on the right of the
Main Unit, move the spacer plate. (See “Moving the Spacer
Plate” on page 17.)

3 Place the Fader Module next to the Main Unit, and press the
units together.

4 Slide both units forward so that you have access to the front
bracket screw holes.

5 Using a 5/32 hex wrench, attach the front bracket, using four
10-32 1/2-inch socket cap screws.

A When bracketing together a D-Command system, leave all
screws on the Fader Module loose enough to allow you to ad-
just the position of the units relative to each other. After all
three brackets are installed, and the units are pressed fully
together, then fully tighten the Fader Module screws.

6 Slide the connected units backward so that you have access
to the rear screws.

7 Remove the four Philips head screws indicated in Figure 6.

Remove screws

Figure 6. Rear view of D-Command and Fader Module

8 Attach the rear bracket, using four 10-32 3/4-inch socket cap
screws and four 6-32 x 3/8-inch Philips pan head screws.

9 Carefully slide the connected units forward so that you have
access to the center bracket screw holes.

10 Attach the center bracket, using two 10-32 3/4-inch socket
cap screws.

11 Press the D-Command units together. If necessary, use a
ratcheting nylon strap to press the units together by running
the strap around the two units. Make sure the nylon strap does
not contact any switches or encoders on the surface.

12 Tighten the bracket screws on the Fader Module.

13 Attach the plastic end cap to the Fader Module.

Moving the Spacer Plate

There is a metal spacer plate pre-installed on the right side of
the Fader Module. When installing the Fader Module on the
right of the Main Unit, you will need to remove the spacer
plate from the Fader Module and place it on the right side of
the Main Unit.

A Do not use a power screwdriver or similar high-torque de-
vice to remove and replace the screws for the spacer plate, as
it might strip the threads in the screw housing.

To move the spacer plate:

1 Remove the screws holding the spacer plate in place. Make
sure to note the location of the long and short screws as you re-
move them.

long screws (6)

%o/ ° o
9\\% ’
short screws (3)

Figure 7. D-Command Fader Module spacer plate

2 Remove the spacer plate from the right side of the Fader
Module.

3 Replace the screws in the side of the Fader Module, making
sure to replace the long and short screws in their correspond-
ing holes.

4 Remove the corresponding screws from the right side of the
Main Unit, and attach the spacer plate with the same screws.

A The holes on the spacer plate are countersunk for installa-
tion on the right side of a unit. Do not attach the spacer
plate to the left side of any D-Command unit.

Chapter 3: Setting Up Fader Modules 17
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Chapter 4: Connecting D-Command

D-Command Connections

D-Command units require power and Ethernet connections to operate with Pro Tools. An optional footswitch connection is also
available on the Main Unit. The connectors on the back panel of the D-Command Main Unit are shown in Figure 8.

Be sure to make all connections with your D-Command units and computer turned off.

Ethernet connector

Footswitch jack

XMON Monitoring System connector

Figure 8. D-Command Main Unit back panel connectors

Power Connections

Each D-Command unit (Main Unit and Fader Module) and the
XMON Monitor Interface requires its own power connection.
D-Command Main Units, Fader Modules, and XMON Inter-
faces are auto power-selecting (100V to 240V) and automati-
cally work with a standard modular power cord when con-
nected to an AC receptacle in any country.

Ethernet Connections

Each D-Command unit communicates with Pro Tools using
Ethernet. The D-Command Main Unit includes a standard
Ethernet cable and a special crossover Ethernet cable for di-
rect connection between the Main Unit and the host com-
puter. Each Fader Module includes a standard Ethernet cable
for use with an Ethernet hub.

If you are connecting only one D-Command unit to your
computer:

1 Connect one end of the supplied crossover Ethernet cable to
the Ethernet port on the back panel of D-Command.

2 Connect the other end of the crossover Ethernet cable to the
appropriate Ethernet port on the computer.

If you are connecting more than one D-Command unit to your
computer:

1 Install an Ethernet hub (not included) according to its in-
structions, apply power to it, and verify that it is functioning

properly.
2 Connect the Ethernet hub to the appropriate Ethernet port

on your computer with a standard Ethernet cable (do not use
the crossover cable to connect to an Ethernet hub).

3 For each D-Command unit, connect one end of the supplied
standard Ethernet cable to a port on the Ethernet hub (do not
use any port labeled for LAN connection), and connect the
other end of the standard Ethernet cable to the Ethernet port
on the unit.

Controlling Pro Tools Systems Over a Network

When D-Command is connected to an Ethernet network, it
will be available to be declared by any Pro Tools system on
that network. This lets you control different Pro Tools sys-
tems on the network with a single D-Command console. (You
can only control one Pro Tools system at a time.)

For more information on switching control between systems,
see “D-Command Multi-Mode” on page 81.

Footswitch Connections

You can connect two SPST (single-pole, single-throw) foot-
switch units to the D-Command Main Unit to control any of
the following functions:

o Starting and stopping Pro Tools playback
« Starting Pro Tools recording
« Toggling Talkback on and off

The footswitch connector is a single 1/4-inch TRS jack on the
back panel of the D-Command Main Unit.

To wire a TRS connector for the D-Command footswitch jack:

= Use the following wiring convention:
« Tip = Footswitch 1
« Ring = Footswitch 2

o Sleeve = Ground

Chapter 4: Connecting D-Command 19



Audio Connections

D-Command monitoring is based on the XMON analog interface, which is remotely controlled from the D-Command monitoring
section. All external analog audio inputs and outputs for control room monitoring and studio communication are connected to
the XMON interface.

XMON provides 18V phantom for its three external mic inputs (External Talkback Mic, Listen Mic 1, Listen Mic 2).

All audio connections are made with standard DB-25 connectors. The back panel of the XMON is shown in Figure 9.

Cue Inputs Main Inputs Surround Inputs Stereo Inputs

cuE Ifiputs MAIN [VPUTS SURROUI|D INPUTS STERE(| INPUTS

C([( ......................... )])3 <[( _________________________ )])3 C([( _________________________ )])3 gd_i.g'i.desig'n

CUE OUTPUTS MAIN OUTPUTS ALT OUTPUTS TB/LB/UTIL l— METER CAL —l CONTROL @
1 ] ‘

Cue Outputs Main Outputs Alt Outputs  Talkback/ Meter Calibration Control Surface ~ AC Power
Listenback/ Screws
Utility

Figure 9. XMON back panel

XMON Monitoring System Connection
D-Command connects to XMON with a single 15-pin XMON cable. A 50-foot (15.25 m) cable is included with the D-Command
Main Unit. The system supports up to an 80-foot (24.5 m) cable.

To connect the XMON to D-Command:

1 Connect the included AC power cord to the back panel of the XMON and to a power source. A surge protected power source is
highly recommended.

2 Connect one end of the included XMON cable to the Control Surface port on your XMON unit, and the other end to the 15-pin
XMON Monitoring System connector on the back panel of the D-Command Unit.
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Control Room Monitoring Connections

AFL/PFL Pro Tools
Solo

AFLIPFL ) Level %a A Command
nput —
(2 channels)

Main E E

6 chanlggllét) >_;_/.- E
' '

Surround i E
ooty P
' ‘

Stereo 1 E E

2 chanlggllét) >_'_/.- E
1

Level, Dim,
Solo, Mute,
Trim + Cal

! —

' *—e Mono

Stereo 2 : Summing
Input )—;—/'.-
(2 channels)

Stelreo 3
nput ’_,_(
(2 channels) H *Thrut

— ¢ ®

' Source
[ Select
List Level
isten
Micl ,}{)
. Level
Listen

Figure 10. Control room monitoring system block diagram

Inputs

Main Inputs (6 channels), balanced, +4 dBu (from Pro Tools)

Surround Inputs (6 channels), balanced, +4 dBu

Stereo 1 Inputs (2 channels), balanced, +4 dBu/-10dBV

Stereo 2 Inputs (2 channels), balanced, +4 dBu/-10dBV

Stereo 3 Inputs (2 channels), balanced, +4 dBu/-10dBV

AFL/PFL Inputs (2 channels), balanced, +4 dBu

Listen Mic 1 (external), mic level (XMON provides 18V phantom power)
Listen Mic 2 (external), mic level (XMON provides 18V phantom power)

Outputs

Main Control Room Outputs (6 channels), balanced or unbalanced, +4 dBu
Alt Control Room Outputs (6 channels), balanced or unbalanced, +4 dBu

Mini Control Room Outputs (2 channels), balanced or unbalanced, +4 dBu

Main Output

Control Room (6 channels)
Output Select

‘/. } Alt Output

(6 channels)
®

Mini Output
(2 channels)

—} [To Cue System]
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Headphone/Cue System Connections

Main Monitor
Input %
(2 channels)
[from Control Room System]
Talkback/Slate Out
} (1 channel)
Cuel "—k._ o
Input ° E el ' Cue 1 Out
(2 channels) P A (2 channels)
] b .+
Input * ' ' Cue 2 Out
(2 channels) ! ./, 1 (2 channels)
re” o]
——o : E
° . ! HP Out
. / ! (2 channels)
: b 1
Internal * : ; Studio LS
Talkback ! _/, . (2 channels)
Tlr}};ebrnall( Level ndan
alkbac! }735— L. r
Talkback
Input switch Talkback
External Assign
Talkback _L.—

External Level
Talkback
Input

Figure 11. Headphone/Cue system block diagram

Inputs
« Main Monitor Input (2 channels)
o Cue I Input (2 channels), balanced, +4 dBu
« Cue 2 Input (2 channels), balanced, +4 dBu
o Internal Talkback Mic (from internal mic)

o External Talkback Mic, mic level (XMON provides 18V phantom power)

Outputs
e Cue 1 (2 channels), +4 dBu
o Cue 2 (2 channels), +4 dBu
« Headphone (2 channels), to internal headphone jack
« Studio Loudspeaker (2 channels)
Talkback/Slate Output (1 channel)
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Example XMON Wiring Diagram

The following diagram shows basic XMON connections for a Pro Tools|HD system with an HD I/0 that has 16 analog outputs.

HD I/O

XMON

ANALOG INPUT
+4 dBu BALANCED

-10 dBV BALANCED.

DIGITAL I/0

AES/EBU 1O

ADAT  ADAT

(ool

TOIF U0

ANALOG OUTPUT

BALANCED

©@ © © @ © © © ©

o‘ C
o o
— — = ®

@ ©®

@

Analog Outputs 1-8

Analog Outputs 9-16

DB-25 to DB-25

connectors
Cue Inputs Main Inputs
17 digidesigmn [T {}
C(K ..................... )])3 C([( .................... )])3 C([( ...................... )])3 <[( .................. )])3 |® é é é é é é é (m)
Cue Outputs  Main Outputs  Alt Outputs Talkback/Listenback
To To To To
Cue System Main Alternate Various
Amplifiers Speakers Speakers Inputs
and
Outputs
DB-25 to XLR
+ * snakes
1-2: Studio 1=L 1=L 1 = Ext Talkback Mic Input
3-4:Cue 1l 2 =(Lc¥) 2 =(Lcv) 2 = Listen Mic 1 Input
5-6: Cue 2 3=C 3=C 3 = Listen Mic 2 Input
4 = (Rc*) 4 = (Rc¥) 4 =AFL Input 1
5=R 5=R 5= AFL Input 2
6=Ls 6=Ls 6 = Mini Speaker Out 1 (L)
7=Rs 7=Rs 7 = Mini Speaker Out 2 (R)
8 =LFE 8 =LFE 8 = Talkback/Slate (Out)

* Main Speaker Outputs 2 and 4 are active on XMON, but Lc and Rc outputs cannot be controlled independently
from the D-Command monitor section. Global Volume, Solo, and Mute controls affect all outputs.

Figure 12. Wiring diagram for HD 1/0 and XMON
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Chapter 5: Configuring D-Command

Starting Up and Shutting Down the
System

Your D-Command-based system must be started up and shut
down in a specific order.

Start your D-Command-based system in this order:

1 Turn on external hard drives first. Wait 10 to 15 seconds for
them to come up to speed.

2 Turn on the D-Command units.

3 If you plan to work with MIDI equipment, turn on MIDI in-
terfaces and other MIDI devices.

4 Turn on all Pro Tools audio interfaces.
5 Turn on the computer.
6 Turn on the XMON interface.

7 Turn on monitor amplifiers or self-powered speakers.

Shut down your D-Command-based system in this order:

1 Turn off monitor amplifiers or self-powered speakers.
2 Turn off the XMON interface.

3 Turn off all Pro Tools audio interfaces.

4 Shut down the computer.

5 If using MIDI equipment, turn off MIDI interfaces or con-
trollers.

6 Turn off the D-Command units.

7 Turn off external hard drives.

Software Configuration

All D-Command software is included when Pro Tools software
is installed. The Pro Tools software installer places the
D-Command Personality folder on the system drive.

Refer to the Getting Started Guide that came with your system
for instructions on installing or updating Pro Tools software.

Updating System Firmware

Each release of Pro Tools software includes the most current
D-Command firmware. When you declare a D-Command unit
in the Pro Tools Peripherals dialog, Pro Tools compares the
firmware of all connected units to the version available in
Pro Tools software, and prompts you if an update is available.

If you are prompted to update firmware, follow the on-screen
instructions to load the latest firmware to each D-Command
unit.

Declaring D-Command Units in Pro Tools

Communication between D-Command and Pro Tools is con-
figured from Pro Tools.

To declare D-Command units in Pro Tools:

1 Choose Setups > Peripherals, and click Ethernet Controllers.

B Enable | Ethernet | 08

Enable ELCON

Cancel —o—3

Ethernet Controllers display in the Peripherals dialog

2 Select Enable. Pro Tools scans the Ethernet connection for
any Ethernet controllers connected to the system.

3 Select the units in the order you want them arranged left to
right.

“CY It is not necessary to declare units in the same sequence
as they are physically arranged.
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As each unit is selected, Pro Tools scans it and brings it online.
The current status of each unit is indicated in the Peripherals
dialog in the following ways:

« Bold indicates a connected unit.
« Italics indicate an offline or disconnected unit.
+ Underlining indicates that the selected unit is in use by

another Pro Tools system.

4 After declaring one or both units, click OK to close the
Peripherals window.

When communication is established, Pro Tools displays col-
ored outlines identifying each bank of Pro Tools tracks.

The colors in each unit row are used to identify controller fo-
cus on-screen in Pro Tools. The bank, track, insert, send, or
other element currently the focus of D-Command is outlined
in the color associated with each unit.

Naming D-Command Units in Pro Tools

You can set the names for D-Command units from Pro Tools.

To name a D-Command unit in Pro Tools:

1 Choose Setup > Peripherals, and click Ethernet Controllers.
2 Click the Name button next to the unit.

3 Enter the name for the unit and click OK.

You can also set the names for D-Command Main Units and
Fader Modules directly from the units themselves, by using
Utility mode. For details on naming D-Command units in
Utility mode, see “D-Command Name Page” on page 134.

26 D-Command Guide

Setting D-Command Preferences

This section describes the settings and preferences for
D-Command that are set directly from the control surface. For
details on preferences that are set from Pro Tools, refer to the
Pro Tools Reference Guide.

Fader and Switch Preferences

The following settings and preferences affect operation of the
faders and switches on D-Command.

Fader Bank Justification

The Bank Justification preference determines whether banks
of channels in Normal mode are left-, center-, or right-justi-
fied on the control surface.

To set bank justification:

1 In the Console Prefs Soft Keys section, press the Operation
switch repeatedly to display the page that includes the Bank
Justification preference (“BnkJus”).

2 Press the Soft Key that corresponds to “BnkJus” to choose
between the “Left,” “CentrL,” “CentrR,” and “Right” settings.

3 Hold Control (Windows) or Command (Mac) and press the
Operation switch to exit.

Faders On/Off

The Faders On/Off preference lets you temporarily turn off
D-Command faders to prevent fader movement when moni-
toring a mix.

To toggle D-Command faders on and off:

1 In the Console Prefs Soft Keys section, press the Operation
switch repeatedly to display the page that includes the Faders
On/Off preference (“Faders”).

2 Press the Soft Key that corresponds to “Faders” to toggle all
faders on and off.

3 Hold Control (Windows) or Command (Mac) and press the
Operation switch to exit.



Touch Value

The Touch Value preference determines whether faders and
encoders, when touched, temporarily show the value of the pa-
rameter they are controlling.

To toggle display of values on or off:

1 In the Console Prefs Soft Keys section, press the Operation
switch repeatedly to display the page that includes Touch
Value (“TchVal”).

2 Press the Soft Key that corresponds to “TchVal” to cycle dis-
play of all values On, all values Off or just fader values off
(“NoVol”).

3 Hold Control (Windows) or Command (Mac) and press the
Operation switch to exit.

Display of Slave Track Controls in VCA Master
Track Encoders

If you don’t want to view or adjust slave track controls from
the VCA Master channel strip, you can turn off the display of
slave track controls in the encoders of VCA Master tracks.

To toggle display of slave track controls in VCA Masters:

1 In the Soft Keys section, press the Operation switch repeat-
edly to display the page that includes the Encoder VCA display
preference (“EncVCA”).

2 Press the Soft Key that corresponds to “EncVCA” to toggle
the setting between “Yes” (display of slave track controls in en-
coders) and “No” (no display of slave track controls).

3 Hold Control (Windows) or Command (Mac) and press the
Operations switch to exit.

Select Switch Latch Mode

The Select Switch Latch mode determines whether channel Se-
lect buttons follow latching or non-latching (exclusive-or) be-
havior when in Select mode.

To set the Select switch mode:

1 In the Console Prefs Soft Keys section, press the Operation
switch repeatedly to display the page that includes Select
Switch Latch mode (“Select™).

2 Press the Soft Key that corresponds to “Select” to toggle the
setting between the “Latch” and “ExclOr” (non-latching) set-
tings.

3 Hold Control (Windows) or Command (Mac) and press the
Operation switch to exit.

Custom Fader Preferences
Custom Fader Justification

The Custom Fader Justification preference determines
whether channels in Custom Fader mode are left-, center-, or
right-justified on the control surface.

To set Custom Fader justification:

1 In the Console Prefs Soft Keys section, press the Operation
switch repeatedly to display the page that includes Custom
Fader Justification (“CFJus”).

2 Press the Soft Key that corresponds to “CF Jus” to choose be-
tween the “Left,” “CentrL,” “CentrR,” and “Right” settings.

3 Hold Control (Windows) or Command (Mac) and press the
Operation switch to exit.

Maximum Custom Fader Bank Size

The Maximum Custom Fader Bank Size preference determines
the number of channels to be used when displaying channels
in the Custom Fader modes.

Custom Fader Bank Size is set independently for each category
of Custom Fader modes (Plug-Ins, Groups, and Track Types).

Options for bank size include 4, 8, 16, 24, 32, and 40 faders, up
to the total number of channels on the D-Command system.
You can choose settings for 32- and 40-fader sizes (indicated
by the prefix “Min”) that use the minimum number of chan-
nels necessary, so that the Custom Fader section dynamically
resizes to match the number of channels in the group.

To set the maximum Custom Fader bank size:

1 In the Soft Keys section, press the Operation switch repeat-
edly to display the page that includes the following Custom
Fader Bank Size preferences:

CFPlug (CF Bank Size for Plug-Ins) Determines the number of
channels allocated for Custom Fader Plug-In mode.

CFGrp (CF Bank Size for Custom and Mix/Edit Groups) Deter-
mines the number of channels allocated for Custom Groups
mode.

CFTyp (CF Bank Size for Track Type) Determines the number
of channels allocated for Custom Fader Tracks mode.
2 Do one of the following:

o Toincrement the number of channel strips, press the Soft
Key that corresponds to the preference setting you want
to change.

—or-

o To decrement the number of channel strips, hold Shift
and press the Soft Key that corresponds to the preference
setting you want to change.

3 Hold Control (Windows) or Command (Mac) and press the
Operation switch to exit.
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Display of Hidden Tracks in Custom Faders

You can set D-Command to show hidden tracks in the Custom
Fader views. You can then mix those hidden tracks, but you
cannot select or record-enable them. Hidden track names are
displayed in yellow in the Custom Faders.

To make hidden tracks visible in Custom Fader views:

1 In the Console Prefs Soft Keys section, press the Operation
switch repeatedly to display the page that includes Custom
Fader Tracks (“CFTrks”).

2 Press the Soft Key that corresponds to “CFTrks” to toggle the
setting between Show Hidden Tracks (“ShwHdn”) and Hide
Hidden Tracks (“HidHdn”).

3 Hold Control (Windows) or Command (Mac) and press the
Operation switch to exit.

Custom Fader Plug-In Mode View Definitions

There are three view options available for display of plug-in
parameters in the channel displays of the Custom Faders.
These options, or view definitions, are accessible from the
D-Command operation preferences.

To set the Custom Fader Plug-In Mode view:

1 In the Console Prefs Soft Keys section, press the Operation
switch repeatedly to display the page that includes Plug-In
View Definition (“PIDef”).

2 Repeatedly press the Soft key that corresponds to “PIDef” to
choose between the following settings for the Plug-In Mode
view:

Name View Shows the track name, plug-in name and channel
format of the currently focused plug-in in the channel displays
of the Custom Faders.

Expanded View Shows additional plug-in controls in the chan-
nel displays of the Custom Faders. This view can also be seen
at any time by pressing and holding the Plug-In switch in the
Custom Fader section until the switch flashes. See “Expanded
Plug-In View” on page 130.

Fader View Maintains track names on channel displays and
fader control of track volume while Custom Fader plug-in pa-
rameters are displayed in the channel encoders. Entering Ex-
panded view or Plug-In Map mode automatically exits Fader
view.

3 Hold Control (Windows) or Command (Mac) and press the
Operation switch to exit.
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Focusing Plug-Ins in Channel Strips

You can set D-Command to focus plug-ins directly in channel
strips instead of Custom Faders, so that plug-in parameters
can be edited and automated from the channel strip.

To enable focusing of plug-ins in D-Command channel strips:

1 In the Soft Keys section, press the Operation switch repeat-
edly to display the page that includes Channel Editing for
Plug-Ins (“ChanPI”).

2 Press the Soft Key that corresponds to “ChanPI” to toggle the
setting between “On” (to focus plug-ins on channel strips) and
“Off” (to focus plug-ins in Custom Faders).

3 Hold Control (Windows) or Command (Mac) and press the
Operations switch to exit.

To focus a plug-in on a channel strip:

1 Press the Inserts switch for the channel to display plug-in
names on the channel’s encoders. Press the Page Up and Page
Down switches on the channel to display additional plug-ins.

2 Press the encoder Select switch for the plug-in you want to
focus.

The controls of the focused plug-in appear on the channel’s
encoders. You can page through the plug-in’s controls by
pressing the Page Up and Page Down switches on the channel.

To focus a plug-in using the opposite mode from the current
ChanPI setting:

= Hold Control+Alt (Windows) or Command+Option (Mac)
when pressing the encoder Select switch for a plug-in.



Encoder Preferences

The following preferences affect operation of the rotary en-
coders on D-Command.

Rotary Encoder Mode

The Rotary Encoder mode affects responsiveness of rotary en-
coder knobs. Fixed mode is at normal resolution. The velocity
modes set different rates of encoder acceleration. In Fine
mode, response is fixed and at fine resolution.

To set the Rotary Encoder mode:

1 In the Console Prefs Soft Keys section, press the Operation
switch repeatedly to display the page that includes Rotary En-
coder mode (“Rotary”).

2 Press the upper Soft Key that corresponds to “Rotary” to step
through the “Fixed,” “Vel-SI” (velocity-sensitive, slow),
“Vel-Md” (velocity-sensitive, medium), “Vel-Fa” (veloc-
ity-sensitive, Fast), and “Fine” settings.

3 Hold Control (Windows) or Command (Mac) and press the
Operation switch to exit.

Encoder Order

The Encoder Order preference determines whether inserts,
sends, and pan controls will be displayed in order from
top-to-bottom or bottom-to-top on D-Command rotary en-
coders.

To set the Encoder Order preference:

1 In the Console Prefs Soft Keys section, press the Operation
switch repeatedly to display the page that includes Encoder
Order (“Encod”).

2 Press the Soft Key that corresponds to “Encod” to toggle the
setting between “Bot-Tp” (bottom-to-top ordering) and
“Tp-Bot” (top-to-bottom ordering).

3 Hold Control (Windows) or Command (Mac) and press the
Operation switch to exit.

Display Preferences

The following preferences affect the interaction of D-Com-
mand with on-screen display of elements in Pro Tools.

Target Track from Application

The Target Track from Application preference determines
whether selecting an Insert or Send on-screen makes its track
the focused track on the D-Command Main Unit. For details
on focusing a track on D-Command, see “Focusing a Track” on
page 109.

To set the Target Track from Application preference:

1 In the Console Prefs Soft Keys section, press the Operation
switch repeatedly to display the page that includes Target
Track (“ApTrgt”).

2 Press the Soft Key that corresponds to “ApTrgt” to toggle the
setting between “Yes” and “No.”

3 Hold Control (Windows) or Command (Mac) and press the
Operation switch to exit.

Channel Window Display

The Channel Window display preference determines whether
displaying plug-in or send pan parameters (by pressing an en-
coder Select switch) on D-Command opens the corresponding
plug-in or send window on-screen in Pro Tools.

This preference also determines whether the Channel Select
switches in the Dynamics or EQ sections change the channel
display of multi-mono plug-ins.

& When this preference is set to “Yes,” the on-screen display of
plug-in and send windows changes to reflect the state of the
control surface.

& When this preference is set to “No,” the on-screen display of
plug-in and send windows does not change to reflect the state
of the control surface.

To set the Channel Window display preference:

1 In the Console Prefs Soft Keys section, press the Operation
switch repeatedly to display the page that includes Channel
Window (“ChanWn”).

2 Press the Soft Key that corresponds to “ChanWn” to toggle
this setting between “Yes” and “No.”

3 Hold Control (Windows) or Command (Mac) and press the
Operation switch to exit.
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Meter Preferences

The following preferences affect operation of the meters on
D-Command.

Send Meters On/Off

The Send Meters On/Off preference toggles send metering on
and off. Send levels are displayed on the LED rings surround-
ing the D-Command rotary encoders. This metering follows
Send pre- or post-metering settings in Pro Tools.

To toggle send meters on and off:

1 Press the Meter switch in the Console Prefs Soft Keys sec-
tion.

2 Press the Soft Key that corresponds to “SndMtr” to toggle the
setting On and Off.

3 Press the Meters Console Prefs Soft Key switch to exit.

Insert Meter On/Off

The Insert Meters On/Off preference toggles insert metering
on and off. This preference applies when inserts are displayed
on the LED rings surrounding the D-Command rotary encod-
ers.

To toggle insert meters on and off:

1 Press the Meter switch in the Console Prefs Soft Keys sec-
tion.

2 Press the Soft Key that corresponds to “InsMtr” to toggle the
setting On and Off.

3 Press the Meters Console Prefs Soft Key switch to exit.

30 D-Command Guide

Meters Pre/Post Fader

The Meters Pre/Post Fader preference toggles channel meter-
ing between pre- and post-fader modes.

To toggle channel meters between pre- and post-fader metering:

1 Press the Meters switch in the Console Prefs Soft Keys sec-
tion.

2 Press the Soft Key that corresponds to “Meters” to toggle the
setting between “PreFad” (pre-fader metering) and “PostFd”
(post-fader metering).

3 Press the Meters Console Prefs Soft Key switch to exit.

Center Meters Track/Output

The Center Meters Track/Output preference toggles the
8-channel meter display on the Main Unit meter bridge be-
tween main output levels and the focused track.

When set to meter the focused track, you can view levels for
multichannel tracks up to 6 channels (5.1 surround).
To toggle the center meters between output and track metering:

1 Press the Meters switch in the Console Prefs Soft Keys sec-
tion.

2 Press the Soft Key that corresponds to “CtrMtr” to toggle the
setting between “Output” and “Track.”

3 Press the Meters Console Prefs Soft Key switch to exit.

VCA Slave Metering On/Off

The VCA Meters On/Off preference toggles metering of VCA
slave track levels on VCA channel rotary encoders on and off.

To toggle VCA slave track metering on and off:

1 In the Soft Keys section, press the Meter switch repeatedly to
display the page that includes the VCA Meters On/Off prefer-
ence (“VCAMtr”).

2 Press the Soft Key that corresponds to “VCAMtr” to toggle
the setting On and Off.

3 Press the Meters Console Prefs Soft Key switch to exit.



System Calibration

Recalibrating D-Command Faders

If a fader on a D-Command Unit shows response problems,
you can recalibrate the faders with the Recal command in Util-
ity mode. See “Recal” on page 137 for details.

Calibrating the Output Meters

You can calibrate the output meters on the Main Unit meter
bridge from XMON, in order to match metering levels in

Pro Tools with metering levels of external sources. The exam-
ple below uses an HD I/0 or 192 1/0 as the reference source.

To calibrate the D-Command output meters:

1 Set the reference level of your HD I/0 or 192 I/O according
to the instructions in its User Guide.

2 With the HD I/0 or 192 I/0 analog output connected to the
XMON Main Input, send a calibration tone to the D-Command
Main Outputs, and note the output level on the D-Command
meters.

3 Disconnect the HD I/0 or 192 I/0 analog output from the
XMON Main Input and connect it to an XMON Stereo Input.

4 Activate the corresponding Alt Output.

5 Adjust the trim pots on the back panel of the XMON until the
output level for each channel on the D-Command matches the
level displayed for the Main Output.

6 When you are finished, reconnect the HD I/0 or 192 I/O an-
alog output to the XMON Main Input.

Calibrating SPL Indication on the Monitor Section

The D-Command Monitor section lets you display output level
in dB or dB SPL. You can calibrate the SPL display to reflect
the sound pressure level at the mix position. See “Calibration
Mode Switch” on page 101.
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Chapter 6: Channel Strip Controls

Channel Strips

The D-Command Main Unit has 8 channel strips, and the
D-Command Fader Module has 16 channel strips. Each chan-
nel strip (Figure 1) has identical controls, including two
touch-sensitive rotary encoders, display and mode controls,
and a touch-sensitive fader.
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Figure 1. D-Command Channel Strip

Rotary Encoder Section

Each channel strip has two touch-sensitive rotary encoders
with LED ring, alphanumeric display, mode switches, and sta-
tus indicators. Rotary encoders control channel input, send,
pan, and mic pre parameters.

Encoder
LED ring

Encoder knob
_Encoder
Automation Mode

indicator
Encoder display

Mute/Pre indicators

Clip/Flip indicators

Select switch Bypass/Mute/Pre

switch

Channel Strip Rotary Encoder

Encoder Knob

The encoder knobs on D-Command channel strips are
touch-sensitive. When you touch the encoder, the encoder dis-
play switches from the parameter name to the parameter
value. Touch display of parameter values can be turned off.

When you are automating a parameter controlled by an en-
coder, touching the encoder knob starts writing automation.

When assigning a channel input or output, or an insert or
send, the encoder knob is used to scroll through available in-
puts, outputs, inserts, or sends.

Inputs, Outputs, Inserts and Sends

When assigning a channel input or output, or an insert or
send, the encoder knob is used to scroll through available in-
puts, outputs, inserts, or sends. When adjusting the phantom
power on a remote-controlled mic preamplifier (such as the
PRE), the encoder knob can be used to toggle phantom power
on and off.

Instrument Tracks

On Instrument tracks, the bottom encoder knob is used to
control MIDI Volume.

VCA Master Tracks

On VCA Master tracks, the encoder knobs are used to control
the Volume of slave tracks.
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Encoder LED Ring

Each encoder has a ring of 15 LEDs. Discrete or stepped infor-
mation is shown by single LEDs, and continuously variable in-
formation is shown by an expanding series of LEDs.

In Normal mode, encoder LED rings can show Send level, pan
position, plug-in parameter values, and mic pre settings. In
Flip mode, they show track level.

Instrument Tracks

On Instrument tracks, the bottom encoder LED ring shows
MIDI Velocity.

VCA Master Tracks

On VCA Master tracks, encoder LED rings show levels of slave
tracks.

Encoder Automation Mode Indicator

Below each encoder knob is an LED marked “auto,” which
lights when the corresponding parameter is enabled for auto-
mation. The indicator lights green for Read mode, yellow
when armed for automation in any of the Write modes, and
red when writing automation in any of the Write modes.

Encoder Display

Each encoder has a six-character display that shows parameter
names. When the corresponding encoder knob is touched or
moved, the display shows parameter values.

Encoder displays use color inversion to indicate the following:

o Green: Default color for input, insert, send, pan, and mic
pre parameter names and values

 Inverted green: Inactive input, inactive output, inactive
plug-in or inactive send names

Clip and Flip Indicators

When viewing inserts on an encoder, these LEDs light to indi-
cate the send or insert has clipped (red LED) or has been
flipped to the fader (yellow LED).

Mute and Pre Indicators

When viewing sends on an encoder, these LEDs light to indi-
cate that the send is muted (red LED) or set to pre-fader oper-
ation (green LED).

Encoder Select Switch

Each encoder has a Select switch that is used to assign an in-
sert or send to that encoder, or to display send parameters for
editing.
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Inserts

When assigning an insert, the encoder Select switch is used to
confirm the selection of the following elements on each level:

« Insert type
o Plug-In subfolder

« Individual insert or plug-in

Sends

When assigning a send, the encoder Select switch is used to
confirm the selection of the following:

« Send type (interface or bus)

« Send assignment

When viewing a send, the encoder adjusts level. In Send Pan
mode, the fader adjusts level and the encoder adjusts Pan.

VCA Master Tracks

On VCA Master tracks, encoder Select switches focus the cor-
responding slave tracks in the Focus Channel section.

Bypass/Mute/Pre Switch

Each encoder has a Bypass/Mute/Pre (B/M/P) switch whose
function depends on what is currently displayed on the en-
coder. With Sends, the function of the B/M/P switch also de-
pends on the current Switch Mode setting.

See “Switch Mode Switch” on page 45 for more information on
changing the Switch mode and viewing the current function of
the B/M/P switch.

Inserts

When a plug-in name is displayed on an encoder (in the
top-level Inserts display), the B/M/P switch bypasses the cor-
responding plug-in. The B/M/P switch lights when the plug-in
is bypassed.

Sends

When a send name is displayed on an encoder, the B/M/P
switch does one of the following:

o Ifthe Switch Mode is set to Mute, the B/M/P switch mutes
the corresponding send. The red Mute LED lights to indi-
cate that the send is muted.

o If the Switch Mode is set to Pre, the B/M/P switch toggles
the corresponding send between pre- and post-fader op-
eration. The green Pre LED lights to indicate that the
send is set for pre-fader operation.

Mic Pre

In Mic Pre mode, mic pre parameters are displayed on a chan-
nel strip’s encoders. In addition, the B/M/P switches do the
following:

« Top encoder, page 1: toggles phantom power on and off



« Bottom encoder page 1: toggles mic pre Pad on and off
+ Top encoder, page 2: toggles mic pre HPF on and off

« Bottom encoder page 2: toggles mic pre Polarity

« Top encoder, page 3: toggles phantom power on and off

« Bottom encoder, page 3: toggles mic pre Insert on and off

Instrument Tracks

On Instrument Tracks, the bottom B/M/P switch is used to
control MIDI Mute state.

VCA Master Tracks

On VCA Master tracks, B/M/P switches are used to control the
Mute state of slave tracks.

MIDI Controls on Instrument Tracks

The Instruments View in Pro Tools contains MIDI controls
that can be displayed on the encoders of D-Command channel
strips.

To display MIDI controls on an Instrument track:

= In the Channel Strip Mode controls section of the Instru-
ment channel strip, press the Inserts switch and the Sends
switch simultaneously.

The MIDI controls appear on the encoders as follows:
« Top encoder: MIDi Pan
« Bottom encoder: MIDI Volume
« Bottom B/M/P switch: MIDI Mute
+ Bottom encoder LED ring: MIDI Velocity meter

To exit display of MIDI controls:

= Press another switch in the Channel Strip Mode section.

Slave Track Display on VCA Master Tracks
In normal Mode, VCA Master tracks show their slave tracks in
their rotary encoders, as follows:

« Encoder knob: Slave track Volume control

o Encoder LED ring: Slave track meter level

« Encoder B/M/P switch: Slave track mute

« Encoder Select switch: Focuses slave track in Focus Chan-
nel Strip

If there are more than two slave tracks for a VCA Master, you
can the press the channel Page Up/Page Down switches to dis-
play the additional slave tracks on the rotary encoders.

Channel Strip Mode Controls

Each channel strip has a set of Channel Strip Mode controls
for displaying and editing pan, plug-in, mic pre, insert, or
send parameters on the encoder section of the D-Command
channel strip.

Page Down switch —() (_)— Page Up switch

PgDn PgUp

Inserts switch —() ()— Pan switch

Inserts  Pan

Bypasss‘zlsitrgrq O (_)7 Sends switch
Byp-Spil Sends

Channel Strip Mode controls

Page Up and Page Down Switches

Control parameters are arranged on channel strip rotary en-
coders in pages, or groups of up to two parameters at a time.

The Page Up and Page Down switches light to indicate the
presence of additional pages of pan, plug-in, mic pre parame-
ters, or (for VCA Master tracks) slave tracks, in the corre-
sponding direction on each channel strip. If no additional
pages are available, neither switch is lit.

To move the page display of parameters on the encoders up or
down:

= Press a lit Page Up or Page Down switch.

Inserts Switch

When you press the Inserts switch, you enter Inserts mode,
and the plug-in names for the first two plug-ins on that chan-
nel strip are displayed on the encoder displays. If there are ad-
ditional plug-ins on the channel, the channel’s Page Up switch
lights. The 10 available inserts are displayed in five pairs
(A-B, C-D, E-F, G-H, I-]).

To open a plug-in window from any channel on D-Command:

= Hold Start (Windows) or Control (Mac) and press the Select
switch for the plug-in.

To close the plug-in window:

= Hold Start (Windows) or Control (Mac) and press the Select

switch again.

The Inserts switch flashes when a plug-in on that channel has
clipped. To clear a clip, press the Clear Clip switch in the Ses-
sion Management section. See “Clear Clip Switch and Plug-In
Clip Indicator” on page 84 for more information.
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Pan Switch

When you press the Pan switch, you enter Pan mode, and the
pan controls for the channel strip are displayed on the encoder
displays.

If the track is a multichannel track, its Page Up switch lights to
indicate that there are multiple pages of pan controls. Multi-
channel pan controls are arranged as follows:

Surround Pan Display, Page 1

Display Pan Control
F/IR Front/Rear Pan
Front Front Pan

Surround Pan Display, Page 2

Display Pan Control
Cntr% Center Speaker Percentage
Rear Rear Pan

Surround Pan Display, Page 3

Display Pan Control
F Div Front Divergence
SCnt% Side Center Percentage (if any)

Surround Pan Display, Page 4

Display Pan Control
R Div Rear Divergence
F/R Div Front/Rear Divergence

Surround Pan Display, Page 5

Display

Pan Control

LFE

Low Frequency Effect level

To open/close the Output window on-screen for a track:
1 Press the Pan switch on the channel.
2 Hold Start (Windows) or Control (Mac) and press the chan-

nel’s encoder switch.

Two-Knob Surround Panning

When working in surround, you can link the front and rear
pan controls on D-Command to facilitate X-axis motion in the
sound field.

To link front and rear surround panners:

1 Press the Operation switch in Console Prefs section until
“2KbPan” appears in the Soft Keys.

2 Press the Soft Key that corresponds to “2KbPan” to toggle the
preference on or off.
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Mic Pre Mode

When you press a channel strip’s Inserts switch and Pan
switch simultaneously, you enter Mic Pre mode. In Mic Pre
mode, the controls for an available remote-controlled micro-
phone preamplifier (such as the PRE) are displayed on the
channel strip’s rotary encoders for editing. The Page Up
switch lights to indicate more available parameter pages.

Microphone preamplifiers are declared in the Pro Tools pe-
ripherals dialog, and assigned to channels in the Pro Tools I/O
Setup dialog.

Bypass/Spill Switch

The function of the Bypass/Spill switch depends on what is
currently displayed on the channel strip’s encoders.

Inserts

« In the top-level Inserts view (when plug-in names are dis-
played on a channel strip’s encoders), the Bypass/Spill switch
bypasses all plug-ins on that channel.

Sends

« In the top-level Sends view (when send names are displayed
on a channel strip’s encoders), the Bypass/Spill switch mutes
all sends on that channel.

VCA Master Tracks

« On VCA Master tracks, the Bypass/Spill switch uses
Mix/Edit Groups mode to display (or “spill”) the slave tracks
for the VCA in Custom Faders.



Sends Switch

When you press the Sends switch, you enter Sends mode, and
the send names for the first two sends on that channel strip are
displayed on the encoder displays. If there are additional
sends on the channel, the channel’s Page Up switch lights. The
10 available sends are displayed in five pairs (A-B, C-D, E-F,
G-H, I-]).

Send Pan Mode

Send Pan mode allows you to adjust send panning and level at
the same time. Send level is controlled by the channel fader
and Send pan is controlled by the encoder.

To enter Send Pan mode:

1 Press the Sends switch to display sends on the channel’s en-
coders.

2 Press the encoder Select switch that corresponds to the send
you want to display.
To return to the top-level display of sends on the channel strip:

= Press the Sends switch again.
To link a Send’s Pan controls to the Main Pan controls of a track:
1 Put the track in Send Pan mode for the Send you want to link.

2 Press the B/M/P switch on any of the active encoders on the
track to toggle the FMP status of the send.

Channel Strip Function Controls

Each channel strip has a set of Channel Strip Function con-

trols for controlling channel selection and focus, mute, solo,
and record enable status, input monitor mode, and automa-
tion mode.

Input Monitor Mode Record Enable
switch O G switch

Input Rec
Channel Select 7()
switch

Select

(= ===

Solo

—<)

Mute

Solo switch

Mute switch

Channel display

Automation Mode <= Automation Trim
switch switch

Auto Trim
Channel Strip Function controls

Input Monitor Mode Switch

The Input Monitor Mode switch toggles the input monitoring
mode for that channel between Auto Input and Input Only
mode. The switch lights when the channel is in Input Only
mode.

Record Enable Switch

The Record Enable switch toggles record enable status for the
channel. When the channel is record-enabled and the

Pro Tools transport is stopped, the switch flashes. During re-
cording, the switch lights continuously.

Record Safe Mode To record safe a track from D-Command,
hold Control (Windows) or Command (Mac) and press the
track’s Record Enable switch.
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Channel Select Switch

The function of the Channel Select switch depends on the Se-
lect/Focus Mode setting. See “Select/Focus Mode Switch and
Indicators” on page 46 for more information on changing the
Select/Focus mode.

Select Mode If the Select/Focus Mode is set to Select, the
Channel Select switch selects the channel in Pro Tools. The
switch lights when the channel is selected. In this mode, the
Channel Select switch can be set to follow latching or exclu-
sive-or (non-latching) behavior.

Focus Mode If the Select/Focus Mode is set to Focus, the
Channel Select switch brings that channel’s Dynamics and EQ
controls into the Dynamics and EQ sections of the Main Unit
for editing. In this mode, because only one track can be fo-
cused at a time, the Select switch follows exclusive-or
(non-latching) behavior only.

In Focus mode, if the D-Command Focus Channel Strip Oper-
ations preference is set to Yes, the Channel Select switch also
places a duplicate of the focused channel in the channel strip
to the immediate left of the Global Controls section.

Solo Switch

The Solo switch toggles solo status for the channel. When a
channel is soloed, the Solo switch lights, and the Mute
switches on other channels in the session flash to indicate im-
plicit mute. The Solo switch function follows the Pro Tools
Operation preference for latched operation.

Solo Safe Mode To solo safe a track, hold Control (Windows)
or Command (Mac) and press the track’s Solo switch.

When a track is solo safed, its Solo switch flashes once.

Mute Switch
The Mute switch toggles mute status for the channel.
+ When a track is muted, its Mute switch lights solid.

+ When a track is implicitly muted (when another track is so-
loed), its Mute switch flashes.
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Channel Display

Each channel display shows the channel information in the
following display modes. In each mode, when the channel
fader is touched, the display shows the channel volume in dB.

Track Name Mode Shows the track name only.

Group/Name Mode Shows the group membership of the track
(by group letter) and an abbreviated track name.

Track Position Number/Name Mode Shows the track position
number and an abbreviated track name.

Headroom Mode Shows the abbreviation “HR” followed by the
remaining headroom in dB.

Level Mode Shows the track volume level in dB only.

Channel displays use colors and backlighting to indicate the
following:

o Green: Channel names and values

« Inverted green: Inactive channel

Automation Mode Switch

The Automation Mode switch cycles the channel through the
Pro Tools automation modes (Write, Touch, Latch, Read and
Off). The active mode is shown by the Automation Mode LED
indicators to the left of each channel’s fader. When in Off
mode, none of the indicators is lit.

The Automation Mode switch lets you cycle the channel
through Touch, Latch, and Read modes during playback, but it
prevents you from entering Write of Off mode during play-
back. To directly enter Write or Off mode during playback, use
the Automation Mode controls in the lower left of the Main
Unit. (See “Automation Mode Controls” on page 49.)

Automation Trim Switch

The Automation Trim switch toggles the channel into the cor-
responding Trim mode for Write, Latch, Touch, and Read
modes. Active Trim mode is shown by the yellow Trim mode
LED indicator to the left of each channel’s fader. The Automa-
tion Trim switch has no effect while the channel is in Off
mode.
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Fader

The touch-sensitive faders on D-Command channel strips
control channel volume in Normal mode, and a wide range of
parameters in Flip mode or the Custom Fader modes. When
you touch a fader, its channel strip display changes from track
name to track volume level (in Normal mode), or from param-
eter name to parameter value (in Flip modes or Custom Fader
modes). When you are automating a parameter on a fader,
touching the fader starts writing automation.

Automation Mode Indicators

The Automation Mode indicators, located to the left of each
channel’s fader, indicate the active automation mode.

WR (Write), TC (Touch) and LT (Latch) are red LEDs; TM
(Trim) is a yellow LED; and RD (Read) is a green LED.

o When in Write mode, the Write indicator flashes at all times.

& When in Touch or Latch modes, the corresponding indicator
lights solid until automation writing begins.

& When a track in Latch mode is primed for writing automa-
tion, its Latch mode indicator flashes.

& When automation writing begins, the appropriate indicator
flashes.

o If automation is turned off for the channel (Off), none of the
indicators is lit.

Group Status Indicator

The Group Status indicator (a green LED marked GRP), lo-
cated to the left of each channel’s fader, lights to indicate that
the channel is a member of an active Mix or Edit group in
Pro Tools. If the channel is a member of an inactive group, or
if groups are suspended, this indicator is off.

Custom Fader Mode Indicator

The Custom Fader Mode indicator (a blue LED marked CF),
located to the left of each channel’s fader, lights to indicate
that the channel is currently in Custom Fader Mode.

AutoMatch Indicators

The AutoMatch indicators (green arrow-shaped LEDs), lo-
cated to the left of each channel’s fader, light to indicate the
direction you need to move the fader in order to match the au-
tomation level previously written for that track. This is espe-
cially useful when editing fader automation.
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Modifier Key Switches

Each D-Command Main Unit and Fader Module has a set of
four switches in its lower left corner that duplicate the func-
tion of the Pro Tools computer keyboard modifiers.

I—w I—w

Shift Control  Start/Win (Windows) Alt £Window3)

Option (Mac) Command) (Mac)
Modifier Keys (Fader Module)
Shift Switch (Windows and Mac)

The Shift switch duplicates the function of the Shift key on
your computer keyboard.

Control Switch (Windows and Mac)

The Control switch duplicates the function of the Control key
on your computer keyboard.

Win Switch (Windows) or Option Switch (Mac)

The Win/Option switch duplicates the function of the Win-
dows key (also called the Start key) or the Option key (Mac) on
your computer keyboard.

Alt Switch (Windows) or Command Switch (Mac)

The Alt/Command switch duplicates the function of the Alt
key (Windows) or the Command key (Mac) on your computer
keyboard.

¥ The order of the modifier keys on the D-Command
reflects the order of the corresponding keys on a
Windows or Mac keyboard, from left to right.
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Global Controls Section

The Global Controls section (Figure 2) is a set of channel-re-
lated controls in the center of the D-Command Main Unit.
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Figure 2. Global Controls section



Flip Switches

The two yellow Flip switches in the Global Controls section
correspond to the two rotary encoders on the D-Command
channel strips.

Flip Mode

The Flip switches invoke Flip mode, which transfers controls
from the corresponding rotary encoder to the fader on each
channel strip, allowing convenient editing and automation of
send, pan, plug-in, and mic pre parameters directly from the
channel faders.

In Flip mode, the rotary encoder control swaps with the chan-
nel fader; the encoder Select switch swaps with the channel Se-
lect switch; the encoder Bypass/Mute/Pre switch swaps with
the channel Mute switch; and the encoder display swaps with
the channel display.

In Flip mode, the Flip switch lights for the affected row of en-
coders, and the yellow Flip LED below each affected encoder is
lit.

Instrument Tracks and Flip Mode

When MIDI controls for Instrument tracks are displayed on
the encoders, they can be transferred (or “flipped”) to the
channel faders, allowing control of MIDI Volume or MIDI Pan
from the channel faders.

In Flip mode, Instrument track controls are transferred as fol-
lows:

o The fader on each channel controls the parameter (MIDI
Volume or MIDI Pan) that was assigned to the encoder, and
the encoder controls track Volume.

o The channel Mute switch controls the MIDI Mute function,
and the B/M/P switch on the encoder controls channel mute.

To transfer controls from arow of rotary encoders to the channel
faders:

= Press the Flip switch that corresponds to the encoder row.

To exit Flip mode:

= Press a lighted Flip switch.

Q When D-Command is in Flip mode and you enter Make In-
" active mode or Assign mode, it is temporarily taken out of
Flip mode, but the Flip switch remains lit. When you exit
Make Inactive mode or Assign mode, controls return to
their flipped positions.

Automation Write To Controls

The Auto Write to controls invoke the manual “Write to
Start/End/All/Punch/Next” commands, the automatic “Write
to Start/End/All/Punch/Next on Stop” automation commands,
and the “Write to Current Parameter” and “Write to All En-
abled Parameters” snapshot automation commands in

Pro Tools.

The “Write to Start/End/All/Punch/Next” commands can also
be invoked from the Soft Keys section of D-Command.

AUTO WRITETO
Automation
@_ Write to All
switch
All
Automation Automation
Write to Start ) Writeto End
switch Start End switch
Automation Automation
Write to Punch O Ci Write to Next
switch switch
Punch  Next

“Auto Write To” switches

All Switch

The All switch writes the current automation value of all
write-enabled parameters to an entire selection or track when
performing an automation pass.

To manually write automation to all of a track or selection:

= Press the All switch during playback.

To write automation to all of a track or selection on stop:
= Hold the Start key (Windows) or the Control key (Mac) and
press the All switch.

To set Write to All on Stop to remain enabled after each
automation pass:

= Hold the Alt+Start keys (Windows) or the Option+Control
keys (Mac) and press the All switch.

To disable automatic Write to All on Stop:

= Press the All switch.
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Start Switch

The Start switch writes the current automation value of all
write-enabled parameters to the start of a selection or track
when performing an automation pass.

To manually write automation to the start of a track or selection:

= Press the Start switch during playback.

To write automation to the start of a track or selection on stop:
= Hold the Start key (Windows) or the Control key (Mac) and
press the Start switch.

To set Write to Start on Stop to remain enabled after each
automation pass:

= Hold the Alt+Start keys (Windows) or the Option+Control
keys (Mac) and press the Start switch.
To disable Write to Start on Stop:

» Press the Start switch.

End Switch

The End switch writes the current automation value of all
write-enabled parameters to the end of a selection or track
when performing an automation pass.

To manually write automation to the end of a track or selection:

= Press the End switch during playback.

To write automation to the end of a track or selection on stop:
= Hold the Start key (Windows) or the Control key (Mac) and
press the End switch.

To set Write to End on Stop to remain enabled after each
automation pass:

= Hold the Alt+Start keys (Windows) or the Option+Control
keys (Mac) and press the End switch.

To disable automatic Write to End on Stop:

» Press the End switch.
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Punch Switch

The Punch switch writes the current automation value of all
write-enabled parameters back to the punch point (the loca-
tion in the track where the current automation pass started).

To manually write automation back to the punch point:

= Press the Punch switch during playback.

To write automation back to the punch point on stop:
= Hold the Start key (Windows) or the Control key (Mac) and

press the Punch switch.

To set Write to Punch on Stop to remain enabled after each
automation pass:

= Hold the Alt+Start keys (Windows) or the Option+Control
keys (Mac) and press the Punch switch.
To disable automatic Write to Punch on Stop:

= Press the Punch switch.

Next Switch

The Next switch writes the current automation value of all
write-enabled parameters forward to the next automation
breakpoint.

Unlike the other Write To commands, the Write to Next on
Stop command always remains enabled after each automation
pass, until you disable it.

To manually write automation forward to the next breakpoint:

= Press the Next switch during playback.

To set Write to Next on Stop to remain enabled after each
automation pass:

= Hold the Start key (Windows) or the Control key (Mac) and
press the Next switch.
To disable automatic Write to Next on Stop:

= Press the Next switch.



Automation Enable Controls

The Automation Enable controls are used to enable or suspend
writing of each type of automation on all channels. When
writing is enabled for a type of automation, its corresponding
switch is lit.

These Automation Enable controls mirror the function of the
corresponding buttons in the Pro Tools Automation Enable

Switch Information Controls

The Switch Information controls are used to change the mode
and display of encoder Bypass/Mute/Pre switches, and glob-
ally show encoder parameter values.

Switch Mode switch

window.

Mute Mode Mute G Pre-Fader Mod
N _.  Pre-Fader Mode
indicator ' (( )) ' indicator
SW MODE
Switch Info - = ) Show Values
switch \) ( b switch

Swinfo Show Val

Switch Information controls

Switch Mode Switch

AUTO ENABLE
) Enable Inserts
( — Automation
— switch
Inserts
Enable Volume Enable Send Volume
Automation 7() ( )7 Automation
switch switch
Vol Snd Vol
Enable Pan Enable Send Pan
Automa’gioﬂ — = (()) ( )— Au.tor;?ation
switc switc
Pan  Snd Pan

Enable Mute Enable Send Mute
Automation 7@ @ )7 Automation
switch switch
Mute Snd Mute

Automation Enable controls

Inserts Switch

The Inserts switch enables and suspends writing of automa-
tion for any automation-enabled plug-in parameters on all
tracks in the session.

Volume Switch

The Volume switch enables and suspends writing of channel
volume automation on all tracks in the session.

Pan Switch

The Pan switch enables and suspends writing of channel pan
automation on all tracks in the session.

Mute Switch

The Mute switch enables and suspends writing of channel
mute automation on all tracks in the session.

Send Volume Switch

The Send Volume switch enables and suspends writing of Send
level automation on all tracks in the session.

Send Pan Switch

The Send Pan switch enables and suspends writing of send pan
automation on all tracks in the session.

Send Mute Switch

The Send Mute switch enables and suspends writing of send
mute automation on all channels.

The Switch Mode switch toggles the function of encoder By-
pass/Mute/Pre switches between Mute and Pre-Fader func-
tions when displaying sends on the encoders.

« When the Switch Mode is set to Bypass, the encoder B/M/P
switch mutes the corresponding send.

o When the Switch Mode is set to Pre, the encoder B/M/P
switch toggles the corresponding send between pre- or
post-fader operation.

A The Transport must be stopped to toggle sends between
pre- and post-fader operation.

To set the Switch Mode:

= Press the Switch mode switch until the appropriate indicator
lights (Mute or Pre).

Switch Info Switch

The Switch Info switch can follow toggling or momentary be-
havior. If pressed briefly, it toggles the encoder display to
show the function assigned to the Bypass/Mute/Pre switch on
each rotary encoder. If held, the function is shown until the
switch is released.

Show Values Switch

The Show Values switch can follow toggling or momentary be-
havior. If pressed briefly, it toggles the encoder display be-
tween parameter name and parameter value. If held, parame-
ter value is shown until the switch is released.

A\ The operation of the Show Values switch is not affected by
the Touch Display of Parameter Values setting in the Oper-
ations Soft Key Section.
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Global Modifier Controls

The Global Modifier controls are used to change modes for the
channel Select switches, channel displays, clear Solo and Mute
states, and globally suspend automation.

@—~L

Escape switch

Esc
Select/Focus Mode { Sel ©Focus
Switch and indicators
Mode
( )7 Solo Clear switch
SoloClear

Do to All switch

Doto Selected — - /#¢ T B
switch @ (( J)

Do To Sel DoTo All
Display Mode (l ) M\ | setto Default
switch \) (’ sv(\e/itc?w e

Display SetTo
Mode Default

Suspend Groups Suspend Automation
switch (( )) (()7) switch

Susp Grps Auto Susp

Global Modifier controls

Escape Switch

The Escape switch is used to exit modes and to cancel opera-
tions or on-screen dialogs. When an action has occurred that
can be exited or canceled with the Escape switch, the switch
flashes.

Select/Focus Mode Switch and Indicators

The Select/Focus Mode switch toggles the function of channel
Select switches between Select and Focus mode. The LEDs on
either side of this switch indicate the current mode.

o In Select mode, channel Select switches are used to select
channels in Pro Tools.

o In Focus mode, channel Select switches are used to focus a
channel in the Focus Channel section on the Main Unit.
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Do To All and Do To Selected Switches

The Do To All and the Do To Selected switches on D-Com-
mand can be used in two different ways: to apply actions to
multiple tracks in a Pro Tools session, and to change the dis-
play mode of multiple channel strips on D-Command.

The Do To All and Do To Selected switches can follow momen-
tary or latching behavior.

& When single-pressed, their effect applies only to the next
operation.

& When held, they apply to all operations carried out while be-
ing held.

& When double-pressed, they latch on and flash until pressed
a second time.

Applying Actions to Multiple Tracks in Pro Tools

The Do To All and Do To Selected switches are convenient for
performing tasks such as muting, soloing, assigning sends, or
assigning the same plug-in across multiple tracks in a session.

To apply actions to multiple tracks in a Pro Tools Session:
1 Do one of the following:

o Press the Do To All or the Do To Selected switch to apply
the action to one parameter.

- or -
o Double-press the Do To All or the Do To Selected switch

to latch the corresponding action and apply it to multiple
parameters.

2 Press any of the following switches to apply the correspond-
ing action to all tracks or all selected tracks in the session:

« Channel Mute switch

« Channel Solo switch

« Channel Solo Safe: Control (Windows) or Command
(Mac) + Solo switch

o Automation Mode switch

o Automation Trim switch

o Channel Select switch (in Select mode)
o Record Enable switch

« Record Safe: Control (Windows) or Command (Mac) +
Record Enable switch

« Input Monitor Mode switch
3 Depending on the current channel strip display mode, you

can apply the following across all tracks or all selected tracks
in the session:

o Mic Pre Controls: Polarity, Pad, Impedance, Source, Gain
« Send Pre/Post: B/M/P switch in Send Pre/Post mode

o Send Mute: B/M/P switch in Send Mute mode

 Plug-In Bypass: B/M/P switch in Inserts mode



4 You can also carry out any of the following tasks across all
tracks or all selected tracks in the session:

+ Assigning Inputs, Outputs, Inserts and Sends

o Activating/deactivating Inputs, Outputs, Inserts, Sends
and Tracks

« Resetting controls with the Set to Default switch
« Changing panner linkage
+ Changing panner editor choice
5 When you are finished, if Do To all or Do To Selected are

latched on, press the flashing Do To All or Do To Selected
switch to exit the corresponding mode.

Changing Parameter Display on D-Command Channel Strips

The Do To All and Do To Selected switches can be used to dis-
play and edit pan, mic pre, insert, or send parameters across
all tracks or all selected tracks in a session.

The Do To All and Do To Selected switches are applied inde-
pendently to channel strips in Normal mode and Custom
Fader mode. This independent operation lets you put banks of
channels in several display modes at once (for example, pan
on channels in Normal mode, and plug-ins on channels in
Custom Fader mode).

To change the display mode of D-Command channel strips:
1 Press the Do To All or the Do To Selected switch.
2 Press any of the following Channel Strip Mode switches on

any individual channel to apply the corresponding action to all
channels or to all selected channels on D-Command:

+ Inserts switch

o Pan switch

+ Bypass/Spill switch

« Sends switch

« Inserts + Pan switches (Mic Pre mode)

« Inserts + Sends switches (Instrument mode)

Page Down switch 7() (}— Page Up switch

PgDn PgUp

Inserts switch 7() ()— Pan switch

Inserts  Pan

Bypass/Spill (. , ( 7, Sends switch
switch Nl "
Byp-Spil Sends

Channel Strip Mode controls

3 When you are finished, if Do To All or Do To Selected are
latched on, press the flashing Do To All or Do To Selected
switch to exit the corresponding mode.

Display Mode Switch

The Display Mode switch toggles the channel display between
the five display modes: Track Name, Group/ Name, Channel
Number/Name, Headroom Value, and Level modes. See
“Channel Display” on page 40 for more information.

Set To Default Switch

The Set to Default switch lets you reset parameters that are
currently visible on the D-Command surface to their default
values. This switch works in both Normal and Custom Fader
modes.

The Set to Default switch can follow momentary or latching
behavior.

& When single-pressed, its effect applies only to the next op-
eration.

& When double-pressed, it latches on and flashes until pressed

a second time.

(¥ You can also use the Set to Default switch to remove plug-in
assignments from channels. See “Assign Inserts Switch” on
page 51.

While the Set to Default switch is pressed or latched on, the
following parameters can be reset:

To reset a channel’s track volume to 0 dB:

= Press Set to Default + the channel Select switch.

= Hold Alt (Windows) or Option (Mac) and touch the channel
fader.

To reset a channel’s pan control to O (center)

= Press Set to Default + the pan encoder Select switch.

To reset a send’s level to 0 dB:

= Press Set to Default + the send encoder Select switch. This
sets the Send level to 0 dB, regardless of the Send default set-
ting in Pro Tools Operation preferences.

To reset a channel’s mic pre gain to 0 dB:

= Press Set to Default + the mic pre gain encoder Select switch

To set a plug-in's parameters to their default values:

= Press Set to Default + the Compare switch for the plug-in.
(The Compare switch appears in the D-Command Dynamics
and EQ sections, and in Custom Fader Expanded Plug-In
view.)
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Suspend Groups Switch
The Suspend Groups switch suspends all groups in the session.

The Suspend Groups switch follows latching behavior, and
flashes to indicate groups are suspended. To exit Suspend
Groups mode, press the Suspend Groups switch again.

Automation Suspend Switch

The Automation Suspend switch suspends reading and writ-
ing of all automation on all tracks in the session. All channels
are left in their current automation mode, but automation op-
erations are temporarily suspended.

The Automation Suspend switch flashes while automation is
suspended.

Solo Clear Switch

The Solo Clear switch clears all latched Solo switches in the
session. This switch flashes when any channel is soloed.

Custom Fader Controls

The Custom Fader controls invoke a special set of D-Com-
mand modes, called Custom Fader modes, which let you set
aside and customize channel strips for display and editing of a
variety of functions. The Custom Fader modes are Groups
mode, Tracks mode, and Plug-In mode. See Chapter 13, “Cus-
tom Fader Modes” for complete information on Custom Fader
modes.

Focus Channel
CUSTOM FADERS

Groups switch 7() ()7 Map switch

Groups . Map

Tracks switch 7() ()7 Lock switch

Tracks = Lock

Plug-In switch —() ()— Window switch

Plug-In /. Win

QL -

Bank/Cycle

Focus Channel
display

Bank/Cycle switch

Custom Fader controls
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Focus Channel Display

& When a Custom Fader mode is active, the Focus Channel dis-
play shows the name of the Custom Group, Mix/Edit Group, or
the plug-in displayed on the Custom Fader channels.

¢ When no Custom Fader mode is active, the Focus Channel
display shows the name of the focused channel.

Groups Switch

The Groups switch invokes Groups mode, which lets you select
either Mix/Edit Groups or Custom Groups. Invoking Mix/Edit
Groups let you create, edit, and recall Pro Tools Mix and Edit
groups to the Custom Fader channels.

Invoking Custom Groups lets you create a custom collection of
channels and arrange them in any order in the Custom Fader
channels. Custom Groups are a D-Command feature, and are
not reflected on-screen in Pro Tools.

For more information about Custom Groups, see“Custom
Groups Mode” on page 126.

To toggle between Custom Groups and Mix/Edit Groups:

= Press the Bank/Cycle switch repeatedly until the appropriate
mode is displayed in the Focus Channel display (Custom or
Groups).

Tracks Switch

The Tracks switch invokes Track Type mode, which lets you
bring all Pro Tools tracks of a certain type (Audio tracks, Aux-
iliary Inputs, MIDI tracks, Instrument tracks, VCA Master
tracks, or Master Faders) to the Custom Fader channels.

Plug-In Switch

The Plug-In switch invokes Plug-In mode, which lets you
bring the plug-in controls from the first insert of the currently
focused channel to the Custom Fader channels.

To cycle through the available inserts:

= In Plug-In mode, press the Bank/Cycle switch repeatedly un-
til the desired insert is brought into the Custom Fader chan-
nels.



Map Switch

The Map switch works with Custom Groups mode, Mix/Edit
Groups mode, and Plug-In mode. While in these modes, the
Map switch lets you further customize the control layout by
mapping individual rotary encoder controls to faders within
the Custom Fader channels.

The Map switch has no effect on other D-Command channels
in Normal mode.

Lock Switch

The Lock switch applies to Custom Fader Plug-In mode only.
This switch locks the plug-in that is currently displayed in the
Focus Channel display, so that it does not change when you fo-
cus a different channel in the duplicate Focus Channel strip.

The Lock switch lights when the plug-in is locked.

+ When Custom Fader Plug-In mode is active, the locked
plug-in appears in the Custom Fader channels, so you can fo-
cus a different channel in the Focus Channel section and keep
the locked plug-in in the Custom Fader channels.

+ When Custom Fader Plug-In mode is not active, the locked
plug-in appears in the Focus Channel display, so you can focus
a different channel on the duplicate Focus Channel Strip and
keep the locked plug-in in the Focus Channel section. (When
you enter Custom Fader Plug-In mode, the locked plug-in will
be displayed on the Custom Fader channels.)

Window Switch

The Window switch opens and closes the plug-in window
on-screen for any plug-in whose name is displayed in the Cus-
tom Faders display.

Bank/Cycle Switch

+ While in Custom Groups or Mix/Edit Groups mode, the
Bank/Cycle switch is used to bank faders within the Custom
Fader channels, if there are more channels than can be dis-
played at one time.

+ While in Custom Fader Plug-In mode, the Bank/Cycle switch
cycles through the plug-ins on the focused channel, displaying
their controls on the Custom Fader channels.

+ When no Custom Fader mode is active, the Bank/Cycle
switch cycles through the plug-ins on the focused channel, dis-
playing their names in the Custom Faders display.

Automation Mode Controls

The Automation Mode controls are used to display and set au-
tomation modes. These switches light to indicate that at least
one channel is in that automation mode. If multiple channels
are selected and set to different automation modes, all appli-
cable mode switches are lit.

These Automation Mode controls let you change automation
modes during playback, and mirror the function of the
on-screen Automation Mode selector for each track.

AUTO MODE
Automation Write Automation Trim
Mode switch Mode switch
Write Trim
Automation Touch Automation Read
Mode switch > ) Mode switch
Touch  Read
Automation Latch Automation Off
Mode switch O ( y) switch
Latch Off

Automation Mode controls
To set the automation mode of one or more channels:

1 Hold an Automation Mode switch (Write, Touch, Latch,
Trim, Read, or Off).

2 Press the Select switches on the channels whose automation
mode you want to set.

To set the automation mode of one or more selected channels:

1 Press the Do To Selected switch.

2 Press the Select switches on the channels whose automation
mode you want to set.

3 Press an Automation Mode switch.

To set the automation mode on all channels:

1 Press the Do To All switch.

2 Press an Automation Mode switch.

Write Switch

The Write switch indicates or sets the automation mode for
the selected tracks to Write mode.

Touch Switch

The Touch switch indicates or sets the automation mode for
the selected tracks to Touch mode.

Latch Switch

The Latch switch indicates or sets the automation mode for
the selected tracks to Latch mode.
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Trim Switch

The Trim switch indicates or sets the automation mode for the
selected tracks to Trim mode.

Read Switch

The Read switch indicates or sets the automation mode for the
selected tracks to Read mode.

Off Switch

The Off switch indicates or sets the automation mode for the
selected tracks to Off.

Talkback Switch

The Talkback switch, located at the bottom of the Global Con-
trols section on the Main Unit, provides control of the D-Com-
mand Talkback function.

AUTO MODE
Write  Trim
Touch  Read

Latch Off

Dbl Press to Latch

Talkback switch

Talkback switch

The Talkback switch can follow momentary or latched behav-
ior. If held, the switch is active only when pressed down.

If rapidly double-pressed, the switch latches on and flashes to
indicate that talkback is active. Press the switch again to turn
off talkback.

Talkback can be activated automatically. See “Auto Talkback
Switch” on page 100 for more information.

Talkback level is set with the Talkback controls in the Monitor
section. See “Talkback/Listen System” on page 100 for more
information.
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Miscellaneous Controls

The Miscellaneous Controls section includes Timeline, As-
sign, Make Inactive, and Plug-In Automation controls.

Timeline Assign Make Inactive Plug-In Automation
controls controls controls controls
| Il N Il |
TIMELINE ASSIGN MAKE INACTIVE PLUG-IN AUTO
00 ©
Counter o ¢ Inputs Qutputs Inputs~ Outputs Enab Para  Safe
(%) (WX(%)
Lk Edi/T-Line Sends  Inserts Sends  Inseris

Miscellaneous controls

Timeline Controls

TIMELINE

Main Counter
switch (O)
Coutter g ¢

_Link Edit and Sg:tergtlirgr? e
Timeline switch @ @ switch and
Link  Edit/T-Line indicators

Timeline controls

Main Counter Switch

The Main Counter switch cycles through the timecode display
modes (Bars:Beats, Min.Secs, Timecode, Feet+Frames and
Samples) on the Main Time Scale display.

Link Edit and Timeline Switch

The Link Edit and Timeline switch toggles the Link Edit and
Timeline Selection command on and off. The switch is lit
when the selections are linked.

Edit/Timeline Switch and Indicators

The Edit/Timeline switch toggles the D-Command transport
function between the edit selection and the timeline selection.
The indicators above the switch light to show which is dis-
played. If Edit and Timeline Selections are linked, these values
will be the same.



Assign Controls

The Assign controls are used to assign inputs, outputs, in-
serts, and sends to channels. Each switch puts D-Command
into a temporary Assign mode in which elements are assigned
or removed from channels. The switch flashes while Assign
mode is in effect.

You can enter Assign mode while Pro Tools is playing back. To
confirm the assignment of inputs, outputs, and sends, the
transport must be stopped. You can, however, confirm the as-
signment of inserts during playback.

ASSIGN

Assign Inputs (f)) ((\) Assign Outputs
switch - ) switch

Inputs  Outputs

Assign Sends [ ) ( A Assign Inserts
switch @ @ switch

Sends Inserts

Assign controls

Assign Inputs Switch

The Inputs switch invokes Assign Inputs mode, in which the
bottom row of encoders shows channel inputs.

When assigning an input, the Select switch on the bottom en-
coder is used to navigate down through Input menu levels, and
the encoder knob is used to scroll through available choices at
each level:

« Input type (Interface or Bus)

« Individual inputs

The Bypass/Mute/Pre switch on the bottom encoder is used to
navigate back up the Input menu levels.

Assign Outputs Switch

The Outputs switch invokes Assign Outputs mode, in which
the bottom row of encoders shows channel outputs.

When assigning an output, the Select switch on the bottom en-
coder is used to navigate down through Output menu levels,
and the encoder knob is used to scroll through available
choices at each level:

« Output type (Interface or Bus)
« Individual outputs

The Bypass/Mute/Pre switch on the bottom encoder is used to
navigate back up the Output menu levels.

Assign Sends Switch

The Sends switch invokes Assign Sends mode, in which the
channel encoders shows the sends on a channel.

When assigning a send, the encoder Select switch is used to
navigate down through Send menu levels, and the encoder
knob is used to scroll through available choices at each level:

« Send type (Interface or Bus)

o Individual sends

The Bypass/Mute/Pre switch on each encoder is used to navi-
gate back up the Send menu levels.

Assign Inserts Switch

The Inserts switch invokes Assign Inserts mode, in which the
channel encoders show the inserts on a channel. When assign-
ing an insert, the encoder Select switch is used to navigate
down through Insert menu levels, and the encoder knob is
used to scroll through available choices. The Bypass/Mute/Pre
switch on the bottom encoder is used to navigate back up the
Insert menu levels.

The order in which plug-ins appear in the Insert menu is de-
termined by the Pro Tools Display preference for plug-in or-
ganization.

If the Organize Plug-In Menus by Category option is selected,
menu levels and choices include:

» Insert type

+ Plug-In sub-folder

o Individual insert or plug-in

If the Organize Plug-In Menus by Category option is not se-
lected, the Plug-In subfolder level is not present.
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To assign an input, output, send or insert:
1 Press an Assign switch to enter the corresponding Assign

mode.

2 On the channel where you want to make the assignment, turn
an encoder knob to select from the first level of menu choices.

3 Press the encoder Select switch to move down and the By-
pass/Mute/Pre switch to move up through menu levels.
4 Do one of the following:

o Press the flashing encoder Select switch or press the
flashing Assign switch to confirm the assignment.

— or —

o Press the flashing Escape switch to cancel the assign-
ment.

To assign multiple inputs, outputs, sends, or inserts:
1 Press an Assign switch to enter the corresponding Assign

mode.

2 Turn the encoder knobs and use the encoder Select and By-
pass/Mute/Pre switches to select each assignment.
3 Do one of the following:

« Press the flashing Assign switch to confirm all the assign-
ments at once.

— or —

o Press the flashing Escape switch to cancel all the assign-
ments.

To remove an input, output, send or insert:
1 Press an Assign switch to enter the corresponding Assign

mode.

2 For the assignment you want to remove, press the encoder
Bypass/Mute/Pre switch repeatedly until you reach the
top-level menu for the assignment.

3 Turn the encoder knob counter-clockwise until no assign-
ment is visible.
4 Do one of the following:

o Press the flashing encoder Select switch or press the
flashing Assign switch to confirm the removal.

- or —

« Press the flashing Escape switch to cancel the removal
and restore the assignment.
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MIDI Inputs and Outputs on Instrument Tracks

The Assign Inputs and Assign Outputs switches can be used to
assign the MIDI Inputs and Outputs on Instrument tracks.

To assign a MIDI Input or Output on an Instrument track:

1 Press the Assign Inputs or Assign Outputs switch to enter the
corresponding Assign mode. Encoder row #1 shows MIDI in-
puts/outputs.

ASSIGN
Assign Inputs (5 ) ( L) Assign Outputs
switch @ Q switgh .

Inputs  Outputs

Sends Inserts

Assignment controls

2 On each channel where you want to make an assignment,
turn the encoder knob in encoder row #1 to select from the
first level of MIDI menu choices.

3 Press the encoder’s Select switch to move down and the By-
pass/Mute/Pre switch to move up through MIDI menu levels.
4 Do one of the following:

o Press the flashing encoder Select switch or press the
flashing Assign switch to confirm the assignments.

— or —

o Press the flashing Escape switch to cancel the assign-
ments.

Make Inactive Controls

The Make Inactive controls are used to make tracks, inputs,
outputs, sends, or plug-ins inactive. Each switch puts D-Com-
mand into a temporary Make Inactive mode in which elements
are made inactive or reactivated. The switch flashes while
Make Inactive mode is in effect.

MAKE INACTIVE

Inputs Inactive ( ) ( ) Outputs Inactive
switch O O switch
Inputs  Outputs

Sends Inactive (s ) @ Inserts Inactive
switch %S) 0 switch

Inserts

Make Inactive Controls

Making a Track Inactive

Tracks can be made inactive in any Make Inactive mode.

To toggle a track inactive/active:

1 Press any of the Make Inactive switches.

2 Press channel strip Select buttons to deactivate or reactivate
the corresponding tracks.

3 Press the flashing Make Inactive switch to exit Inactive mode



Inputs Inactive Switch

The Inputs switch invokes Inputs Inactive mode and displays
channel inputs in the bottom row of encoders. The By-
pass/Mute/Pre switch on the bottom encoder toggles the input
inactive and active.

Outputs Inactive Switch

The Outputs switch invokes Outputs inactive mode and dis-
plays the main channel outputs in the bottom row of encoders.
The Bypass/Mute/Pre switch on the bottom encoder toggles
the output inactive and active.

Sends Inactive Switch

The Sends switch invokes Sends Inactive mode and displays
the channel’s sends on its encoders. The Bypass/Mute/Pre
switch on each encoder toggles the corresponding send inac-
tive and active.

Inserts Inactive Switch

The Inserts switch invokes Plug-Ins Inactive mode and dis-
plays a channel’s inserts on its encoders. The By-
pass/Mute/Pre switch on each encoder toggles the corre-
sponding insert inactive and active.

To toggle an input, output, send, or insert active/inactive:

1 Make sure the channel is showing the top-level view for the
element you want to make active/inactive.

2 Press a Make Inactive switch to enter the appropriate Make
Inactive mode.

3 Press the Bypass/Mute/Pre switches on encoders to deacti-
vate or reactivate their corresponding track elements.

4 Press the flashing Make Inactive switch to exit Inactive
mode.

Plug-In Automation Controls

The Plug-In Automation controls are used to enable parame-
ters for automation and to place them in automation safe
mode.

PLUG-IN AUTO
Enable Parameter ( ) Automation Safe
switch —fg)) 07 switch

Enab Para  Safe

Plug-In Automation controls

Enable Parameters Switch

The Enable Parameters switch lets you enable parameters for
automation by touching or pressing their controls.

In Enable Parameters mode, the Enable Parameters switch is
lit. While in this mode, the Auto LED for any rotary encoder
enabled for automation is lit red, and the switch for any pa-
rameter enabled for automation is lit.

To toggle automation on and off for plug-in parameters:

1 Press the Enable Parameter switch.

2 Touch the rotary encoders or press the switches for the con-
trols for which you want to toggle automation on or off.

3 Press the Enable Parameter switch again to exit Enable Pa-
rameters mode.

(Y You can also toggle automation for a plug-in parameter by
holding Control+Start+Alt (Windows) or Command+Con-
trol+Option (Mac) and touching the rotary encoder for the
parameter.
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Automation Safe Switch

The Automation Safe switch invokes a mode in which the By-
pass/Mute/Pre switch for each plug-in or send and the channel
Select switch for each track become Safe switches.

Plug-Ins and Sends

While in Automation Safe mode, pressing a Bypass/Mute/Pre
switch on a plug-in or send protects any automation on that
plug-in or send from being overwritten. The Bypass/Mute/Pre
switch for any protected plug-in or send is lit, reflecting the
state of the Safe button in the on-screen plug-in or send output
window.

Tracks

While in Automation Safe mode, pressing a channel Select
switch protects volume, pan and mute parameters on that
track from being overwritten. The channel Select switch for
any protected track is lit, reflecting the state of the Safe button
in the on-screen track output window.

To toggle automation safe on and off:

1 Press the Automation Safe switch.
2 Press the channel Select switch on the tracks for which you
want to toggle automation safe status. The automation safe

status of the track is reflected by the Safe button in the track’s
on-screen output window.

3 Press the Bypass/Mute/Pre switch for the plug-ins or sends
for which you want to toggle automation safe status.

4 Press the Automation Safe switch again to exit Automation
Safe mode.
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Chapter 7: Plug-In Controls

D-Command provides dedicated Dynamics and EQ sections
for plug-ins that support dynamics and EQ plug-in mapping.
These sections include encoders and switches that map to
standard controls for each plug-in type.

Plug-Ins of all types can be focused across multiple D-Com-
mand channels using Custom Fader Plug-Ins mode. See “Cus-
tom Fader Plug-In Mode” on page 129.

Plug-In Channel Formats

D-Command supports mono, stereo, multichannel and
multi-mono plug-in channel formats up to six channels wide.

With D-Command, you can display, edit, and link specific
channels of multi-mono dynamics and EQ plug-ins directly
from the Channel Select switches in the corresponding sec-
tion.

Assigning and Removing Plug-Ins

You can make plug-in assignments directly from D-Command
in several ways. In Inserts mode, plug-ins can be added on an
insert-by-insert basis. In Assign Inserts mode you can assign
plug-ins to insert positions on multiple tracks.

To assign a plug-in in Inserts mode:

1 Press the Inserts switch to display inserts on the channel
where you want to assign the plug-in.

2 If the insert location where you want to assign a plug-in is
not showing, press the Page Up or Page Down switches on the
channel where you want to make the assignment until the ap-
propriate location is displayed.

3 Do one of the following:

« If the insert location you want to use is empty, press the
corresponding encoder Select switch.

o If a plug-in is already present in the insert location you
want to use, press and hold the corresponding encoder
Select switch.

4 At the insert position where you want to make the assign-
ment, turn the encoder knob to select from the first level of
menu choices.

5 Press the encoder Select switch to move down and the By-
pass/Mute/Pre switch to move up through menu levels.

6 When the plug-in you want to assign is displayed, press the
encoder Select switch to confirm your selection.

To assign plug-ins to multiple tracks:

1 Press the Assign Inserts switch to enter Inserts Assign mode.
The first two send or insert positions will show on the encoder
displays by default.

2 To display and edit other insert positions, press the Page Up
or Page Down switches on the channel where you want to make
the assignment.

3 At the insert position where you want to make the assign-
ment, turn the encoder knob to select from the first level of
menu choices.

4 Press the encoder Select switch to move down and the By-
pass/Mute/Pre switch to move up through menu levels.

5 When the plug-in you want to assign is displayed, press the
encoder Select switch to confirm your selection.

6 Repeat steps 2-5 to make additional insert assignments.

7 Press the flashing Assign switch to confirm the assignments
and exit Inserts Assign mode.

To remove a plug-in:

1 Press the Set to Default switch.

2 Press the encoder Select switch for each plug-in you want to
remove.

3 Press the flashing Set to Default switch to exit Set to Default
mode.

Default Plug-In Preferences

You can set a default EQ plug-in and default Dynamics plug-in
in Pro Tools, which makes them available for quick assign-
ment from D-Command.

To set a default EQ or Dynamics plug-in:

1 In Pro Tools, choose Setup > Preferences and click Mixing.

2 Under Setup, choose a plug-in from the Default EQ or De-
fault Dynamics pop-up menu.

3 Click OK to close the Preferences window.
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Focusing Plug-Ins on D-Command

A plug-in is focused when its controls are mapped to the
knobs, switches or faders on D-Command. Its parameters can
then be edited and automated from the control surface.
D-Command lets you focus a plug-in with or without display-
ing its window on-screen.

You can focus plug-ins in multiple locations on D-Command:
in the Dynamics section, in the EQ section, and in the Custom
Faders section.

When a plug-in is focused on D-Command and displayed
on-screen in Pro Tools, a colored outline appears in the
plug-in window header.

To focus a plug-in in the Dynamics or EQ section:

1 Focus the plug-in’s track in the Focus Channel section by
pressing the track’s Select switch. The first dynamics and EQ
plug-ins on that track are automatically focused in the corre-
sponding D-Command section.

2 Press the Cycle switch in the Dynamics or EQ section to fo-
cus successive dynamics or EQ plug-ins on that channel. (The
No Insert option is always available.)

To focus a plug-in in the Custom Faders section:

1 Focus the plug-in’s track in the Focus Channel section by
pressing the track’s Select switch. The name of the first plug-in
that is not a dynamics or EQ plug-in appears in the Focus
Channel display.

2 Press the Plug-In switch in the Custom Faders section. The
switch lights to indicate the mode is active. The plug-in name
and channel format appear in the Custom Fader channel dis-

plays, and the plug-in’s parameters appear in the Custom Fader
channel encoders.

3 In the Custom Faders section, press the Bank/Cycle switch to
cycle through the plug-ins on the focused channel. (The No In-
sert option is always available.)

The plug-in whose name appears in the Custom Faders display
is focused in Custom Fader mode. See “Custom Fader Plug-In
Mode” on page 129.

Q When plug-in names are shown on the encoder displays, a
plug-in can be quickly brought into Custom Fader mode by
pressing its associated encoder Select switch.
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Opening Plug-In Windows On-Screen

There are several ways to open plug-in windows on-screen
from D-Command.

To open a plug-in window from any channel on D-Command:

= Hold Start (Windows) or Control (Mac) and press the en-
coder Select switch for the plug-in.

To open a plug-in window on a focused track:

1 Focus a track in the Focus Channel section by pressing its Se-
lect switch.

2 In the Custom Faders section, press the Bank/Cycle switch to
cycle through the plug-ins on the focused track. Plug-In names
are shown in the Custom Faders display.

3 In the Custom Faders section, press the Win switch to open
the plug-in whose name is displayed.

To open a focused dynamics or EQ plug-in window:

= Press the Window switch in the Dynamics or EQ section of
D-Command.

To open or close all focused plug-in windows:

= Press the Plug-In switch in the Window Management sec-
tion.

To close all open plug-in windows:

= Hold Alt (Windows) or Option (Mac) and press the Plug-In
switch in the Window Management section. This closes all
real-time and AudioSuite plug-in windows.

To set D-Command to automatically open plug-in windows:

1 Press the Operations switch in the D-Command Soft Keys
section twice.

2 Press the Soft Key that corresponds to “ChanWn” until its
value is “Yes.”

With this preference set to “Yes,” when you insert a new
plug-in, press an encoder Select switch to edit a plug-in, or cy-
cle through plug-ins on the focused track, the plug-in window
will automatically open on-screen.



Managing Multiple Plug-In Windows

D-Command lets you open and swap multiple plug-in win-
dows on-screen. This makes it possible keep multiple plug-in
windows open while focusing on different tracks (for example,
in a session where several tracks have dynamics and EQ
plug-ins).

Targeting Plug-Ins

A plug-in is said to be targeted on-screen when its target icon
in the plug-in window header is lit red. The first plug-in win-
dow to be opened is automatically targeted.

& When a plug-in window is targeted, it is replaced when you
open any new plug-in window.

& When a plug-in window is not targeted (when its target icon
is grey) the plug-in window will remain on-screen.

To open multiple plug-in windows:

= Hold Shift while opening each new window. The new plug-in
windows are not targeted.

To swap multiple plug-in windows while changing track focus:

1 Focus a track with multiple plug-ins (for example, dynamics,
EQ and pitch shift plug-ins) by pressing the track’s Select
switch.

2 Open multiple plug-in windows on the focused track while
holding the Shift modifier.

3 Hold Alt (Windows) or Option (Mac) while changing focus to
another track with multiple plug-ins by pressing that track’s
Select switch.

Focused plug-ins with open windows swap into new plug-in
windows on-screen, wherever plug-ins are present in the new
track.

Making Plug-Ins Inactive or Active

You can toggle the active/inactive status of a plug-in directly
from a channel strip without putting D-Command into Make
Inactive mode.

To toggle a plug-in active/inactive directly from a channel strip:

1 Press the Inserts switch on a channel strip to display the
names of the plug-ins on the channel’s encoders.

2 If the insert location for the plug-in that you want to make
active/inactive is not showing, press the Page Up or Page Down
switches on the channel until the appropriate location is dis-
played.

3 Hold Control+Start (Windows) or Control+ Command
(Mac) and press the encoder Select switch for the plug-in.

Changing Plug-In Presets from
Channel Strips

You can activate the next or previous settings in the Plug-In
Librarian menu directly from any channel strip or from the
Custom Fader section.

To enable the next or previous plug-in setting from D-Command:
1 Do one of the following:

« Focus the plug-in in a channel strip so its controls are vis-
ible on the channel strip encoders.

o Focus the plug-in in the Custom Faders section.
2 Hold Control (Windows) or Command (Mac) and press the

Page Up (Next) or Page Down (Previous) switch in the chan-
nel’s Channel Strip Mode controls.
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Copying and Pasting Plug-In Settings

You can copy plug-in settings from a plug-in and paste them
into another copy of the same plug-in directly from a channel
strip on D-Command.

To copy and paste plug-in settings:

1 Press the Inserts switch on a channel strip to display the
names of the plug-ins on that channel’s encoders.

2 If the insert location for the plug-in whose settings you want
to copy is not showing, press the Page Up or Page Down
switches on the channel until the appropriate location is dis-
played.

3 Copy the settings of a plug-in by holding Shift+Control
(Windows) or Shift+Command (Mac) and pressing the Select
switch under the name of the plug-in.

4 Paste the settings into another instance of the same plug-in
by pressing the B/M/P switch under the name of that plug-in.

Enabling Plug-In Automation

When plug-in names are displayed in top-level view on a
D-Command channel strip, you can quickly enable all param-
eters of a plug-in for automation.

You can also use the Do To All or Do To Selected switches on
D-Command to automate multiple plug-ins in the same insert
position in a session.

To toggle automation on and off for a parameter of a plug-in:

1 Press the Inserts switch in the Channel Strip Mode controls
of a track to show the top-level Inserts display. Plug-In names
appear in the encoder displays of that track.

2 Press the Page Up or Page Down switch to display the name
of the plug-in you want to automate.

3 Press an encoder Select switch to display that plug-in’s pa-
rameters on the Custom Fader encoders.

4 Hold Control+Alt+Start (Windows) or Command+Op-
tion+Control (Mac) and touch the rotary encoder for the
plug-in parameters you want to enable for automation.
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To toggle automation on and off for all parameters of a plug-in:

1 Press the Inserts switch in the Channel Strip Mode controls
of a track to show the top-level Inserts display. Plug-In names
appear in the encoder displays of that track.

2 Press the Page Up or Page Down switch to display the name
of the plug-in you want to automate.

3 Hold Control+Alt+Start (Windows) or Command+Op-
tion+Control (Mac) and touch the rotary encoder for the
plug-in whose parameters you want to enable for automation.

To toggle automation on and off for all plug-ins in a given Insert
position:

1 Press the Inserts switch in the Channel Strip Mode controls
of a track to show the top-level Inserts display. Plug-In names
appear in the encoder displays of that track.

2 Press the Page Up or Page Down switch to display the insert
position for the plug-ins you want to automate.

3 Press the Do To All switch in the Global controls section.

4 Hold Control+Alt+Start (Windows) or Command+Op-
tion+Control (Mac) and touch the rotary encoder for any
plug-in at the insert position (Insert 1-5) where you want to
enable plug-in automation.

To toggle automation on and off for plug-ins in a given Insert
position on all selected tracks:

1 Select the tracks containing the plug-ins you want to enable
for automation.

1 Press the Inserts switch in the Channel Strip Mode controls
of a track to show the top-level Inserts display. Plug-In names
appear in the encoder displays of that track.

2 Press the Page Up or Page Down switch to display the insert
position for the plug-ins you want to automate.

3 Press the Do To Selected switch in the Global controls sec-
tion.

4 Hold Control+Alt+Start (Windows) or Command+Op-
tion+Control (Mac) and touch the rotary encoder for any
plug-in at the insert position (Insert 1-5) where you want to
enable plug-in automation.



Plug-In Mapping

You can put a plug-in into Learn mode, select parameters for
mapping, and independently map two sets of plug-in parame-
ters to each encoder or its associated B/M/P switch, all directly
from the control surface.

For complete instruction on creating and managing
plug-in maps, see the Pro Tools Reference Guide.

You can map parameters to encoders and B/M/P switches in
both the Custom Faders and in channel strips.

Q You cannot map controls to the EQ and Dynamics
" sections of D-Command.

When you put a plug-in into Learn mode, its track is focused
in the Focus Channel strip and it is automatically put into
Custom Fader Plug-In mode. In Learn mode, encoder displays
for a focused plug-in are blank, showing that it is ready for
mapping of parameters to the encoders and B/M/P switches.

LrnTch (Learn Touch) Console Preference

The Learn Touch preference (in the Operation Soft Keys) de-
termines whether controls are active when a plug-in is in
Learn mode. When this preference is enabled, encoders and
switches will not send commands to Pro Tools while in Learn
mode, but will only allow Learn mode operations. This lets
you select parameters for mapping from the control surface.

Plug-In Mapping and Channel Strips

D-Command plug-in map parameters are arranged in Channel
Strip pages of 6 separately mappable encoders and switches.
These pages are displayed 2 encoders at a time on D-Command
channel strips.

Plug-In Mapping and Custom Fader Bank Size

D-Command plug-in map parameters are arranged in Custom
Fader pages of 8 separately mappable encoders and switches.

When plug-in mapping is displayed in Plug-In Custom Fader
banks, the arrangement of plug-in map pages follows the set-
ting for Maximum Custom Fader Bank Size for Plug-Ins (in
the Operation Soft keys).

Q When creating and recalling plug-in maps, it is important
to use the same Custom Fader Bank Size setting, so that
plug-in maps display consistently. The examples in this sec-
tion are for a Custom Fader Bank Size of 8 channels.

Putting a Plug-In into Learn Mode

You can put a plug-in into Learn mode directly from D-Com-
mand.

To put a plug-in into Learn mode from the control surface:
1 Focus the plug-in in Custom Fader mode.

2 Hold Start (Windows) or Control (Mac) and press the Map
switch in the Custom Faders section.

To take a plug-in out of Learn mode from the control surface:
= Hold Start (Windows) or Control (Mac) and press the flash-
ing Map switch in the Custom Faders section.

= Press the Win switch in the Custom Faders section to close
the plug-in window.

Creating and Editing Plug-In Maps

To create a custom map of plug-in parameters:
1 Make the LrnTch (Learn Touch) preference (in the Operation
Soft Keys) is set to On.

2 Open the plug-in whose mapping you want to customize.

3 Put the plug-in into Learn mode. The plug-in is focused with
blank encoders and switches, ready for mapping.

4 On the control surface, do one of the following:

« For an EQ or Dynamics plug-in, make sure a plug-in of
the same type is displayed in the EQ or Dynamics section
of the control surface.

« For all other plug-in types, display a different instance of
the same plug-in type in a second location (for example,

on a channel strip in Normal mode, or in another bank of
Custom Faders).

5 Touch the encoder or press the switch for the parameter you
want to map. The encoder’s auto LED or the switch’s Mute LED
lights.

6 On the encoder where you want to map the parameter, press
the encoder Select switch to toggle between the two available
views on the control.

7 Map the parameter by doing one of the following:

o Touch the encoder to map a continuous or a switched pa-
rameter, or press the B/M/P switch to map a switched pa-
rameter.

— or —

o If D-Command is in Flip mode, touch the fader to map a
continuous or a switched parameter, or press the channel
Select switch to map a switched parameter.

8 Take the plug-in out of Learn mode.
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To change parameter mapping in a plug-in map:

1 Make the LrnTch (Learn Touch) preference (in the Operation
Soft Keys) is set to On.

2 Open the plug-in whose mapping you want to change.

3 Choose the map you want to change from the Map Preset
pop-up menu.

4 Put the plug-in into Learn mode. The plug-in map is focused
on the control surface.

5 On the control surface, do one of the following:

« For an EQ or Dynamics plug-in, make sure a plug-in of
the same type is displayed in the EQ or Dynamics section
of the control surface.

« For all other plug-in types, display a different instance of
the same plug-in type in a second location (for example,

on a channel strip in Normal mode, or in another bank of
Custom Faders).

6 Touch the encoder or press the switch for the parameter you
want to map. The encoder’s auto LED or the switch’s Mute LED
lights.

7 Locate the encoder where you want to change the mapping,
and if necessary, press the encoder Select switch to toggle be-
tween the two available views on the control.

8 Touch the encoder or press the B/M/P switch to map the pa-
rameter.

9 Take the plug-in out of Learn mode.

To remove parameter mapping from a plug-in map:

1 Make the LrnTch (Learn Touch) preference (in the Operation
Soft Keys) is set to On.

2 Open the plug-in whose custom map you want to change.

3 Choose the map you want to change from the Map Preset
pop-up menu.

4 Put the plug-in into Learn mode. The plug-in map is focused

on the control surface.

5 Locate the encoder where you want to change the mapping,
and if necessary, press the encoder Select switch to toggle be-
tween the two available views on the control.

6 Do one of following for each parameter mapping you want to
remove:

o If the Parameter menu shows No Control, touch the en-
coder or press the B/M/P switch to remove the parameter

mapping.

o If the Parameter menu shows the name of a preset, hold
Control (Windows) or Command (Mac) and press the
B/M/P switch to remove the parameter mapping.

7 Take the plug-in out of Learn mode.
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Changing Plug-In Map Presets from D-Command

You can select the next or previous plug-in map for a plug-in
directly from D-Command.

To enable the next or previous plug-in map from a channel strip:

1 Focus the plug-in in the channel strip so its controls are vis-
ible on the channel strip encoders.

2 Hold Start (Windows) or Control (Mac) and press the Page
Up (Next) or Page Down (Previous) switch in that channel

strip’s Channel Strip Mode controls. The name of the plug-in
map preset is shown momentarily in the bottom encoder dis-

play.

To enable the next or previous plug-in map from the Custom
Faders:

1 Focus the plug-in in the Custom Faders section.

2 Hold Start (Windows) or Control (Mac) and press the Page

Up (Next) or Page Down (Previous) switch in a Custom Fader
channel. The name of the plug-in map preset is shown momen-
tarily in the Custom Fader channel displays.

Q To select the next or previous plug-in map on multiple
© channels, use the Do To All and Do To Selected switches
on D-Command.



Dynamics Section

The Dynamics section includes standard controls for compressor, gate, and limiter plug-ins, an array of controls for managing
the display and editing of plug-in parameters, and for selecting or linking channels in multi-mono plug-ins.
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D-Command Dynamics section

Dynamics Plug-In Support

Dynamics processing plug-ins may have widely varying con-
trols, depending on their applications. The D-Command Dy-
namics Section provides dedicated knobs and switches to ac-
commodate a wide range of possible plug-ins. Not all plug-ins
will require all the Dynamics controls, while others may have
more parameters than can be displayed in the Dynamics sec-
tion at one time. To display all controls of any plug-in, use
Custom Fader Plug-Ins mode. (See “Custom Fader Plug-In
Mode” on page 129.)

Threshold/Output Level

Dynamics Edit/Display/Page controls

Displaying Dynamics Plug-Ins

The D-Command Dynamics section automatically focuses the
first dynamics plug-in on the channel displayed in the Focus
Channel section on the Main Unit.

To display successive dynamics plug-ins that are on the fo-
cused channel, press the Cycle switch in the Dynamics section.
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Knee/Hysteresis/Q and
Ratio/Range/Frequency Controls
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Knee/Hysteresis/Q and Ratio/Range/Frequency controls in the
Dynamics section

Knee/Hysteresis/Q Control

The top encoder in this section controls the knee shape, the
hysteresis value, or the Q value for the current plug-in page,
depending on which indicator is lit. The Auto indicator under
the encoder knob lights when the displayed parameter is en-
abled for automation.

Ratio/Range/Frequency Control

The bottom encoder in this section controls the compression
ratio, the range value, or the filter frequency for the current
plug-in page, depending on which indicator is lit. The Auto in-
dicator under the encoder knob lights when the displayed pa-
rameter is enabled for automation.
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Attack/Q and Release/Frequency Controls
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Attack/Q and Release/Frequency controls in the Dynamics section

Attack/Q Control

The top encoder in this section controls the attack value, or
the Q value for the current plug-in, depending on which indi-
cator is lit. The Auto indicator under the encoder knob lights
when the displayed parameter is enabled for automation.

Release/Frequency Control

The bottom encoder in this section controls the release value
for the current plug-in, or the filter frequency for the current
plug-in page, depending on which indicator is lit. The Auto in-
dicator under the encoder knob lights when the displayed pa-
rameter is enabled for automation.



Gain/Hold and Threshold Controls
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Gain/Hold and Threshold controls in the Dynamics section
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Gain/Hold/Input Control

The top encoder in this section controls the gain (make-up
gain), the hold value for the current plug-in page, or the input
gain for the current plug-in, depending on which indicator is
lit. The Auto indicator under the encoder knob lights when the
displayed parameter is enabled for automation.

Threshold/Output Control

The bottom encoder in this section controls the threshold
value for the current plug-in page, or the output gain for the
current plug-in, depending on which indicator is lit. The Auto
indicator under the encoder knob lights when the displayed
parameter is enabled for automation.
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Dynamics Channel Select Controls
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Channel Select controls in the Dynamics section
Dynamics Display

The LED display in the Dynamics section show the name of the
focused plug-in by default. When any rotary encoder is
touched, the display shows the corresponding parameter
value.

Lock Switch

The Lock switch is used to lock the focus of the Dynamics sec-
tion on the current plug-in. When the plug-in focus is locked,
the current plug-in remains in the Dynamics section, even
when a different track is focused on D-Command. This switch
lights when the plug-in focus is locked.

Save and Save As Switches

The Save and Save As switches perform the Save and Save As
commands in the Plug-In settings menu. The Save command
saves current parameter settings to the current plug-in set-
tings file, and the Save As command saves the parameter set-
tings to a new plug-in settings file.

To save a Dynamics plug-in setting from D-Command:

1 Press the Save or Save As switch in the Channel Select con-
trols of the Dynamics section. The Save or Save As switch
flashes while the Save Settings dialog is open.

2 Type a name for the plug-in setting.

3 Do one of the following:
« Click OK to save the settings and close the dialog.

« Press the flashing Save or Save As switch to save the set-
tings and close the dialog.

o Press the Escape switch to exit the dialog without saving
the settings.
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Channel Select Switches

Multichannel Plug-Ins

When you are working with a multichannel plug-in, all chan-
nels are controlled in tandem and the Channel Select switches
have no effect.

Multi-Mono Plug-Ins

When you are working with a multi-mono plug-in, the con-
trols for the channels are usually linked and edited together.

However, you can edit plug-in settings for individual channels
of a multi-mono plug-in by using the Channel Select switches
to unlink all of the channels, or to link specific channels.

There are Channel Select switches for the following channels:
o L (Left)
o C (Center)
. R (Right)
o Ls (Left Surround)
« Rs (Right Surround)
« LFE

A maximum of six channels (5.1 surround) may be in use at
any time.



Master Link Switch

Multichannel Plug-Ins

When you are working with a multichannel plug-in, all chan-
nels are controlled in tandem, and the Master Link switch has
no effect.

Multi-Mono Plug-Ins

When you are working with a multi-mono plug-in, the Master
Link switch toggles the Master Link button in the plug-in win-
dow, which links or unlinks all channels of the plug-in. When
the Master Link button is enabled, the Link switch is lit.

Select/Link/Bypass Mode Switch

The Select/Link/Bypass Mode switch determines the function
of the Channel Select switches with multi-mono plug-ins.

Select Mode In this mode, the Channel Select switches deter-
mine which channel of a multi-mono plug-in is the focus of
the plug-in controls. When a channel is selected, its switch is
lit. If any channels are linked, their switches follow linked be-
havior.

In Select mode, if the D-Command Channel Window Display
preference is set to Yes, the Channel Select switches also
change the channel display in the plug-in window.

Bypass Mode In this mode, the Channel Select switches deter-
mine which channels of a multi-mono plug-in are bypassed.
When a channel is bypassed, its switch is lit. If any channels
are linked, their switches follow linked behavior.

Link Mode In this mode, the Channel Select switches deter-
mine which individual channels of a multi-mono plug-in are
linked together. Linked channels are indicated by switches
that are lit.
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Dynamics Edit and Display Controls
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Edit and Display controls in the Dynamics section

External Key Switch

The External Key switch turns the Key Input on or off for
plug-ins that support side-chain processing with external in-
put. This switch lights when Key Input is on.

Key Listen Switch

The Key Listen switch turns the Key Listen function on or off
for plug-ins that support auditioning the Key Input. This
switch lights when Key Listen is on.

Automation Switch

The Automation switch lets you enable Dynamics parameters
for automation by touching or pressing their controls in the
Dynamics section only.

In Automation mode, the Auto switch is lit. While in this
mode, the Auto indicator for any rotary encoder enabled for
automation is lit red, and the switch for any parameter en-
abled for automation is lit.

To toggle automation on and off for individual Dynamics
parameters:

1 Press the Automation switch.

2 Touch the rotary encoders or press the switches in the Dy-
namics section for which you want to toggle automation.

3 Press the Automation switch again to exit Automation mode.
To toggle automation on and off for all parameters of a Dynamics
plug-in:
1 Press the Automation switch.
2 Do one of the following:

« Hold Alt (Windows) or Option (Mac).

« Hold Do to All.

3 Touch any rotary encoder or press any switches in the Dy-
namics section.
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4 Press the Automation switch again to exit Automation mode.

Automation Safe Switch

The Automation Safe switch toggles the Safe button in the
plug-in window, which protects existing automation for that
plug-in from being overwritten.

Window Switch

The Window switch is used to open and close the on-screen
window for the currently focused plug-in.

Compare Switch

The Compare switch toggles the Compare button in the
plug-in window, which alternates between the currently saved
plug-in setting and any changes you have made.

Cycle Switch

The Cycle switch steps through all available Dynamics
plug-ins on the focused channel.

Bypass Switch

The Bypass switch bypasses the plug-in.

Page Switch

With plug-ins that have more than one page of controls, the
Page switch lights. Pressing this switch steps through the
pages for the currently displayed plug-in.

The current function of the rotary encoders in the Dynamics
section is shown by the corresponding indicator LEDs. Active
controls are shown in the on-screen plug-in window by col-
ored outlines.



Dynamics Gain Controls and Meters
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Level meters in the Dynamics section

Output Meter and Clip Indicator

The Output meter shows the output level for the current
plug-in. The Clip indicator lights when a clip is reported by
the plug-in, and can be cleared by pressing the Clear Clip

switch in the Session Management section.

Gain Reduction Meter

The Gain Reduction meter shows the amount of gain reduc-
tion for Compressor/Limiter functions (using the range
shown on the left) and Expander/Gate functions (using the

range shown on the right).
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EQ Section

The EQ section includes standard controls for a variety of multi-band equalization plug-ins, an array of controls for managing the
display and editing of plug-in parameters, and controls for selecting or linking channels in multi-mono plug-ins.
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EQ Edit and Display controls

D-Command EQ section

EQ Plug-In Support Displaying EQ Plug-Ins

EQ processing plug-ins may have widely varying controls, de- The D-Command EQ section automatically displays the first
pending on their applications. The D-Command EQ section EQ plug-in on the channel that is focused in the Focus Channel
uses paging to accommodate the widest range of plug-ins pos- section on the Main Unit.

sible.

To display successive EQ plug-ins that are on the focused
Each encoder column controls several frequency bands, which channel:
are chosen by pressing the Page switch. LEDs light to indicate
the frequency band that is currently active for editing.
Notch/Shape switches are located on the Low and High band
to change filter types.

= Press the Cycle switch in the EQ section.

To simultaneously display all controls of any plug-in, use Cus-
tom Fader Plug-Ins mode. (See “Custom Fader Plug-In Mode”
on page 129.)
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Low Filter and High-Pass Filter Controls

LF/HPF
OO0

Q encoder

’,7 Notch/Shape switch
aa >
@

Notch indicator. Shelf indicator

Frequency encoder

Low Filter. 35 e High-Pass Filter
indicator LF HPF indicator

Gain
encoder

Filter In switch

Low Filter and High-Pass Filter controls in the EQ section
Q Encoder

The top encoder controls the Q of the selected filter. The Auto
indicator under the encoder knob lights when the parameter is
enabled for automation.

Notch/Shape Switches and Indicator

The Notch/Shape switch let you switch between the two filter
types when they are available. The indicators on either side of
the switch light to show which type of filter is active.

Frequency Encoder

The middle encoder controls the filter frequency for the cur-
rently selected band. When the filter is a notch filter, the en-
coder controls the center frequency. When the selected filter
is a low-pass filter, the encoder controls the cutoff frequency.
The Auto indicator under the encoder knob lights when the
parameter is enabled for automation.

Gain Encoder

The bottom encoder controls the gain for each band. The Auto
indicator under the encoder knob lights when the parameter is
enabled for automation.

Filter In Switch

The Filter In switch lets you engage or bypass the correspond-
ing EQ band in the plug-in.

Low-Mid Filter and Mid Filter Controls

LMF/MF

Q encoder

Frequency encoder

Low-Mid Filter
indicator

Mid Filter
indicator

Gain
encoder

Filter In switch

Low-Mid Filter and Mid Filter controls in the EQ section
Q Encoder

The top encoder controls the Q of the selected filter. The Auto
indicator under the encoder knob lights when the parameter is
enabled for automation.

Frequency Encoder

The middle encoder controls the center frequency for the cur-
rently selected band. The Auto indicator under the encoder
knob lights when the parameter is enabled for automation.

Gain Encoders

The bottom encoder controls the gain for each band. The Auto
indicator under the encoder knob lights when the parameter is
enabled for automation.

Filter In Switch

The Filter In switch lets you engage or bypass the correspond-
ing EQ band in the plug-in.
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High-Mid Filter and EQ Level Controls
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High-Mid Filter and EQ level controls in the EQ section
Q/Input level Encoder

The top encoder controls the Q of the High-Mid filter, or the
Input level. The Auto indicator under the encoder knob lights
when the parameter is enabled for automation.

Frequency/Output Level Encoder

The middle encoder controls the center frequency for the cur-
rently selected band, or the Output level. The Auto indicator

under the encoder knob lights when the parameter is enabled
for automation.

Gain Encoder

The bottom encoder controls the gain for the High-Mid band.
The Auto indicator under the encoder knob lights when the
parameter is enabled for automation.

Filter In Switch

The Filter In switch lets you engage or bypass the correspond-
ing EQ band in the plug-in.
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High Filter and Low-Pass Filter Controls
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Low Filter and High Filter controls in the EQ section
Q Encoders

The top encoder controls the Q of the selected band. The Auto
indicator under each encoder knob lights when the parameter
is enabled for automation.

Notch/Shape Switches and Indicator

The Notch/Shape switch let you switch between the two filter
types when they are available. The indicators on either side of
the switch light to show which type of filter is active.

Frequency Encoder

The middle encoder controls the filter frequency for the cur-
rently selected band. When the filter is a notch filter, the en-
coder controls the center frequency. When the selected filter
is a low-pass filter, the encoder controls the cutoff frequency.
The Auto indicator under the encoder knob lights when the
parameter is enabled for automation.

Gain Encoder

The bottom encoder controls the gain for each band. The Auto
indicator under the encoder knob lights when the parameter is
enabled for automation.

Filter In Switch

The Filter In switch lets you engage or bypass the correspond-
ing EQ band in the plug-in.



EQ Channel Select Controls

EQ display

Lock switch
Lock Save

Save and Save As switches

Master Link switch
Link

Channel Select controls in the EQ section
EQ Displays

The LED display in the EQ section shows the name of the fo-
cused plug-in by default. When any rotary encoder is touched,
the display shows the corresponding parameter value.

Lock Switch

The Lock switch is used to lock the focus of the EQ section on
the current plug-in. When the plug-in focus is locked, the cur-
rent plug-in remains in the EQ section, even when a different
track is focused on D-Command. This switch lights when the
plug-in focus is locked.

Save and Save As Switches

The Save and Save As switches perform the Save and Save As
commands in the Plug-In settings menu. The Save command
saves current parameter settings to the current plug-in set-
tings file, and the Save As command saves the parameter set-
tings to a new plug-in settings file.

To save an EQ plug-in setting from D-Command:

1 Press the Save or Save As switch in the Channel Select con-
trols of the EQ section. The Save or Save As switch flashes
while the Save Settings dialog is open.

2 Type a name for the plug-in setting.

3 Do one of the following:
« Click OK to save the settings and close the dialog.

« Press the flashing Save or Save As switch to save the set-
tings and close the dialog.

o Press the Escape switch to exit the dialog without saving
the settings.
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Channel Select switches
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Save As
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Select/Link/Bypass Mode switch
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Channel Select Switches

Multichannel Plug-Ins

When you are working with a multichannel plug-in, all chan-
nels are controlled in tandem and the Channel Select switches
have no effect, except with multichannel plug-ins (such as
Focusrite d2) that directly support channel selection.

Multi-Mono Plug-Ins

When you are working with a multi-mono plug-in, the con-
trols for the channels are usually linked and edited together.

However, you can edit plug-in settings for individual channels
of a multi-mono plug-in by unlinking all of the channels, or by
using the Channel Select switches to link specific channels.

There are Channel Select switches for the following channels:
o L (Left)
o C (Center)
« R (Right)
o Ls (Left Surround)
« Rs (Right Surround)
« LFE

These choices can be used to support all possible channel con-
figurations in Pro Tools. A maximum of six channels (5.1 sur-
round) may be in use at any time.
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Master Link Switch

Multichannel Plug-Ins

When you are working with a multichannel plug-in, all chan-
nels are controlled in tandem, so the Master Link switch has
no effect, except with multichannel plug-ins (such as
Focusrite d2) that directly support channel linking.

Multi-Mono Plug-Ins

When you are working with a multi-mono plug-in, the Master
Link switch toggles the Master Link button in the plug-in win-
dow, which links or unlinks all channels of the plug-in. When
the Master Link button is enabled, the Link switch is lit.
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Select/Link/Bypass Mode Switch

The Select/Link/Bypass Mode switch determines the function
of the Channel Select switches with multi-mono plug-ins.

Select Mode In this mode, the Channel Select switches deter-
mine which channel of a multi-mono plug-in is the focus of
the plug-in controls. When a channel is selected, its switch is
lit. If any channels are linked, their switches follow linked be-
havior.

In Select mode, if the D-Command Channel Window Display
preference is set to Yes, the Channel Select switches also
change the channel display in the plug-in window.

Bypass Mode In this mode, the Channel Select switches deter-
mine which channels of a multi-mono plug-in are bypassed.
When a channel is bypassed, its switch is lit. If any channels
are linked, their switches follow linked behavior.

Link Mode In this mode, the Channel Select switches deter-
mine which individual channels of a multi-mono plug-in are
linked together. Linked channels are indicated by switches
that are lit.



EQ Edit and Display Controls
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Edit and Display controls in the EQ section

Automation Switch

The Automation switch lets you enable EQ parameters for au-
tomation by touching or pressing their controls in the EQ sec-
tion only.

In Automation mode, the Auto switch is lit. While in this
mode, the Auto indicator for any rotary encoder enabled for
automation is lit red, and the switch for any parameter en-
abled for automation is lit.

To toggle automation on and off for individual EQ parameters:

1 Press the Automation switch.

2 Touch the rotary encoders or press the switches in the EQ
section for which you want to toggle automation.

3 Press the Automation switch again to exit Automation mode.
To toggle automation on and off for all parameters of an EQ
plug-in:
1 Press the Automation switch.
2 Do one of the following:

« Hold Alt (Windows) or Option (Mac).

« Hold Do to All.

3 Touch any rotary encoder or press any switches in the EQ
section.

4 Press the Automation switch again to exit Automation mode.

Automation Safe Switch

The Automation Safe switch toggles the Safe button in the
plug-in window, which protects existing automation for that
plug-in from being overwritten.

Page

Compare Switch

The Compare switch toggles the Compare button in the
plug-in window, which alternates between the currently saved
plug-in setting and any changes you have made.

Window Switch

The Window switch is used to open and close the on-screen
window for the currently focused plug-in.

Output Meter and Clip Indicator

The Output meter shows the output levels for the current
plug-in. The Clip indicator lights when a clip is reported by
the plug-in, and can be cleared by pressing the Clear Clip
switch in the Session Management section.

Cycle Switch

The Cycle switch steps through all available EQ plug-ins on
the focused channel.

Bypass Switch

The Bypass switch bypasses the plug-in.

Page Switch

The Page switch steps through the pages for the currently dis-
played plug-in. The Page switch lights when plug-ins have
more than one page of controls. Active controls are shown in
the on-screen plug-in window by colored outlines.
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Chapter 8: Transport and Navigation Controls

Transport Section

The D-Command Transport section includes transport switches, switches for setting the transport mode, scrub/shuttle switches

and controls, and advanced audition and locate switches.

Audition switches

Master Record Mode
switch

Locate switches

Pro Tools Transport
switches

D-Command Transport Section

Transport Switches

MIDI Merge
indicator

Record

Fast  Stop ay
Forward

Pro Tools Transport switches

Rewind

Pro Tools Transport

The D-Command Pro Tools Transport switches correspond to
the controls in the Pro Tools Transport window.

Rewind Switch Moves backward through the Pro Tools session
beginning from the current cursor position.

Fast Forward Switch Moves forward through the Pro Tools
session beginning from the current cursor position.

Stop Switch Stops playback of the Pro Tools session.

Play Switch Begins playback of the Pro Tools session from the
current cursor position.

Transport Mode switches

Scrub/Shuttle
controls

Record Switch Arms Pro Tools for recording. The exact func-
tion of the Record switch depends on the current Pro Tools re-
cord mode (QuickPunch, TrackPunch, Wait for Note, Pause).

MIDI Merge Indicator Shows when MIDI Merge is activated.

Latching Behavior for Fast Forward and Rewind
Switches

You can set Fast Forward or Rewind to follow latched behavior
from the D-Command Transport section.

To set Fast Forward to latch:

= Hold the Fast Forward switch and momentarily press the Re-
wind switch.

To set Rewind to latch:

= Hold the Rewind switch and momentarily press the Fast For-

ward switch.

Playback of Timeline Selection and Edit Selection
from the Transport

When the Timeline and Edit selections in the Edit window are
unlinked, you can set the D-Command Transport to control
playback of either the Timeline selection or the Edit selection.
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To focus the D-Command Transport on the Timeline selection:
» Press the Edit/Timeline Selection switch in the Miscella-
neous Controls section so that the Timeline LED is lit.

To focus the D-Command Transport on the Edit selection:

» Press the Edit/Timeline Selection switch in the Miscella-
neous Controls section so that the Edit LED is lit.

Scrub/Shuttle Controls

The Scrub/Shuttle controls are used for scrubbing, scrubbing
while trimming, shuttling, and making selections.

Trim  Scrub Shuttle
switch switch switch

© O ©

Trim Scrub Shuttle

Scrub/Shuttle
Wheel

Scrub/Shuttle controls

Scrub/Shuttle Wheel

The Scrub/Shuttle wheel is used to control cursor position in
Pro Tools and for locating external machines.

Scrolling and Locating in Pro Tools Windows
To horizontally scroll the contents of the Edit window or Mix
window:

1 Focus the window you want to scroll by clicking in it or by
pressing the corresponding window key in the Window Man-
agement section.

2 Hold Alt (Windows) or Option (Mac) while turning the
Scrub/Shuttle Wheel.

To vertically scroll the contents of the Edit window or Mix
window:

1 Focus the window you want to scroll by clicking in it or by
pressing the corresponding window key in the Window Man-
agement section.

2 Hold Shift while turning the Scrub/Shuttle Wheel.

To locate the cursor in the Edit window while in Continuous
Scroll Mode:

= Hold Control+Alt+Start (Windows) or Command+Op-
tion+Control (Mac) and press the Mark In or Mark Out switch
in the Audition section.
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Selecting with the Scrub/Shuttle Wheel

To create selections with the Scrub/Shuttle wheel:

1 Locate the cursor in a track.
2 Press the Scrub switch or the Shuttle switch.

3 Do one of the following:

« Hold the Mark In switch and turn the Scrub/Shuttle wheel
counter-clockwise to create or extend the selection to the
left.

« Hold the Mark Out switch and turn the Scrub/Shuttle
wheel clockwise to create or extend the selection to the
right.

To scrub while adding to the front of a selection:

= Hold Start+Shift (Windows) or Control + Shift (Mac) while
scrubbing the front of the selection.

To scrub while adding to the end of a selection:

= Hold Start+Shift+Alt (Windows) or Control+Shift+Option
(Mac) while scrubbing the end of the selection.

To scrub with fine resolution while adding to the front of a

selection:

» Hold Start+Shift+Control (Windows) or Con-
trol+Shift+Command (Mac) while scrubbing the front of the
selection.

To scrub with fine resolution while adding to the end of a
selection:

= Hold Start+Shift+Alt+Control (Windows) or Con-
trol+Shift+Option+Command (Mac) while scrubbing the end
of the selection.

Continuous Zooming in the Edit Window

To horizontally zoom continuously in the Edit window:

= Hold Control (Windows) or Command (Mac) while turning
the Scrub/Shuttle Wheel.

To vertically zoom continuously in the Edit window:

= Hold Control+Alt (Windows) or Command+Option (Mac)
while turning the Scrub/Shuttle Wheel.

Moving Windows On-Screen with the Scrub/Shuttle Wheel

To move a Pro Tools window horizontally on-screen:

= In the Window Management section, hold the switch for the
window and turn the Scrub/Shuttle wheel.

To move a Pro Tools window vertically on-screen:

= In the Window Management section, hold the switch for the
window, hold Shift, and turn the Scrub/Shuttle wheel.



Nudging Track Position or Focus on D-Command with the
Scrub/Shuttle Wheel

To nudge the position of tracks on D-Command in Normal mode:

= Hold any of the Nudge/Bank switches and turn the
Scrub/Shuttle wheel.

To nudge the position of tracks on D-Command in Custom
Faders:

= Hold the Bank/Cycle switch in the Custom Faders section
and turn the Scrub/Shuttle wheel.

Trim Switch

The Trim switch places the transport in Trim/Scrub mode,
which lets you scrub to locate an edit point, then trim to that
point.

To use Trim/Scrub:
1 Navigate to a clip or selection you want to trim.

2 Press the Trim switch.

Q To trim to the end of a selection, hold Alt (Windows) or Op-
tion (Mac) while pressing the Trim switch.

3 Press the Scrub switch.

4 Rotate the Scrub/Shuttle wheel to move the cursor to the
trim location.

5 To trim to the cursor location, press the Trim switch again.
To cancel without trimming, press Escape.

Scrub Switch

The Scrub switch places the transport in Scrub mode, which
lets you scrub from the cursor position or across a selection.

To use Scrub mode:

1 While Pro Tools is stopped, press the Scrub switch.

2 Rotate the Scrub/Shuttle wheel clockwise to scrub audio for-
ward, or counter-clockwise to scrub audio backward.

3 To exit, press the Scrub switch again.

Shuttle Switch

The Shuttle switch places the transport in Shuttle mode, which
lets you locate the cursor in the Edit window.

To use Shuttle mode:

1 While Pro Tools is stopped, press the Shuttle switch.

2 Rotate the Scrub/Shuttle wheel clockwise to shuttle forward,
or counter-clockwise to shuttle backward.

3 To exit, press the Shuttle switch again.

Scrub, Trim/Scrub and Shuttle modes can be used to create se-
lections and define clips in the Pro Tools Edit window.

Master Record Enable Switch

Gi Master Record Enable switch

Master
Record

Master Record Enable switch

The Master Record Enable switch toggles record enable status
for all applicable audio tracks in a session. This switch flashes
when channels are record-enabled and the Pro Tools trans-
port is stopped, and lights continuously during recording.

If any tracks in the session are record-enabled, pressing the
Master Record Enable switch takes them out of their enabled
state. If no channels are record-enabled, pressing the Master
Record Enable switch places all applicable audio tracks into
record-enabled state.
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Transport Mode Switches

The Transport Mode switches are used to put the Pro Tools
transport in the various playback and record modes.

Machine Loop Playback QuickPunch
switch switch switch
Pro Tools Online Transport Master TrackPunch

switch switch switch
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Transport Mode switches

Pro Tools Online Switch

The Pro Tools Online switch toggles the Pro Tools online
state. The online state is mirrored in the Online button in the
Pro Tools Transport window.

While Pro Tools is online and waiting for timecode, this
switch flashes. When timecode is received, this switch lights
continuously.

Machine Switch

The Machine switch is used in Multi-Mode to switch control
between Pro Tools systems. For more information, see
“D-Command Multi-Mode” on page 81.

Transport Master Switch

WIth the Machine Control option, the Transport Master
switch toggles the Pro Tools transport master between
“Transport = Pro Tools” and “Transport = Machine” (in Serial
Deck Control mode) or between “Transport = Pro Tools” and
“Transport = Remote” (in Remote mode).

Loop Playback Switch

The Loop Playback switch toggles Loop Playback mode in
Pro Tools. When Loop Playback mode is active, this switch
lights. The Loop Playback state is mirrored in the Play button
in the Pro Tools Transport window.

QuickPunch Switch

The QuickPunch switch toggles QuickPunch record mode in
Pro Tools. When QuickPunch mode is active, this switch
lights. The QuickPunch state is mirrored in the Record button
in the Pro Tools Transport window.

TrackPunch Switch

The TrackPunch switch toggles TrackPunch record mode in
Pro Tools. When TrackPunch mode is active, this switch
lights. The TrackPunch state is mirrored in the Record button
in the Pro Tools Transport window.
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Audition Switches

The Audition switches are used to activate pre-roll and
post-roll in playback, define selection in and out points, and
trigger automatic playback of ranges

Audition Mark In Post-Roll
switch Pre-Roll switch Mark Out switch
switch switch
AUDITION

OO0 000

Audition  Pre-Roll  MarkIn  Mark Out Post-Roll

Audition switches

Audition Switch

The Audition switch toggles Audition mode on and off. When
Audition mode is on, this switch lights.

When Audition mode is on, you can quickly listen to either the
start or end of a selection, with or without pre-roll or post-roll,
by pressing the following switches:

Pre-Roll Switch Plays audio starting at the pre-roll point up to
the beginning of the selection.

Mark In Switch Plays audio starting at the selection start
through the length of the post-roll amount.

Mark Out Switch Plays audio back-timed from the selection
end by the pre-roll amount.

Post-Roll Switch Plays audio starting at the end of a selection
through the post-roll amount.

Pre-Roll and Post-Roll Switches

When Audition mode is off, the Pre-Roll and Post-Roll
switches toggle pre-roll and post-roll playback on and off in
Pro Tools. When pre-roll or post-roll is active, the corre-
sponding switch lights.

When Audition mode is on, the Pre-Roll and Post-Roll
switches play a range of audio around the current Edit selec-
tion.



Mark In and Mark Out Switches

When Audition mode is off, the Mark In and Mark Out
switches are used to define selection start and end during
playback, or when using the Scrub/Shuttle wheel.

When Audition mode is on, the Mark In and Mark Out
switches play a range of audio around the current Edit selec-
tion.

To move the selection start:

With the transport stopped, hold the Mark In switch and turn
the Scrub/Shuttle wheel.

To move the selection end:

With the transport stopped, hold the Mark In switch and turn
the Scrub/Shuttle wheel.

To move the entire selection:
With the transport stopped, hold both the Mark In and Mark
Out switches and turn the Scrub/Shuttle wheel.

Locate Switches

The Locate switches move the Pro Tools transport to the des-
ignated location.

Instant

GoTo Start  Go To End Back Back & Play  Playback
switch switch switch switch switch
Back Back Instant
Iq D' & Play Playback

Locate switches

Go To Start Switch

The Go To Start switch returns the playback cursor to the be-
ginning of the session.

Go to End Switch

The Go To End switch moves the playback cursor to the end of
the session.

Back Switch

The Back switch stops the Transport (if it is moving) and
moves the playback cursor back (earlier in time) by the
amount of time selected in Back settings pop-up in Pro Tools.
You can also click repeatedly to move back multiple times.

Forward Mode

Forward mode can be invoked by pressing Alt (Windows) or
Option (Mac), and pressing the Back switch.

Back & Play Switch

The Back and Play switch combines the function of the Back
switch and the Transport Play switch. The playback cursor
moves back by the amount of time selected in the Back settings
preference in Pro Tools.

If pre-roll is enabled, the pre-roll time will be observed in ad-
dition to the Back time if pre-roll is enabled.

Forward & Play Mode
Forward & Play mode can be invoked by doing the following:

To move the playback location forward and begin playback:

= Hold Alt (Windows) or Option (Mac) and press the Back and
Play switch in the Transport section.

Instant Playback

The Instant Playback switch primes Pro Tools for playback, so
that pressing Play will begin playback instantaneously. This
switch can also be used during recording to put Pro Tools in
Record Pause mode.
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Zoom/Navigate Section

The Zoom/Navigate section is used to control navigation, dis-
play, and selections in the Pro Tools Edit window.

Navigate Mode
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D-Command Zoom/Navigate Section

Zoom Mode Switch

The Zoom Mode switch puts the arrow switches in Zoom
mode.

Navigate Mode Switch

The Navigate Mode switch puts the arrow switches in Navigate
mode.

Arrow Switches (Up, Down, Previous, Next)

The function of the Arrow switches depends on the current
mode.

Zoom Mode When set to Zoom Mode, the Up and Down Arrow
switches change the vertical zoom and the Previous (Left) and
Next (Right) Arrow switches change the horizontal zoom.

Navigate Mode In Navigate mode, the Up and Down Arrow
switches move the edit cursor up and down among tracks, and
the Previous (Left) and Next (Right) Arrow switches move the
edit cursor left and right among clip boundaries or transients
(according to the Tab to Transients setting).

Text Entry In both Zoom or Navigate modes, the Arrow
switches can be also used to navigate on-screen text fields and
enter numerical values in the on-screen Main and Sub Coun-
ters, Start/End/Length fields, and Pre/Post Roll fields in the
Edit and Transport windows. The Previous (Left) and Next
(Right) Arrow switches move between fields, and the Up and
Down Arrow switches change the value.

Zoom Preset Switches

The Zoom Preset switches recall the five horizontal Zoom pre-
sets in Pro Tools.
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To store a Zoom Preset:

1 Using either the Horizontal Zoom buttons or the Zoomer
tool, set the zoom level that you want to store.

2 While pressing Control (Windows) or Command (Mac),
press a Zoom Preset switch.

To recall a Zoom Preset:

= Press the corresponding Zoom preset switch.
Zoom Shortcuts

To zoom in on the current selection:

= Hold Alt (Windows) or Option (Mac) and press the Zoom
switch.

To zoom out to show the entire session:

= Double-press the Zoom switch.

Nudge/Bank Section

The Nudge/Bank section controls the display of any channels
in Normal mode on the D-Command surface. If any channels
are in any of the Custom Fader modes, they are not affected by
Bank or Nudge commands, and the other channels move
around them.

Nudge Left and Right switche

Bank

-0
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Bank Left and Right switches

D-Command Nudge/Bank Section

Nudge Switches

The Nudge switches move the display of tracks on the control
surface to the left or right, one channel at a time.

To nudge the track focus forward or backward by one channel:

= With a track focused in the Focus Channel Strip, hold Con-
trol (Windows) or Command (Mac) and press the left or right
Nudge switch.

Bank Switches

The Bank switches move the display of tracks on the controls
surface to the left or right by the number of available channels
on the control surface.

To nudge the track focus forward or backward by eight channels:

= With a track focused in the Focus Channel Strip, hold Con-
trol (Windows) or Command (Mac) and press the left or right
Bank switch.



D-Command Multi-Mode

D-Command Multi-mode lets you use a single D-Command
console to access two Pro Tools systems on a network. In
Multi-mode, you can quickly switch worksurface control from
one system to the other by pressing a single switch on the
console.

A When a D-Command unit is in Multi-mode, it is not
possible to update its firmware. To allow updating of
D-Command firmware from Pro Tools, first take the unit
out of Multi-mode.

Enabling Multi-Mode

To enable a D-Command console to be declared on two
Pro Tools systems, the D-Command Main Unit and any Fader
Modules must first be placed in Multi-mode.

To place a D-Command unit in Multi-mode:
1 If a D-Command is declared on a system, do one of the fol-
lowing:

e Quit Pro Tools.

—or -

o Undeclare the D-Command in the Pro Tools Peripherals

dialog.

2 Press and hold the Solo switch on the leftmost Channel Strip
on the unit for approximately three seconds.

When in Multi-mode, the unit displays “D-Command
Multi-Mode” in the Soft Keys (on a Main Unit) or in the Chan-
nel Displays (on a Fader Module).

Declaring D-Command Units when in Multi-Mode

When a D-Command unit is in Multi-mode, it appears in the
Peripherals dialog twice, with the numbers “1” and “2” ap-
pended to its name. These two listings can then be declared on
different Pro Tools systems on the network.

To declare D-Command units in Multi-mode:

1 On the first Pro Tools system, choose Setup > Peripherals,
and click Ethernet Controllers.

2 In the Ethernet Controllers page, select Enable. Pro Tools
scans the Ethernet connection and finds the Multi-mode en-
abled D-Command units.

3 Declare the Main Unit and Fader Modules that end in the
suffix “1,” in the order you want the units arranged from left to
right.

4 Click OK to close the Peripherals window.

5 On the second Pro Tools system, repeat the above steps, de-
claring the Main Unit and Fader Modules that appear with the
suffix “2,” in the same order from left to right as you declared
them on the first Pro Tools system.

As you declare the D-Command units from each Pro Tools
system, the Machine switch in the Transport Modes section
of the Transport controls flashes to indicate that system is
available.

Using D-Command Multi-Mode

When two Pro Tools systems are available in Multi-mode, you
can view their transport synchronization status and instantly
switch between them using the Machine switch in the Trans-
port Modes section of the Transport controls.

Pro Tools System Status Indication

The Machine switch shows the status of available Pro Tools
systems as follows:

Pro Tools system status indications

Mach switch L
Indication

state

Off No Pro Tools system available

Flashing Available Pro Tools system, stopped or
not locked to timecode, or error dialog
on Pro Tools system

On (solid) Available Pro Tools system, locked to
timecode

Switching Control Between Pro Tools Systems

When a Pro Tools system is indicated as available, you can
switch control to that system by pressing the Machine switch
in the Transport Modes section of the Transport controls.
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Chapter 9: Management Sections

Window Management Section

The Window Management section includes controls for opening and closing Pro Tools windows on-screen. When a window is

open, its corresponding switch is lit.

Workspace Browser switch.

Transport switch
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Memory Locations switch

Mix switch

MIDI Event List switch

Mic Pre switch

Pan switch

Edit switch

Plug-In switch

D-Command Window Management section

Workspace Browser Switch

The Workspace Browser switch opens and closes the DigiBase
Workspace Browser. Hold Alt (Windows) or Option (Mac) and
press this switch to close all DigiBase windows.

MIDI Event List Switch

The MIDI Event List switch opens and closes the MIDI Event
List or brings it to the front.

Mic Pre Switch

The Mic Pre switch opens and closes the Mic Pre window for
the focused track.

Memory Locations Switch

The Memory Locations Switch opens and closes the Memory
Locations window

o o0

Transport Switch

The Transport switch opens and closes the Transport window

Pan Switch

The Pan switch opens and closes the Pan window for the fo-
cused track. Hold Alt (Windows) or Option (Mac) to close all
Pan windows.

Mix Switch

The Mix switch opens the Mix Window or brings it to the
front.

Edit Switch

The Edit switch opens the Edit Window or brings it to the
front.

Plug-In Switch

The Plug-In switch opens and closes windows for any cur-
rently targeted plug-ins in the session. Hold Alt (Windows) or
Option (Mac) to close all plug-in windows.
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Session Management Section

The Session Management section includes controls for ses-
sion-wide management and save operations.

Plug-In Clip Publish Redo
indicator switch switch
Go To All Notes Off Save Undo
switch switch switch switch

00 000 O

Go To Clear Clip Al Notes Off Publish Save Redo Undo

Clear Clip
switch

D-Command Session Management section

Go To Switch

The Go To switch is used to focus a specific track onto the Fo-
cus Channel section on the Main Unit.

To go to a specific track:

1 Press the Go To switch.

2 Enter the track position number for the track and press En-
ter.

Clear Clip Switch and Plug-In Clip Indicator

D-Command indicates occurrences of signal clipping on audio
tracks, sends, and plug-ins. (Clip indication on D-Command
follows the clip settings in the Pro Tools Display preferences.)

The Clear Clip switch lights if a clip occurs on an audio track
or on a send anywhere in the session. The Plug-In Clip indica-
tor lights if a clip occurs on a plug-in anywhere in the session.
In addition, D-Command shows clipping with the following
indicators:

o If an audio track clips, the meter clip LED for the clipping
channel’s lights red.

o If a send clips, the Send switch flashes in the Channel Strip
Mode controls section. In addition, if one of the encoders on
the channel strip is controlling the clipping send, the corre-
sponding encoder clip LED lights red.

o If a plug-in clips, the Insert switch flashes in the Channel
Strip Mode controls section. In addition, if one of the encod-
ers on the channel strip is displaying the clipping plug-in,
the corresponding encoder clip LED lights red.

Pressing the Clear Clip switch clears all clip indicators on
D-Command, and in the Pro Tools session.
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All Notes Off Switch

The All Notes Off switch can be used to silence stuck notes
with MIDI devices. It sends an All Notes Off message to each
channel for all connected MIDI devices.

Publish Switch

The Publish switch executes the Send Session Via DigiDelivery
command in Pro Tools, opening the Send To DigiDelivery di-
alog on-screen.

Save Switch

The Save switch executes the Save Session command in
Pro Tools. Whenever a change is made in a session and the
Save command is available, this switch lights.

To save the current session:

1 Press the Save switch. The switch flashes, prompting confir-
mation of the Save command.

2 Do one of the following:

« To confirm the Save command, press the Save switch
again.
o To cancel the Save command, press Escape.

Redo Switch

The Redo switch executes the Redo command in Pro Tools.

Undo Switch

The Undo switch executes the Undo command in Pro Tools.



Soft Keys Section

The Soft Keys section provides access to a wide range of Pro Tools commands directly from the control surface. It also provides
access to preferences and settings specific to D-Command. The section consists of six variable-function soft keys and displays,
along with a matrix of mode switches that change the functions shown in the displays. When a function is shown in a Soft Key dis-
play, pressing the corresponding Soft Key switch activates that function.

Some controls invoke multiple pages of Soft Key functions. To cycle through multiple pages of the same control, repeatedly press
the control switch.
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controls - @ @ | @
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Console Preference  Utility
controls switch

D-Command Soft Keys section

Default Soft Key Display

When a session is first opened, the Soft Key displays show ba-

sic information about the session:

Session Name

Bit: Session Bit Depth

Sampl: Session Sample Rate
File: Session File Type

Tcode: Session Timecode Rate

Delay Compensation On/Off Status

Delay Compensation can be toggled on and off from this dis-
play. The other settings shown above cannot be changed from
the Soft Keys section.

Soft Keys Display with Pro Tools Dialogs

When Pro Tools has a dialog on-screen, the two lower Soft
Keys temporarily display “Escape” and “Enter,” letting you
cancel or confirm the dialog from the control surface.

Exiting from Soft Key Modes

You can exit a Soft Key mode and return to the top-level
Soft Key display by holding Control (Windows) or Command
(Mac) and pressing the currently lit Soft Key switch.
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Management Controls

Snapshot  Group Track Playlist Window
switch switch switch switch switch
MANACEMENT

O 0 0 0O 0O

Snapshot Group Track Playlist Window

Management controls

Snapshot Switch

The Snapshot switch displays the following commands:
Page 1

+ Captre: Capture

o Punch Captre: Punch Capture

« Snap 1-4: Snapshots 1-4
Pages 2-12

« Snap 5-48: Snapshots 5-48 (in groups of 4)

Group Switch
The Group switch displays the following commands:
Page 1
o Create Edit: Create Edit Groups
« Suspnd: Suspend Groups
« Create Mix: Create Mix Groups
« Modify: Modify Groups
o Create Both: Create Mix /Edit Groups
Page 2
o Preset 1-6: Recall Group Presets 1-6

Track Switch

The Track switch displays the following commands:
o New Track: Track > New
« Dup Track: Track > Duplicate
o Delete Selectd: Track > Delete
o Make Act/In: Track > Make Active/Inactive
« Bounce: File > Bounce To > Disk

« Split Mono: Track > Split into Mono

Playlist Switch

The Playlist switch displays the following playlist commands:

o New: New Playlist

« Duplicate: Duplicate Playlist

o Delete Audio: Delete Unused Audio Playlists
+ Delete MIDI: Delete Unused MIDI Playlists
o Prevs Plylst: Show Previous Playlist

+ Next Plylst: Show Next Playlist
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Window Switch

No Session When no session is open, the Window switch dis-
plays the following commands:
Page 1

o Task Managr: Window > Task Manager

« Disk Space: Window > Disk Space

o System Usage: Window > System Usage
Page 2

« 1/0 Setup: Setup > I/O

o HW Setup: Setup > Hardware

« PB Engine: Setup > Playback Engine

o Preferences: Setup > Preferences

o Peripherals: Setup > Peripherals

Open Session When a session is open, the Window switch dis-
plays the following commands:

Page 1

« Auto Enabls: Window > Automation Enable

o Track Arm > Track Arming

» Beat Det: Event > Beat Detective

» Session Setup: Setup > Session

o Tasks: Window > Task Manager

o Projct Browser: Window > Project Browser
Page 2

« Color Pallet: Window > Color Palette

« Big Countr: Window > Big Counter

« Undo Histry: Window > Undo History

« Disk Space: Window > Disk Space

o Video Window: Window > Video

o System Usage: Window > System Usage
Page 3

« I/0 Setup: Setup > 1/0

o HW Setup: Setup > Hardware

o PB Engine: Setup > Playback Engine

« Disk Alloc: Setup > Disk Allocation

o Preferences: Setup > Preferences

o Peripherals: Setup > Peripherals
Page 4

« Window Confgs: Window > Configurations > Window
Configuration List

« MIDI Editor: Window > MIDI Editor

o Score Editor: Window > Score Editor
Page 5

o Tile Windws: Window > Arrange > Tile

o Tile Hrzntl: Window > Arrange > Tile Horizontal



Page 2
SendTo Back: Clip > Send to Back

« SendTo Front: Clip > Bring to Front
Edit Controls .

o Ungrp Clips: Clip > Ungroup

o Tile Vertcl: Window > Arrange > Tile Vertical

+ Cascde Windws: Window > Arrange > Cascade .

Group Clips: Clip > Group

Function 1 Function 2 Function 3  Modes Tools
switch switch switch switch switch « Ungrp All: Clip > Ungroup All
‘ ‘ ‘ ‘ o Regrp Clips: Clip > Regroup
EIDIT

©

Func1

(%)

Func 2

©

Func 3

©

Modes Tools

Edit Function 3 Switch (Manipulation Commands)

The Edit Function 3 switch displays the following commands:
Edit controls

Edit Function 1 Switch (Basic Edit Commands)

The Edit Function 1 switch displays the following commands:

Page 1

Cut: Edit > Cut

Copy: Edit > Copy

Paste: Edit > Paste

Clear: Edit > Clear

TCE To TLSel: Edit > TCE Edit to Timeline Selection

Page 2

CutSP AllAut: Edit > Cut Special > All Automation
CopySP AllAut: Edit > Copy Special > All Automation
CutSP PanAut: Edit > Cut Special > Pan Automation
CopySP PanAut: Edit > Copy Special > Pan Automation
CutSP PI Aut: Edit > Cut Special > Plug-In Automation
CopySP PI Aut: Edit > Copy Special > Plug-In Automation

Page 3

PsteSP Merge: Edit > Paste Special > Merge

ClIrSP AllAut: Edit > Clear Special > All Automation
PsteSP RepFil: Edit > Paste Special > Repeat to Fill Selec-
tion

ClrSP PanAut: Edit > Clear Special > Pan Automation

PsteSP ToCurr: Edit > Paste Special > To Current Automa-
tion Type

CIrSP PI Aut: Edit > Clear Special > Plug-In Automation

Edit Function 2 Switch

The Edit Function 2 switch displays the following commands:

Page 1

Trim to Sel: Edit > Trim > To Selection
Cpture Clip: Edit > Capture Clip

Seprte: Edit > Separate Clip

Heal Seprtn: Edit > Heal Separation
Consolidate: Edit > Consolidate Selection

Time Stamp: Audio Clip List > Time Stamp Selected

Page 1
o Duplicate: Edit > Duplicate
o Repeat: Edit > Repeat
« Shift: Edit > Shift
« Insert Silnce: Edit > Insert Silence
« Lock Clip: Clip > Lock/Unlock
o Mute Clip: Clip > Mute/Unmute

Page 2
« Loop Clips: Clip > Loop Clip
« Unloop Clips: Clip > Unloop Clip
o ID/Rem SyncPT: Clip > Identify/Remove Sync Point
« Rename Clips: Clip > Rename Clips
o Quantz ToGrid: Clip > Quantize to Grid

o ClpDrp: Clip List > Timeline Drop Order >
L to R/Top to Bottom

Edit Modes Switch

The Edit Modes switch displays the Pro Tools Edit modes:

Page 1
o Shuffl: Shuffle Mode
« Spot: Spot Mode
« Slip: Slip Mode
o Grid Rel: Relative Grid Mode
o Grid Abs: Absolute Grid Mode
Page 2
o Tab Trnsnt: Tab to Transients
o Dynamc Trnspt: Options > Dynamic Transport
« Loop Plybck: Options > Loop Playback
« Loop Record: Options > Loop Record
o LLM: Options > Low Latency Monitoring
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Edit Tools Switch

The Edit Tool Tools switch displays the Pro Tools Edit Tools.
To cycle through multiple versions of the same tool, repeat-
edly press the corresponding Soft Key.

« Zoom: Normal/Single Zoomer tools

o Trim: Standard/Scrub/TCE Trimmer tools

« Select: Selector tool

o Grabbr: Time/Separation/Object Grabber tools
« Scrubber tool

« Pencil: Square, Random, Free, Line, Triangle, Arc,
S-Curve

To select the Smart Tool, press any two buttons for the Trim-
mer, Selector or Grabber simultaneously.

Memory/MIDI Controls

Memory Location MIDI
switch switch

Memory/MIDI controls

Memory Location Switch

The Memory Location switch (“Mem Loc”) displays the names
of Memory Locations in pages of six. The Soft Key display is
paged by repeatedly pressing the Memory Location switch in
the Soft Keys section. To page backwards, hold Shift while
pressing the Memory Location switch.

MIDI Switch

The MIDI switch displays the following commands:
Page 1
« Wait Note: Transport Window > Wait for Note button
« Count Off: Transport Window > Countoff button
o Merge Record: Transport Window > MIDI Merge button
« Transpose: Event > Event Operations > Transpose
« Veloc: Event > Event Operations > Change Velocity
« Click On/Off: Options > Click
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Page 2
« Change Tempo: Change Tempo window
o Change Meter: Change Meter window
« Split Notes: Event > Event Operations > Select/Split Notes
o Quantz: Event > Event Operations > Quantize
o Input Quantz: Event > Event Operations > Input
Quantize
Page 3
o Write RTProp: Track > Write MIDI Real Time Properties

« Remove DpNote: Event > Remove Duplicate Notes

Audio Files Switch

No Session Open When no session is open, the Audio Files
switch displays the names of the ten most recent Pro Tools
sessions in its display pages 1 and 2.

Open Session When a session is open, the Audio Files switch
displays the following commands:
Page 1
o New Sessn: File > New Session
o Open Sessn: File > Open Session
« Close Sessn: File > Close Session
« Revert Sessn: File > Revert to Saved
« Save As: File > Save As
« Save Copy In: File > Save Copy In
Page 2
o Import Audio: File > Import > Audio
o Import MIDI: File > Import > MIDI
o Import SesDat: File > Import > Session Data
« Import ClpGrp: File > Import > Clip Groups
o Import Video: File > Import > Video
Page 3
« Export Clips: Clip List Menu > Export Clips as Files
« Export MIDI: File > Export > MIDI

o Export OMFAAF: File > Export > Selected Tracks as New
AAF/OMF

« Export Text: File > Export > Session Info As Text

Pages 4 and 5

« Recent Sessns: Open recent sessions (listed by name)



Show/Hide Switch

The Show/Hide switch displays commands from the
Show/Hide Tracks List menu.

Show/Hide Switch (Page 1)
o Show All: Show All Tracks
« Hide All: Hide All Tracks
« Show Selctd: Show Only Selected Tracks
 Hide Selctd: Hide Only Selected Tracks
« Show Inactv: Show Only Inactive Tracks

 Hide Inactv: Hide Only Inactive Tracks

Show/Hide Switch (Page 2)
« Show Audio: Show Only Audio Tracks
« Hide Audio: Hide Only Audio Tracks
o Show Aux: Show Only Auxiliary Inputs
« Hide Aux: Hide Only Auxiliary Inputs
+ Show MIDI: Show Only MIDI Tracks
« Hide MIDI: Hide Only MIDI Tracks

Show/Hide Switch (Page 3)
o Show Instmt: Show Only Instrument Tracks
« Hide Instmt: Hide Only Instrument Tracks
o Show VCA: Show Only VCA Master Tracks
« Hide VCA: Hide Only VCA Master Tracks
« Hide MkInac: Hide and Make Inactive

You can select multiple Show/Hide categories by holding Shift
while pressing the corresponding Soft Key.

Console Preferences

User Operation Meter

switch switch switch
CC/NSOLE PREF!
0 0O O
User Operation Meter

Console Preferences

The Console Preference switches control D-Command prefer-
ences only, and do not affect the Pro Tools on-screen display.

User Switch

The User switch displays a user-configurable, custom set of
Soft Keys, chosen from any of the other Soft Key displays. To
cycle through both pages of User Soft Key selections, repeat-
edly press the User switch.

To add a Soft Key command to a User Soft Key selection:

1 In the Soft Keys section, press the User switch repeatedly to
display the page (Page 1 or Page 2) where you want to add the
operation.

2 Press the Soft Keys to display the page containing the oper-
ation you want to add.

3 Hold Control (Windows) or Command (Mac) and press the
Soft Key for the operation.

To remove a Soft Key command from the User Soft Key selection:

1 Press the User switch repeatedly to display the operation you
want to remove.

2 Hold Control (Windows) or Command (Mac) and press the
Soft Key for the User operation.

Meter Switch

The Meter switch displays the following D-Command meter
preferences:

Page 1

SndMtr (Send Meters) Toggles send metering on channel ro-
tary encoders on and off.

InsMtr (Insert Meters) Toggles plug-in metering on channel ro-
tary encoders on and off.

VCAMtr (VCA Meters) Toggles metering of VCA slaves on
channel rotary encoders on and off.

Meters Toggles channel metering between pre- and post-fader
modes.

CtrMtr (Center Meters) Toggles the 8-channel meter display on
the Main Unit meter bridge between main output levels and
the focused track.

RefLvl (Reference Level) Lets you change the D-Command me-
ter display to help monitor program material with respect to
different reference levels.

Page 2

GrChan (Gain Reduction Channel Display) Sets channel meters
to display dynamics plug-in gain reduction when the plug-in
is focused on a channel strip.
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Operation Switch

The Operation switch controls operations specific to D-Com-
mand, and does not affect the Pro Tools on-screen display. For
details on setting preferences, see “Setting D-Command Pref-
erences” on page 26.

The Operation switch has the following pages of Soft Key func-
tions:

Operation Switch (Page 1)

BnkJus (Bank Justification) Determines whether banks of
channels in Normal mode are justified at the left, left center
(to the left of the Main Unit), right center, (to the right of the
Main Unit) or right side of the control surface.

Rotary (Rotary Encoder Mode) Determines responsiveness of
rotary encoder knobs. Fixed mode is at normal resolution. The
velocity modes set different rates of encoder acceleration. In
Fine mode, response is fixed and at fine resolution.

CF Jus (Custom Fader Justification) Determines whether
channels in Custom Fader mode are placed at the left, cen-
ter-left, center-right, or right side of the control surface.

Encod (Encoder Order) Determines whether inserts, sends,
and pan controls will be displayed in order from top-to-bot-
tom or bottom-to-top on D-Command rotary encoders.

PIDef (Plug-In View Definition) Determines the view of plug-in
parameters in the Custom Fader section (Name view, Ex-
panded view, or Fader view).

FCStrp (Focus Channel Strip) Determines whether focusing a
channel in the Focus Channel section also places a duplicate of
the focused channel in the channel strip to the immediate left
of the Global Controls section.

When Focus Channel Strip is enabled, all controls and modes
are linked. You can, however, use four encoders simultane-
ously by using the Page Up or Page Down switches to bring a
different set of sends or inserts to the duplicate channel’s en-
coders.

A The duplicate Focus Channel strip is not available when
D-Command is in a Custom Fader mode.

Operation Switch (Page 2)

CFPlug (CF Bank Size for Plug-Ins) Determines the number of
channels allocated for Custom Fader Plug-In mode.

ApTrgt (Target Track from Application) Determines whether
selecting an Insert or Send on-screen focuses its track on the
D-Command Main Unit.

CFGrp (CF Bank Size for Custom and Mix/Edit Groups) Deter-
mines the number of channels allocated for Custom Groups
mode.
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ChanWn (Channel Window Display) Determines whether dis-
playing plug-in or send pan parameters (by pressing an en-
coder Select switch) on D-Command opens the corresponding
plug-in or send window on-screen in Pro Tools. Also deter-
mines whether the Channel Select switches (in the Dynamics
or EQ sections) change the channel display of multi-mono
plug-ins.

& When this preference is set to “Yes,” the on-screen display of
plug-in and send windows changes to reflect the state of the
control surface.

& When this preference is set to “No,” the on-screen display of
plug-in and send windows does not change to reflect the state
of the control surface.

CFTyp (CF Bank Size for Track Type) Determines the number
of channels allocated for Custom Fader Tracks mode.

Select (Select Switch Latch Mode) Determines whether chan-
nel Select buttons follow latching or exclusive-or (non-latch-
ing) behavior when in Select mode.

Operation Switch (Page 3)

SoloFc (Focused Track Follows Solo) Determines whether a
soloed track is automatically focused in the Focus Channel
section (this function works in both Select and Focus modes)

2KbPan (Two-Knob Panning) Toggles linking of front and rear
pan controls in surround panner windows to facilitate
left-right motion in the surround field.

TchVal (Touch Display of Parameter Values On/Off) Turns off
the display of parameter values when faders or encoders are
touched.

CFTrks (Custom Faders Display Hidden Tracks) Determines
whether tracks that are hidden in Pro Tools are displayed or
hidden in Custom Fader modes. Tracks that are hidden in
Pro Tools but shown in Custom Faders cannot be Selected or
Record enabled.

Brdcst (Broadcast) Determines whether the XMON monitor-
ing system is in Broadcast mode, which prevents AFL and PFL
solo modes from changing the XMON Control Room Input
source.

Trk/Ed (Link Track and Edit Selection) Toggles the Options >
Link Track and Edit Selection option, which automatically se-
lects a track or range of tracks when a selection is made in the
track’s timeline.



Operation Switch (Page 4)

Import PIMaps (Import Plug-In Maps) Opens “Choose a map-
ping file” dialog in Pro Tools.

Export PIMaps (Export Plug-In Maps) Opens “Save Plug-In
Mapping As” dialog in Pro Tools.

For more information about importing and exporting
plug-in maps, see “Exporting and Importing .pim Files” on
page 132.

Faders (Faders On/Off) Turns off D-Command faders to pre-
vent fader movement when monitoring a mix.

FilBnk (Always Fill Channel Strips When Banking) Toggles the
preference setting that maximizes the number of channels dis-
played in Normal mode when banking. When selected, bank-
ing follows end stop behavior.

FillCF (Always Fill Custom Faders When Banking) Toggles the
preference setting that maximizes the number of channels dis-
played in Custom Faders when banking. When selected, bank-
ing follows end stop behavior.

ChanPI (Channel Strip Editing for Plug-Ins) Toggles the prefer-
ence setting that enables display of plug-in parameters di-
rectly on D-Command channel encoders.

Operation Switch (Page 5)

AsnMtx (Assign Matrix Enable) Determines whether Assign
Matrix or normal Assign mode operation is used for assigning
inputs, outputs, inserts and sends.

MtxJst (Matrix Select Area Justification) Determines whether
Assign Matrix rows are arranged from Top to Bottom or Bot-
tom to Top on the encoders.

PICImn (Plug-In Menu Column Width) Determines the number
of plug-in names displayed per row in the Assign Matrix

IOCImn (/O Menu Column Width) Determines the number of
1/0 labels displayed per row in the Assign Matrix

MtxLck (Assign Matrix Lock) Determines whether the Assign
Matrix is locked by default or needs to be put into lock mode
manually.

EncVCA (VCA Encoder Display) Determines whether VCA
slave track controls are displayed in the encoders of VCA Mas-
ter channels.

Operation Switch (Page 6)

LrnTch (Learn Touch) Determines whether D-Command en-
coders and switches are active when a plug-in is in Learn
mode.

Automation Controls

AutoMatch Join Actions Modes

switch switch switch switch
J\UTOMATION|

Auto Match Join Actions Modes

Automation controls

AutoMatch Switch

The AutoMatch switch enables AutoMatch command in Latch
or Write automation modes.

Join Switch

The Join switch is used to manually resume writing automa-
tion on all channels that were previously writing automation
after an automation pass is interrupted.

Actions Switch

The Actions switch displays the following commands:
Actions Switch (Page 1)

Prview (Preview) Puts Pro Tools in Preview mode

Punch Prview (Punch Preview) Executes the Punch Preview
command

Prview Suspnd (Preview Suspend) Suspends Preview mode
Captre (Capture) Executes the Capture command

Punch Captre (Punch Capture) Executes the Punch Capture
command

See “Previewing Automation” on page 113 and “Capturing and
Recalling Automation” on page 114 for more information on
these commands.
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Actions Switch (Page 2)

Wrt To All (Write to All) Writes current automation values to
an entire selection or track while performing an automation
pass.

Snap Back Causes all Latch or Write enabled tracks to exit
their current automation pass and return instantly to the pre-
viously written automation levels. During playback, this com-
mand stops writing of automation without applying any Au-
toMatch ramping.

Wrt To Start (Write To Start) Writes current automation values
from the insertion point backward to the beginning of a selec-
tion or track while performing an automation pass.

Wrt To End (Write to End) Writes current automation values
from the insertion point forward to the end of a selection or
track while performing an automation pass.

Wrt To Punch (Write To Punch Point) Writes current automa-
tion values back to the point where writing of automation be-
gan

Wrt To Next (Write to Next Breakpoint) Writes current automa-
tion values from the insertion point forward to the next auto-
mation breakpoint while performing an automation pass.

Actions Switch (Page 3)

Copy To Send Opens the Copy To Send dialog to allow copying
of track control values to each selected track’s send (Edit >
Automation > Copy To Send).

Thin Auto (Thin Automation) Performs the Thin Automation
command. (Edt > Automation > Thin).

Colesc VCAAtm (Coalesce VCA Automation) Executes the
Track > Coalesce VCA Master Automation command

Colesc TrmAtm (Coalesce Trim Automation) Executes the
Track > Coalesce Trim Automation Command

Clear TrmAtm (Clear Trim Automation) Executes the Track >
Clear Trim Automation Command

Suspend TrmAtm (Suspend Trim Automation) Temporarily
suspends Trim automation to allow auditioning of Trim
moves
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Modes Switch

The Modes switch displays the following D-Command Modes:

Modes Switch (Page 1)

AWrtTo All (Auto Write to All on Stop) Writes current automa-
tion values to an entire selection or track when the transport is
stopped after an automation pass.

By default, Automatic Write to All on Stop mode is enabled for
a single automation pass only. To configure the mode to re-
main enabled after an automation pass, hold Start+Alt
(Windows) or Control+Option (Mac) while pressing the
AWrtTo All switch.

Auto Join Auto Join is used in Latch mode to automatically re-
sume writing of automation after the transport is stopped and
started again during an automation pass.

AWrtTo Start (Auto Write to Start on Stop) Automatically
writes current automation values from the insertion point
backward to the beginning of a selection or track when the
transport is stopped after an automation pass.

By default, Automatic Write to Start on Stop mode is enabled
for a single automation pass only. To configure the mode to
remain enabled after an automation pass, hold Start+Alt
(Windows) or Control+Option (Mac) while pressing the
AWrtTo Strt switch.

AWrtTo End (Auto Write to End on Stop) Writes current auto-
mation values from the insertion point forward to the end of a
selection or track when the transport is stopped after an auto-
mation pass.

By default, Automatic Write to End on Stop mode is enabled
for a single automation pass only. To configure the mode to
remain enabled after an automation pass, hold Start+Alt
(Windows) or Control+Option (Mac) while pressing the
AWrtTo End switch.

AWrtTo Punch (Auto Write to Punch Point on Stop) Writes
current automation values back to where the current automa-
tion pass began.

By default, Automatic Write to Punch Point on Stop mode is
enabled for a single automation pass only. To configure the
mode to remain enabled after an automation pass, hold Alt
(Windows) or Option (Mac) while pressing the AWrtTo Punch
switch.

AWrtTo Next (Auto Write to Next Breakpoint on Stop) Writes
current automation values from the insertion point forward to
the next automation breakpoint when the transport is stopped
after an automation pass.

Automatic Write to Next Breakpoint on Stop remains enabled
after each automation pass, until you disable it by pressing the
lit AWrtTo Next switch.



Modes Switch (Page 2)

Wrt To Currnt (Write To Current Parameter) Writes the current
control value to the currently displayed automation parame-
ter (Edit > Automation > Write To Current).

Wrt To All Ena (Write To All Enabled Parameters) Writes cur-
rent control values to all enabled automation parameters (Edit
> Automation > Write To All Enabled).

Trm To Currnt (Trim To Current Parameter) Applies the current
trim value to the currently displayed automation parameter
(Edit > Automation > Trim To Current).

Trm To AllEna (Trim To All Enabled Parameters) Applies cur-
rent trim values to all enabled automation parameters (Edit >
Automation > Trim To All Enabled).

Gld To Currnt (Glide To Current Parameter) Applies a transi-
tion between automation values to the currently displayed au-
tomation parameter (Edit > Automation > Glide To Current).

Gld To AllEna (Glide To All Enabled Parameters) Applies a
transition between automation values to all enabled automa-
tion parameters (Edit > Automation > Glide To All Enabled).

Modes Switch (Page 3)

Match Time (AutoMatch Time) Lets you use the Scrub/Shuttle
wheel to set AutoMatch time, the amount of time it takes for
automation values to return to the previously written values
after an automation pass stops.

Glide Time (AutoGlide Time) Lets you use the Scrub/Shuttle
wheel to set AutoGlide time, the amount of time it takes for
surround pan values to move between two points in an auto-
mation pass performed with the optional Surround panner.

LchStp (Allow Latch Prime in Stop) Toggles the Allow Latch
Prime in Stop preference, which allows tracks in Latch mode
to be primed for writing automation while the transport is
stopped. When a track in Latch mode is primed for writing au-
tomation, its Latch mode indicator flashes.

PlgAut (Plug-In Controls Default to Auto-Enabled) Toggles the
preference that enables plug-in controls automatically when
they are added to a track

AutCls (Coalesce when Removing Slaves from VCA Group)

Toggles the preference that automatically coalesces automa-
tion to slave track when they are removed from a VCA-con-
trolled group

TrmCols (Coalesce Trim Automation) Sets the preference that
determines when Trim automation is coalesced (After Every
Pass, On Exiting Trim Mode, or Manually)

Modes Switch (Page 4)
MmtTch (Latching Behavior for Switched Controls in Touch)

Toggles the preference that determines the behavior of
switched controls in Touch mode.

StdVCA (Standard VCA Logic for Group Attributes) Toggles
the preference that disables normal group linking behavior
when a VCA is assigned to a group

WrtWrn (Suppress Automation “Write To” Warnings Toggles
the preference that suppresses dialogs after invoking the
Write To Start/End/All commands

PanLnk (Use Absolute Pan Linking) Toggles the preference
that determines the behavior of pan controls in grouped tracks

SndTrm (Include Sends in Trim Mode) Toggles the preference
that determines whether Send Faders go into Trim mode along
with Main Volume

Ctlund (Include Control Changes in Undo Queue) Toggles the
preference that determines whether mixer changes appear in
the Undo queue

Utility Switch

Utility
Utility switch

The Utility switch places the D-Command in Utility mode.
When D-Command is in Utility mode, this switch flashes.

Utility mode lets you view D-Command system information,
name D-Command units, run D-Command diagnostic tests,
and set certain D-Command hardware preferences. For com-
plete information on Utility mode, see Appendix A, “Utility
Mode”

Track Size Switches

TRK SIZE
(O) Track Size Up
switch
Up
(\ Track Size Down
) switch
Down

Track Size controls

The Track Size Up and Down switches increase and decrease
the track height of all tracks where a selection or edit cursor is
present.
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Memory Locations

You can view and create Pro Tools Memory Locations from
the D-Command Soft Keys.

To view Memory Locations in the Soft Keys, do one of the
following:

= Repeatedly press the Mem Loc switch in the Soft Keys sec-
tion to page the display of Memory Locations.

- or —

= Hold Shift and repeatedly press the Mem Loc switch in the
Soft Keys section to page backward.

To create a new Memory Location from the Soft Keys:

1 Press the Mem Loc switch in the Soft Keys section. The Mem
Loc switch lights to indicate Memory Location display.

2 Press any Soft Key that corresponds to a blank display.

3 Set the properties of the new Memory Location in the New
Memory Location dialog.

4 Press the Soft Key that corresponds to Enter to save the
Memory Location.

To edit a Memory Location from the Soft Keys:

1 Press the Mem Loc switch in the Soft Keys section. The Mem
Loc switch lights to indicate Memory Location display.

2 If there are more than six Memory Locations, press the Soft
Keys that correspond to Page Up and Page Down to view addi-
tional locations.

3 Hold the Start key (Windows) or Control key (Mac) and press
the Soft Key that corresponds to the Memory Location you
want to edit.

4 Change the properties of the Memory Location in the Edit
Memory Location dialog.

5 Press the Soft Key that corresponds to Enter to save the
Memory Location.

To delete a Memory Location from the Soft Keys:

1 Press the Mem Loc switch in the Select/MIDI Soft Keys sec-
tion.

2 Hold the Alt key (Windows) or Option key (Mac) and press
the Soft Key that corresponds to the Memory Location you
want to delete.

94 D-Command Guide

Window Configurations

You can view, create, and edit Window Configurations from
the D-Command Soft Keys.

To display Window Configurations in the Soft Keys:

1 Hold the Start key (Windows) or Control key (Mac) and press
the Mem Loc switch in the Select/MIDI Soft Keys section. The
Mem Loc switch flashes to indicate Window Configuration
display.

2 If there are more than six Window Configurations, press the
Soft Keys that correspond to Page Up and Page Down to view
additional configurations.

To recall a Window Configuration from the Soft Keys:
1 Hold the Start key (Windows) or Control key (Mac) and press
the Mem Loc switch in the Select/MIDI Soft Keys section.

2 Press the Soft Key that corresponds to the Window Configu-
ration you want to recall.

To create a Window Configuration from the Soft Keys:

1 Hold the Start key (Windows) or Control key (Mac) and press
the Mem Loc switch in the Select/MIDI Soft Keys section.

2 Press any Soft Key that corresponds to a blank display.

3 Set the properties of the new Window Configuration in the
New Window Configuration dialog.

4 Press the Soft Key that corresponds to Enter to save the Win-
dow Configuration.

To edit a Window Configuration from the Soft Keys:

1 Hold the Start key (Windows) or Control key (Mac) and press
the Mem Loc switch in the Select/MIDI Soft Keys section.

2 Hold the Start key (Windows) or Control key (Mac) and press
the Soft Key that corresponds to the Window Configuration
you want to edit.

3 Change the properties of the Window Configuration in the
Edit Window Configuration dialog.

4 Press the Soft Key that corresponds to Enter to save the Win-
dow Configuration.

To delete a Window Configuration from the Soft Keys:

1 Hold the Start key (Windows) or Control key (Mac) and press
the Mem Loc switch in the Select/MIDI Soft Keys section.

2 Hold the Alt key (Windows) or Option key (Mac) and press
the Soft Key that corresponds to the Window Configuration
you want to delete.



Chapter 10: Monitor and Meter Sections

Monitor Section Controls

The Monitor section includes a full set of controls for the control room monitoring, headphone/cue, and talkback/listenback
sections of D-Command. All input and output connections to the D-Command monitoring system are made on the XMON inter-
face, which is connected to the D-Command console with the XMON cable, and remotely controlled from this section.

D-Command Monitor section

Input source switches Studio Output Channel Select Talkback/Listenback
and Output controls  controls and Mode switches controls

| MONITOR
STUDIO LISTEN MICS
Gz 00
Phones  Studio LS Mc1  Mc2
@ |
Cue1in TALKBACK
000000000
Cue2in AFL/PFL | Set up L C R AFL Intermal  Extemal

Set Assign
Source B
On Dim Mite Auto Talkback
Monitor
Mode
controls
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Input Source Switches and Output
Controls

INPUTS
sum switth— &%) (=
Pl suround_ @y @ Stereo Input
urroun
switch @ @ switches
Alt Surr Stereo 2
Main switch O O
Main  Stereo 3
Output
Level control
Level
Output__| o Alt Output
controls ’7 On/Off switch
(()) ((\> Mini Output
= On/Off switch
At Mini
(' ) Main Output
On/Off switch
Main

Input source switches and Output controls

Input Source Switches

The monitor system has five input sources:
« Main Inputs (6 channels)
« Surround Inputs (6 channels)
o Stereo 1 Inputs (2 channels)
« Stereo 2 Inputs (2 channels)
o Stereo 3 Inputs (2 channels)

These sources are selected by pressing their corresponding In-
put switches, which light when the source is activated.

Input Level Trim Mode

Each input source can be trimmed independently, to allow for
setting of different reference levels or to compensate for dif-
ferences in gain structure. Available trim values range from
-20 dB to +10 dB in 0.5 dB steps.

To trim input levels:

1 Press and hold the Input Source Selector switch for the input
you want to trim, until the switch flashes.

2 Turn the Main Output Level encoder knob to set the trim
value. The monitor section display shows “Trim” and the trim
value in dB.

3 Press the flashing Input Source Selector switch to exit Trim
mode.
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Sum Switch

In normal operation, the Input Source switches follow exclu-
sive-or (non-latching) behavior, allowing only one source to
be monitored at a time.

However, D-Command has a Sum mode that allows multiple
input sources to be monitored at the same time. When Sum
mode is on, multiple input source switches can be active.

Sum mode ignores any input trim values when it is active.

To add or remove inputs in Sum mode:
1 Press the Sum switch. The switch lights to indicate Sum

mode is on.

2 Press any number of Input Source switches to toggle their
corresponding inputs on or off. It is possible to turn all inputs
off in this mode.

To exit Sum mode:

= Press the Sum switch again. Monitoring reverts to the input
that was selected when you entered Sum mode.

Output On/Off Switches

The monitor system has three outputs:
« Main Control Room Outputs (6 channels)
« Alt Control Room Outputs (6 channels)

« Mini Control Room Outputs (2 channels)

Only one output can be active at a time. The Output On/Off
switches follow exclusive-or (non-latching) behavior. When
you activate an output, its name and gain value (in dB) are
shown in the monitor section display.

Output Level Control

The monitor system output section has a touch-sensitive ro-
tary encoder for control of output level. When the encoder
knob is touched, the monitor section display shows the cur-
rent level in dB. Gain ranges from a minimum of -INF to a
maximum of +10 dB, in 1 dB steps.

Output Level Trim Mode

Each output level control can be trimmed independently, to
allow for setting of different reference levels or to compensate
for differences in gain structure. Available trim values range
from -20 dB to +10 dB, in 0.5 dB steps.

To trim output levels:

1 Press and hold the On/Off switch for the output you want to
trim, until the switch flashes.

2 Turn the encoder knob to set the trim value. The monitor
display shows the trim value in dB.

3 Press the flashing On/Off switch to exit Trim mode.



Studio Controls
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Cue Input Source Switches

The Headphone/Cue monitor system has three input sources:
« Cue 1 Input (2 channels)
o Cue 2 Input (2 channels)

« Main Monitor Input (2 channels)

Cue Output On/Off Switches

The Cue system has four available outputs:
e Cue 1 (2 channels)
« Cue 2 (2 channels)
« Headphone (2 channels)
« Studio Loudspeaker (2 channels)
The two Cue Outputs, Headphone Output, and Studio Loud-

speaker Output can be active in any combination, including all
on or all off.

The following table shows possible outputs for each input
source. (Talkback can be added to each of the outputs.)

Input Possible Outputs

Cue 1l Cue 1, Headphone, Studio LS

Cue 2 Cue 2, Headphone, Studio LS

Main Monitor | Cue 1, Cue 2, Headphone, Studio LS

To assign an input source to an output:

1 Press the switch for the output for which you want to assign
an input. The switch will light, and the Monitor LED display
will show the currently selected source.

2 Press the Set Source switch repeatedly to cycle through the
available source choices.

Assign Talkback Switch

The Assign Talkback switch lets you add the talkback signal to
any of the Headphone/Cue system outputs. The Assign Talk-
back switch lights to indicate that talkback is active for a given
output.
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Output Channel Select Controls

Channel Select switches
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Output Channel Select controls

Set Up Switch

The Set Up switch resets output trim levels to their default val-
ues.

Channel Select Switches

The Channel Select switches let you solo or mute individual
channels of the Control Room outputs. The function of the
Channel Select switches depends on the mode of the
Solo/Mute switch.

« When the mode is set to Solo, each Channel Select switch so-
los the corresponding output channel.

« When the mode is set to Mute, each Channel Select switch
mutes the corresponding output channel.

In both modes, the Channel Select switches follow latched be-
havior, allowing multiple outputs to be soloed or muted. The
Channel Select switches light to indicate that they are active.

There are Channel Select switches for the following channels:
o L (Left)
« C (Center)
« R (Right)
o Ls (Left Surround)
Rs (Right Surround)
« LFE

These choices support all possible channel configurations in
Pro Tools. A maximum of six channels (5.1 surround) may be
in use at any time.
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Individual Output Trim Mode

Each output channel can be trimmed individually for each of
the three control room outputs (Main, Alt, and Mini), allow-
ing you adjust the channel balance for each set of control room
speakers. Trim values are stored for each of the three outputs.
Available trim values range from -30 dB to +10 dB, in 0.5 dB
steps.

To trim the output level for an individual output channel:

1 Activate the control room output (Main, Alt, or Mini) whose
channel levels you want to trim.

2 Press and hold the Channel Select switch for the output
channel you want to trim, until the switch flashes.

3 Turn the Output Level encoder to set the trim value for the
channel. The monitor display shows “Trim” and the trim value
in dB.

4 Press the flashing Channel Select switch to exit Trim mode.

5 Repeat the above steps for each output channel and each set
of outputs (Main, Alt, or Mini) you want to trim.

Solo/Mute Switch and Indicators

The Solo/Mute switch toggles the function of the Channel Se-
lect switches between Solo and Mute modes. The indicators
light to indicate which mode is active.



AFL and PFL Switches

The AFL and PFL switches invokes After Fader Listen and Pre
Fader Listen Solo modes.

AFL and PFL modes send signal to a separate output path with
independently adjustable levels for each mode. The XMON
Control Room Input source is automatically changed to mon-
itor the AFL/PFL input, unless you put D-Command in Broad-
cast mode (see “Broadcast Mode for AFL and PFL Monitoring”
on page 99). This lets you monitor the soloed channels in the
Main control room monitors (with Broadcast mode off) orin a
dedicated solo monitoring system (with Broadcast mode on).

A\ AFL and PFL Solo modes require the use of the Surround
Mixer plug-in.
To select the Solo mode:

1 Press the AFL or PFL switch in the D-Command Monitor sec-
tion to select the corresponding Solo mode.

Setting AFL and PFL Levels

Levels can be set separately for AFL and PFL modes from the
D-Command Monitor section.

To set the AFL or PFL level:

1 Press the AFL or PFL switch in the D-Command Monitor sec-
tion.

2 Turn the Cue output level control. The AFL/PFL level is
shown in the Monitor displays.

To set the AFL or PFL level to its default setting:
1 Press the AFL or PFL switch in the D-Command Monitor sec-

tion.

2 Hold Alt (Windows) or Option (Mac) and touch the Cue out-
put level control.

Broadcast Mode for AFL and PFL
Monitoring

You can put the D-Command monitoring system in Broadcast
mode, which prevents AFL and PFL solo modes from changing
the XMON Control Room Input source. This lets you solo
channels while preserving the main monitor mix.

You can then use the AFL/PFL path selector in the I/O Setup
dialog to route the AFL/PFL solo signal from the Pro Tools au-
dio interface to a separate set of speakers or headphones.

To put the XMON monitoring system in Broadcast mode:

1 Press the Operation switch in the Soft Key section.

2 Press the Soft Key that corresponds to “Broadcast”

While in Broadcast mode, any channels soloed while in AFL or
PFL are still sent to the AFL/PFL path, but XMON does not
switch the Control Room Input source to monitor that path.

While in Broadcast mode, any channels soloed while in SIP
mode will still cause all other tracks to be muted.
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Talkback/Listen System
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Talkback Controls

The Talkback system has two talkback microphone inputs
(one external, one built-in) both using the touch-sensitive ro-
tary encoder for control of output volume. When either switch
is lit, the monitor section display show the corresponding vol-
ume level in dB. Level control on each ranges from a minimum
level of -INF to a maximum level of +30 dB.

Talkback Level Control

When the External Talkback switch is lit, the Level control ad-
justs the volume for the external talkback microphone. When
the encoder knob is touched, the monitor section display
shows the level in dB.

The Talkback Level control also adjusts the volume of the
built-in (Internal) microphone, located on the meter bridge of
the D-Command Main Unit.

Talkback Dim Function

When Talkback is engaged, the Dim switch lights and the Dim
function is automatically applied to the Main outputs. Any ad-
justment of the Dim level affects both the Talkback Dim func-
tion and the Control Room Output Dim function.

To set the Dim level:

1 Press and hold the Assign Talkback switch until the switch
flashes.

2 Turn the Cue Output Level encoder to set the Dim value. The
monitor section shows the Dim value in dB.
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Auto Talkback Switch

The Auto Talkback switch activates a mode in which the talk-
back and listen microphones are automatically turned on
whenever the Pro Tools transport is not in Play or Record.
When Auto Talkback is active, the Auto Talkback switch
lights, and the Talkback switches flash.

While in Auto Talkback mode, you can temporarily disable
and re-enable talkback, while staying in Auto Talkback mode.
To temporarily disable Talkback while in Auto Talkback mode:

= Press either of the flashing Talkback switches.

To re-enable talkback while in Auto Talkback mode:

= Double-press either Talkback switch so it flashes again.

Talkback Switch

The Talkback switch, located at the bottom of the Channel
Strip Master section on the Main Unit, controls the D-Com-
mand Talkback function.

AUTO MODE

Write Trim

00

Touch  Read

00

Latch Off

I 7= Talkback switch

Dbl PresstoLatch

Talkback switch

The Talkback switch can follow momentary or latched behav-
ior. If held, the switch is active only when pressed down.

If rapidly double-pressed, the switch latches on and flashes to
indicate that talkback is active. Press the switch again to turn
off talkback.



Listen Controls

The Listen system has two selectable microphone inputs, both
using the touch-sensitive rotary encoder for level control.

Listen Mic Select Switches
There are two Listen Mic Select switches for the external listen
microphone inputs:

e« Micl

e Mic2
Either or both of these inputs can be active at any time. When
one input is active, the encoder controls the level of that input
independently. When both inputs are active, the encoder con-

trols both levels simultaneously, maintaining any relative off-
set between the two.

Level control ranges from a minimum level of ~INF to a max-
imum level of +30 dB.

Dim Level Control

The Dim Level control lets you adjust the amount of level re-
duction applied by the Dim switch, located at the bottom of
the Monitor section. Level reduction ranges from -30 dB to
0 dB, in 1 dB steps.

When the Dim encoder knob is touched, the monitor section
display shows “Dim” and the gain reduction in dB.

Monitor Output Mode Controls

li ion M i
Cal |brat|onswﬁtéﬁ (O) (()7 Mono switch

Calibrated Mono

Dim switch ————
Dim

Monitor Output Mode controls

€2 wuteswich
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Calibration Mode Switch

The Calibration Mode switch invokes a mode that changes the
output value displayed by the Monitor section display from
gain (expressed in dB) to sound pressure level (expressed in
dB SPL) for each of the control room outputs. This switch
lights when an SPL value is shown for the active output.

To display output levels in dB SPL, you must first calibrate
each output. This SPL calibration requires the use of a pink
noise source (or other reference material) and a sound pres-
sure level meter to measure the output of individual control
room speakers.

To calibrate Control Room outputs to display SPL:

1 Send the reference material to the Main Control Room Out-
puts, and set the output level in Pro Tools to your studio refer-
ence level (for example, —-18 dBEFS).

2 Pan the signal to center (so that equal level is sent to all Main
Control Room Output speakers).

3 Set the speaker-to-speaker balance for all speakers in the
system using Output Trim mode for each channel, using the
sound pressure level meter to measure SPL at the mix position.
See “Individual Output Trim Mode” on page 98.

4 Solo the Center speaker, and adjust the Main Control Room
Output level encoder until the sound pressure level meter mea-
sures the target reference level (for example, 85 dB) at the mix
position.

5 Press and hold the Calibration Mode switch until it flashes.

6 Adjust the Main Control Room Output level encoder until
the target reference level is displayed in the Monitor Section
display.

7 Press the flashing Cal switch.

8 Repeat steps 4-7 for the Alt and Mini outputs.

To toggle the output display between dB and dB SPL:

1 Select the output whose display you want to toggle (Main,
Alt, or Mini).

2 Press the Calibration Mode switch.

& When the Calibration Mode switch is lit, output is displayed
in dB SPL.

o When the Calibration Mode switch is unlit, output is dis-
played in dB.
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Mono Switch

The Mono switch mixes the Left and Right signals of any of the
output modes (any surround channels are not affected) to pro-
vide mono output, useful for checking phase and balance rela-
tionships. The Mono switch lights to indicate that it is active.

Mono Trim Mode

Mono output can be trimmed to adjust its reference level in
comparison to other outputs. Available trim values range
from -12 dB to 0 dB, in 0.5 dB steps.

To trim mono output:

1 Press and hold the Mono switch until it flashes.

2 Turn Alt Output encoder knob to set the Mono trim value.
The monitor display shows “Irim” and the trim value in dB.

3 Press the flashing Mono switch to exit Trim mode.
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Dim Switch

The Dim function applies an adjustable gain reduction to the
Control Room outputs. This function affects all three output
destinations. The Dim switch toggles the dim function on and
off, and lights to indicate that it is active.

Mute Switch

The Mute switch toggles the mute state for all Control Room
outputs. Mute operates globally on all three output destina-
tions. The Mute switch lights to indicate that it is active.

If the Mute switch on the XMON interface front panel is acti-
vated, the Mute switch on D-Command must be used to un-
mute the monitor system. (Outputs cannot be unmuted from
XMON front panel.)



Meter and Timecode Displays (Main Unit)
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Meters

The Channel Strip Meter display features dual 32-segment LED bar graphs for each channel, and can display pre- or post-fader
levels depending on the D-Command Meter Preferences setting. In Custom Fader mode, these meter displays can show plug-in
input and output meters, gain reduction meters for dynamics plug-ins, and other parameters. The top LED is red and indicates
clipping on the corresponding channel or parameter.

The Output Meter display includes eight 32-segment LED bar graphs with clip indication for displaying output levels or the level
of the track focused in the Focus Channel Strip, depending on the D-Command Meter Preferences setting.

For details on setting meter preferences, see “Meter Preferences” on page 30.

Time Scale Displays

The Time Scale displays on the Main Unit mirrors the Main Time Scales in Pro Tools.

Time Scale Display Format Indicators

The indicators to the left of the Time Scale displays show the currently displayed format for both the Main Time Scale and the Sub
Time Scale. Formats include:

« Hours:Minutes:Seconds:Milliseconds

« Hours:Minutes:Seconds:Frames

« Feet+Frames

« Bars|Beats

Talkback Microphone

The built-in D-Command talkback microphone is located between the Meters and the Time Scale display.
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Setting D-Command Meters for Different Reference Levels

The Pro Tools Reference Level meter preference lets you change the D-Command meter display to help monitor program material
with respect to different reference levels.

At each setting except 0 dB, a single LED lights continuously across the meter bridge at a fixed point to indicate that reference
level. You can then compare the peaks of the program material to the indicated level.

The following reference level settings are available:

0 dB This is the normal setting used for referencing material to a 0 dB (full code) reference level.
—14 dB This reference level setting lights a single LED at —14 dB across the meter bridge.

—18 dB This reference level setting lights a single LED at —-18 dB across the meter bridge.

—20 dB This reference level setting lights a single LED at -20 dB across the meter bridge.

To set a D-Command meter reference level:

1 In the Soft Keys section, press the Meter switch.
2 Press the Soft Key that corresponds to “RefLv]” to cycle among the meter reference level settings.

3 Press the Meter switch to exit.
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Chapter 11: Normal Mode Operations and Commands

The power and flexibility of D-Command lies in its different
operating modes, which let you customize the behavior of its
channel strip controls to fit your workflow.

The main D-Command operating modes are Normal mode and
the four Custom Fader modes.

For more information on Custom Fader Modes, see
Chapter 13, “Custom Fader Modes.”

In Normal mode, Pro Tools tracks are displayed on D-Com-
mand in a standard console format. In this mode, channel
strips correspond to a track in the session, and most of the
channel strip controls correspond directly to on-screen con-
trols or views in Pro Tools:

¢ Channel Fader controls channel volume

+ Channel Display shows track name, and track volume when
fader is touched

« Pan switch shows Pan values on encoders (this is the default
view when a new track is created)

o Inserts switch shows Insert name on encoders

+ Sends switch shows name of Send on the encoder display,
and Send level on the encoder LED ring

Assigning Elements to Tracks

You can assign Inputs, Outputs, Inserts, and Sends to tracks
directly from D-Command by entering Assign mode.

To assign an input or output to a track:

1 Press the Assign Inputs switch or Assign Outputs switch to
enter the corresponding Assign mode. Input and output as-
signments are displayed and edited on the lower encoder.

2 If necessary, press the Bypass/Mute/Pre switch repeatedly to
move up through to the top menu level.

3 Turn the encoder knob to choose between audio interface
channels and busses.

4 Press the encoder Select switch to confirm your selection.

5 Turn the encoder knob to choose the audio interface channel
or bus assignment that you want.

6 Repeat steps 2-5 for any other channels that you want to as-
sign an input or output.

7 Press the flashing encoder Select switch or press the flashing
Assign switch to confirm the assignments.

To assign a send or insert to a track (global assign mode):

1 Press the Assign Sends switch or the Assign Inserts switch to
enter the corresponding Assign mode. The first two send or in-
sert positions will show on the encoder displays by default.

2 To display and edit other insert positions, press the Page Up
or Page Down switches on the channel where you want to make
the assignment.

3 Turn the encoder knob that corresponds to the insert posi-
tion that you want to edit to select from the first level of menu
choices.

4 Press the encoder Select switch to move down and the By-
pass/Mute/Pre switch to move up through menu levels.

5 Press the encoder Select switch to confirm each menu level
selection.

6 Repeat steps 2-5 to modify other send or insert assignments.

7 Press each flashing encoder Select switch or press the flash-
ing Assign switch to confirm the assignments.

To assign a send or insert to a track (temporary assign mode):

1 Press the Inserts or Sends switch on the channel where you
want to make the assignment.

2 To display and edit other insert positions on the channel,
press the channel’s Page Up or Page Down switches.

3 Do one of the following:

« If the send or insert position is empty, press the encoder
select switch. The encoder display shows the “>” sign in-
dicating that you are editing the send or insert position.

o If the send or insert position is already assigned, press
and hold the encoder select switch until the encoder dis-
play shows the “>” sign indicating that you are editing the
send or insert position.

4 Turn the encoder knob that corresponds to the insert posi-
tion that you want to edit to select from the first level of menu
choices.

5 Press the encoder Select switch to move down and the
Bypass/Mute/Pre switch to move up through menu levels.

6 Press the encoder Select switch to confirm each menu level
selection.
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7 Repeat steps 2-5 to modify other send or insert assignments.

8 Press the flashing encoder Select switch to confirm the as-
signment.

To remove an input, output, send or insert:
1 Press an Assign switch to enter the corresponding Assign

mode.

2 For the assignment you want to remove, press the encoder
Bypass/Mute/Pre switch repeatedly until you reach the
top-level menu for the assignment.

3 Turn the encoder knob counter-clockwise until no assign-
ment is visible.
4 Do one of the following:

o Press the flashing encoder Select switch or press the
flashing Assign switch to confirm the removal.

— or —

« Press the flashing Escape switch to cancel the removal
and restore the assignment.

To quickly remove an output or send assignment:

1 Press the Output Assign or Send Assign switch.

2 Hold Start (Windows) or Control (Mac) and press the Select
switch for each output or send assignment you want to remove.

3 Press the flashing Assign switch to exit Assign mode.

Assigning Inputs in Sessions with
Multiple Plug-In Outputs

In sessions with plug-ins that have multiple outputs, the out-
puts of those plug-ins are available as inputs in other audio
and Auxiliary Input tracks. These appear as a third category of
inputs, labelled plug-ins, in the track input menu.

When assigning inputs from D-Command, this third category
of inputs appears as a top-level menu choice.

To assign an input from a plug-in output:
1 Press the Assign Inputs switch.
2 On the channel where you want to make the assignment, turn

an encoder knob to select Plug-In from the first level of menu
choices.

3 Press the encoder Select switch to move down to the individ-
ual plug-in level.
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4 Turn the encoder knob to select the plug-in whose auxiliary
output you want to select.

5 Press the encoder Select switch to move down to the list of
plug-in auxiliary outputs.
6 Do one of the following:

« Press the flashing encoder Select switch or press the
flashing Assign Inputs switch to confirm the assignment.

— or —

o Press the flashing Escape switch to cancel the assign-
ment.

Viewing Assignments

Display of Inserts and Sends

Encoder and channel strip displays show Insert and Send in-
formation as follows:

« Inserts with no assignments show only uppercase letters
(A-J) in the corresponding positions.

« Sends with no assignments show only lowercase letters (a-j)
in the corresponding positions.

« Inserts and Sends with assignments show only the Insert or
Send name and no letters.

Display of I/0O Assignments

You can view the I/0 assignments for individual channels in a
momentary I/0 view. I/O assignments are displayed at the
bottom of the channel’s encoders, according to track type.
Assignments are displayed from top to bottom as follows:

 Audio and Auxiliary Input tracks
« Input
o Output

o Instrument tracks
« MIDI input
« MIDI output
o Aux input
o Aux output

« MIDI tracks
o MIDI input
« MIDI output

« Master Fader tracks
o Output

« VCA Master tracks

» Group assignment



To view the I/O assignments on a track:
= Press and hold the Sends switch on the track. The Sends

switch lights to indicate I/0 view.

Q With Instrument tracks, press the Page Up and Page
° Down switches to view additional assignments.

Display of Multiple Output Assignments
Audio and MIDI Tracks

For audio or MIDI tracks that have multiple output assign-
ments, a Plus (+) sign precedes the output name.

To view the names of multiple output assignments:
1 Press and hold the Sends switch on a track with multiple out-

put assignments. The Sends switch lights to indicate I/O view.

2 Press the B/M/P switch under any output name preceded by
a plus (+) sign. The names of output paths “spill” onto the
track’s encoder displays.

3 To exit output “spill” view, press any of the lit output path
B/M/P switches.

To rename an I/O path on an audio track:
1 Press and hold the Sends switch on the track. The Sends
switch lights to indicate display of I/0 assignments.

2 If you have multiple I/0 assignments on the track, press the
B/M/P switch under any output name preceded by a plus (+)
sign. The names of output paths “spill” onto the track’s en-
coder displays.

3 Hold Start (Windows) or Control (Mac) and press the B/M/P
switch under the I/0 path you want to rename.

4 Enter a new name for the path.

5 Click OK.

Display of Multiple Send Assignments

For sends that have multiple assignments, a Plus (+) sign pre-
cedes the send name.

To view the names of multiple send assignments:

1 Press the Sends switch on a track with multiple send assign-
ments.

2 Hold Control (Windows) or Command (Mac) and press the
B/M/P switch under any Send name preceded by a plus (+)
sign. The names of send paths “spill” onto the track’s encoder
displays.

3 To exit send “spill” view, press any of the lit send path B/M/P
switches.

To rename a Send path:

1 Press the Sends switch on the track with the Send you want
to rename.

2 If you have multiple sends on the track, hold Control (Win-
dows) or Command (Mac) and press the B/M/P switch under
any Send name preceded by a plus (+) sign,. The names of send
paths “spill” onto the track’s encoder displays.

3 Hold Start (Windows) or Control (Mac) and press the B/M/P
switch under the send path name.

4 Enter a new name for the path.

5 Click OK.

Interrogation of Bus and I/0 Assignments
Momentary and Latching Operation

When interrogating bus assignments or I/O assignments, you
can display them momentarily or latch them on. Latching the
display of assignments is useful when banking faders to locate
off-bank indications.

To display bus and I/O assignments momentarily:

= Touch the encoder showing the assignment.

To latch display of bus and I/O assignments:

= Double-tap the encoder showing the assignment.

To exit latched display of bus and I/0 assignments:

= Press the flashing Escape switch.

Off-Bank Indications

When interrogating bus assignments (in either momentary or
latched display), any off-bank assignments are indicated by
flashing Bank/Nudge switches. Slow flashing indicates that an
assignment is one button press away; Fast flashing indicates
that an assignment is multiple presses away.
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Interrogating Bus Assignments

D-Command allows both forward interrogation of outputs to
bus paths and reverse interrogation of inputs from bus paths
on Audio tracks or Auxiliary Input tracks.

To interrogate atrack output to a bus (forward bus interrogation):

1 Press and hold the Sends switch on a track that has the bus
as an output assignment. The channel goes into I/0 view,
showing the input and output for the track in its channel strip
encoders.

2 Touch (or double-tap) the encoder showing the bus assign-
ment on the output. The channel Select switch flashes on
tracks with that bus assigned as an input.

To interrogate a send to a bus (forward bus interrogation):

1 Press the Sends switch on a track that has the bus as a Send
assignment.

2 Hold Control (Windows) or Command (Mac) and press the
B/M/P switch under the send. All sends on the track spill to the
track’s encoders.

3 Touch (or double-tap) the encoder showing the bus assign-
ment on the send. The channel Select switch flashes on tracks
with that bus assigned as an input.

To interrogate a track input from a bus (reverse bus
interrogation):

1 Press and hold the Sends switch on a track that has the bus
as an input assignment. The channel goes into I/0 view, show-
ing the input and output for the track in its channel strip en-
coders.

2 Touch (or double-tap) the encoder showing the bus assign-
ment on the input. The channel Select switch flashes on tracks
with that bus as an output. Both the channel Select switch and
the channel Send switch flash on tracks with that bus as a send
assignment.

Interrogating 1/O Assignments

D-Command allows interrogation of matching input or output
assignments (including interface, bus, or MIDI paths) on Au-
dio, Auxiliary Input, MIDI, Instrument, or Master Fader
tracks.

To interrogate a track input or output:

1 Press and hold the Sends switch on a track that has the input
or output assignment. The channel goes into I/0 view, showing
the input and output for the track in its channel strip encoders.

2 Hold Shift and touch (or double-tap) the encoder showing
the input or output assignment. The channel Select switch
flashes on all tracks that have the same input or output.
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Making Elements Active or Inactive

You can make Inputs, Outputs, Inserts, Sends, and entire
tracks active or inactive directly from D-Command by enter-
ing a temporary Make Inactive mode.

To toggle input paths activel/inactive:

1 Press the Make Inactive Inputs switch to enter the Make In-
active mode.

2 Press the Bypass/Mute/Pre switch on the appropriate en-
coder to deactivate or reactivate the input. Inactive inputs are
shown with an inverted text display.

3 Press the flashing Make Inactive switch to exit Inactive
mode.

To toggle output paths active/inactive:

1 Press the Make Inactive Outputs switch to enter the Make In-
active mode.

2 Press the Bypass/Mute/Pre switch on the appropriate en-
coder to deactivate or reactivate the combined outputs for that
channel.

3 Press the flashing Make Inactive switch to exit Inactive
mode.

To toggle individual outputs sub-paths active/inactive:

1 Press the Make Inactive Outputs switch to enter the Make In-
active mode.

2 Press the Select switch on the appropriate encoder to view
the output sub-paths for the channel.

3 Press the Page Up or Page Down switches to step through the
possible output sub-paths.

4 Press the Bypass/Mute/Pre switch on the appropriate en-
coder to deactivate or reactivate your choice of output
sub-paths. Inactive output sub-paths are shown with an in-
verted text display.

5 Press the flashing Make Inactive switch to exit Inactive
mode.

To toggle a send or plug-in active/inactive:

1 Press the Make Inactive Sends switch or the Make Inactive
Inserts switch to enter the corresponding Make Inactive mode.
The first two insert or send positions will show on the encoder
displays.

2 To display and edit other insert positions, press the Page Up
or Page Down switches on the channel where you want to make
the assignment.

3 Press the Bypass/Mute/Pre switch on the appropriate en-
coder to deactivate or reactivate the insert or send assignment.
Inactive assignments are shown with an inverted text display.

4 Repeat steps 2-3 to modify other send or insert assignments.



5 Press the flashing Make Inactive switch to exit Inactive
mode.
To toggle a track inactive/active:

1 Press any of the Make Inactive switches.

2 Press channel strip Select buttons to deactivate or reactivate
the corresponding tracks.

3 Press the flashing Make Inactive switch to exit Inactive
mode.

Working with Tracks

Selecting a Track

You can select tracks in Pro Tools directly from D-Command.
In Select mode, Select switches can follow latching or
non-latching behavior. For details on setting the latch mode
for the Select switch, see “Display of Hidden Tracks in Custom
Faders” on page 28.

To select a track from D-Command:

1 Make sure the Select/Focus switch mode is set to Select.

2 Press the channel Select switch for the track you want to se-
lect.

To select arange of tracks:
1 Press the Select switch on the channel at the start of the

range you want to select.

2 Hold Shift and press the Select switch on channel at the end
range you want to select.

All tracks between the first channel and last channel (inclu-
sive) are selected.

To select or deselect multiple, non-contiguous tracks, do one of
the following:

= If the Select Switch Latch Mode is set to latch, press addi-
tional Select switches.

— or —

= Hold Control (Windows) or Command (Mac) and press the
Select switches on multiple channels.

Focusing a Track

You can focus any track in a session in the Focus Channel sec-
tion, and the Dynamics and EQ sections of D-Command. Fo-
cusing a track also makes it available for use with the Custom
Fader Plug-In mode. (See “Custom Fader Plug-In Mode” on
page 129.)

To focus atrack in the Focus Channel section from D-Command:

1 Make sure the Select/Focus switch mode is set to Focus.

2 Press the channel Select switch for the track you want to fo-
cus.

To focus a track on the Focus Channel section while staying in
Select mode:

= Hold Start+Shift (Windows) or Control+Shift (Mac) and
press the channel Select switch for the track you want to focus.

To focus atrack on the Focus Channel section from Pro Tools:

1 Make sure the Target Track from Application preference is
set to Yes. For details on this preference, see “Target Track
from Application” on page 29.

2 On-screen in Pro Tools, click the plug-in state plate, send
window, panner window, or mic pre pane for the track you
want to focus.

To focus a specific track number:
1 Do one of the following;

o Press the Go To switch on D-Command.

_or -

o Choose Operations > Scroll to Track Number in Pro Tools.
2 Enter the track position number for the track and press En-
ter.
To nudge the track focus left or right by one channel:
= Hold Control (Windows) or Command (Mac) and press the
Nudge Left or Nudge Right switch.
To bank the track focus left or right by eight channels:

= Hold Control (Windows) or Command (Mac) and press the
Bank Left or Bank Right switch.
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Focus Channel Strip

If the D-Command Focus Channel Strip Operations preference
is set to Yes, focusing a track also places a duplicate of the fo-
cused track in the channel strip to the immediate left of the
Global Controls section. See “FCStrp (Focus Channel Strip)”
on page 90.

A The duplicate Focus Channel strip is not available when
D-Command is in a Custom Fader mode.

Focusing Tracks when Soloing

To set D-Command to automatically focus a track when it is
soloed:

1 Press the Operation switch repeatedly to display the page
that includes the Focused Track Follows Solo preference (So-
loFc).

2 Press the Soft Key that corresponds to “SoloFc” until its
value is “Yes.”

Working with the HEAT Option

You can enable and control the HEAT option from
D-Command.

To enable and control HEAT for a session:

» Hold Start+Shift (Windows) or Control+Shift (Mac) and
press the Plug-In switch in the Custom Fader section. The
following HEAT Master controls appear in two Custom Fader
channels:

On/Off To enable HEAT, press the B/M/P switch that corre-
sponds to “HEAT” in the encoder display of the Custom Fad-
ers.

Master Bypass To toggle the Master Bypass, press the B/M/P
switch that corresponds to “MstByp” in the encoder display of
the Custom Faders.

Drive To adjust the Drive parameter, turn the encoder that
corresponds to “Drive” in the encoder display of the Custom
Faders.

Tone To adjust the Tone parameter, turn the encoder that
corresponds to “Tone” in the encoder display of the Custom
Faders.

To access HEAT controls for a channel:
1 Make sure HEAT is enabled in the session.

2 Hold Start+Shift (Windows) or Control+Shift (Mac) and
press the Inserts switch on the channel.

To bypass HEAT for a channel:

1 Hold Start+Shift (Windows) or Control+Shift (Mac) and
press the Inserts switch on the channel to display its HEAT
controls.
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2 Press the B/M/P switch that corresponds to “Bypass.”
To toggle HEAT between pre- or post-insert operation on a
channel:

1 Hold Start+Shift (Windows) or Control+Shift (Mac) and
press the Inserts switch on the channel to display its HEAT
controls.

2 Press the B/M/P switch that corresponds to “Pre” or “Post.”

Q HEAT supports Flip mode for both its Master
" and Channel controls.

Working with Plug-Ins and Sends

Focusing a Plug-In

If the D-Command Focus Channel Strip Operations preference
is set to Yes, focusing a track on D-Command brings the name
of the first active plug-in into the Focus Channel display.

To focus a plug-in in the Focus Channel display:

1 Make sure the Select/Focus switch mode is set to Focus.

2 Press the channel strips’s Select switch. The first plug-in that
is not a dynamics or EQ plug-in is automatically focused, and
its name appears in the Custom Faders display.

3 In the Custom Faders section, press the Bank/Cycle switch to
cycle through the plug-ins on the Custom Faders display.

The plug-in whose name appears in the Focus Channel display
is then available for Custom Fader Plug-In mode. (See “Cus-
tom Fader Plug-In Mode” on page 129.)

To focus a plug-in in the Dynamics or EQ section:

1 Focus the plug-in’s track in the Focus Channel section by
pressing the track’s Select switch. The first dynamics and EQ
plug-ins on that track are automatically focused in the corre-
sponding D-Command section.

2 Press the Cycle switch in the Dynamics or EQ section to fo-
cus successive dynamics or EQ plug-ins on that channel. (The
No Insert option is always available.)

To focus a plug-in in the Custom Faders section (temporary
plug-in assign mode):

1 Press the Inserts switch on the plug-in’s channel strip to en-
ter Inserts mode.

2 Press the encoder Select switch for the plug-in that you want
to control.

The plug-in is focused in the Custom Fader section. (See “Cus-
tom Fader Plug-In Mode” on page 129.)



Automation Safe Mode

The Automation Safe switch invokes a mode in which the By-
pass/Mute/Pre switch for each encoder and the channel Select
switch become Automation Safe switches. While in this mode,
pressing a Bypass/Mute/Pre switch on a plug-in or send pro-
tects any automation on that plug-in or send from being over-
written. Pressing a channel Select switch protects any auto-
mated parameters on that track from being overwritten.

In Automation Safe mode, the Automation Safe switch is lit.

While in this mode, the Bypass/Mute/Pre switch for any pro-
tected insert or send is lit, and the channel Select switch for

any protected channel is lit.

To toggle Automation Safe mode on and off:

1 Press the Automation Safe switch.

2 Press the channel Select switch on the tracks for which you
want to toggle automation safe status.

3 Press the Bypass/Mute/Pre switch for the plug-ins or sends
for which you want to toggle automation safe status.

4 Press the Automation Safe switch again to exit Automation
Safe mode.

Bypassing Plug-Ins

When a plug-in name is displayed on an encoder (in the
top-level Inserts display), the encoder’s Bypass/Mute/Pre
(B/M/P) switch bypasses the corresponding plug-in. The
B/M/P switch lights when the insert or plug-in is bypassed.

To bypass a plug-in:

1 Press the Inserts switch on the plug-in’s channel to display
the first two Insert names on the channel’s encoders.

2 To display and edit other insert positions, press the Page Up
or Page Down switches.

3 Press the B/M/P switch that corresponds to the plug-in you
want to bypass. The B/M/P switch lights when the plug-in is
bypassed.

Making Plug-Ins Active/lnactive

When a plug-in name is displayed on an encoder (in the
top-level Inserts display), it can be made inactive without en-
tering Make Inactive mode.

To toggle a plug-in active/inactive:

1 Press the Inserts switch on a channel strip to display the
names of the plug-ins on the channel’s encoders.

2 If the insert location for the plug-in that you want to make
active/inactive is not showing, press the Page Up or Page Down
switches on the channel where you want to make the assign-
ment until the appropriate location is displayed.

3 Hold Control+Start (Windows) or Control+ Command
(Mac) and press the encoder Select switch for the plug-in.

Muting Sends

You can mute sends directly from D-Command by setting the
appropriate mode for the Bypass/Mute/Pre switch.

To mute sends:

1 Press the Sends switch on the track to display Send names in
the channel encoders.

2 To display and edit other send positions, press the Page Up
or Page Down switches.

3 Press the Switch Mode switch to set the mode to Mute.

4 Press the B/M/P switch for the send you want to mute. The
red Mute LED lights to indicate that the send is muted.

Setting Send Pre-/Post-Fader Operation

You can set sends to pre-fader or post-fader operation directly
from D-Command, by setting the appropriate mode for the
Bypass/Mute/Pre switch.

To toggle sends between pre-fader and post-fader operation:

1 Press the Sends switch on the track to display Send names in
the channel encoders.

2 Press the Switch Mode switch to set the mode to Pre.

3 Press the B/M/P switch for the send you want to toggle. The
green Pre LED lights to indicate that the send is set for
pre-fader operation.
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Flip Mode

Channels in Normal mode can use Flip Mode, which transfers
controls from a row of encoders to the channel faders.

In Flip mode, the Flip switch lights, the rotary encoder control
swaps with the channel fader; the encoder Select switch swaps
with the channel Select switch; the encoder Bypass/Mute/Pre
switch swaps with the channel Mute switch; and the encoder
display swaps with the channel display.

To transfer controls from arow of rotary encoders to the channel
faders:

= Press the Flip switch that corresponds to the encoder row
that you want to transfer.

To exit Flip mode:

= Press a lighted Flip switch.

Assigning Inserts and Sends While in Flip
Mode

You can assign Inserts or Sends directly to an encoder even
when its controls are flipped to the channel fader.

When an encoder’s controls are flipped to the channel fader,
the channel Select switch replaces the encoder Select switch,
the channel Mute switch replaces the Bypass/Mute/Pre switch,
and the channel Fader replaces the encoder knob.

To assign an individual insert or send to a flipped encoder:

1 On the channel where you want to make the assignment,
press the Inserts or Sends switch to display the corresponding
elements on the channel. The controls for the flipped encoder
appear on the channel fader.

2 Press and hold the channel Select switch on the channel
where you want to assign the insert or send. The channel scrib-
ble strip shows a right arrow (“>- -”) to indicate the channel
is in assign mode.

3 Move the channel fader to select from the first level of menu
choices.

4 Press the channel Select switch to move down and the chan-
nel Mute switch to move up through menu levels.
5 Do one of the following:

o Press the flashing channel Select switch to confirm the
assignment.

— or —

+ Press the flashing Escape switch to cancel the assign-
ment.
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To change a previously assigned insert or send on a flipped
encoder:

1 On the channel where you want to change the assignment,
press the Inserts or Sends switch to display the corresponding
elements on the channel.

2 Press and hold the channel Select switch for the flipped in-
sert or send you want to change, until the channel scribble

« »

strip shows a right arrow (“>”) next to the assignment to indi-
cate the channel is in assign mode.
3 Do one of the following to select a new insert or send:

« Move the channel fader to select from the current level of
menu choices.

« Press the channel Select switch to move down and the

channel Mute switch to move up through menu levels.

4 When the new insert or send is displayed in the channel
scribble strip, do one of the following:

o Press the flashing channel Select switch to confirm the
assignment.

« Press the flashing Escape switch to cancel the assign-
ment.

To remove an individual insert or send on a flipped encoder:

1 On the channel where you want to remove the assignment,
press the Inserts or Sends switch to display the corresponding
elements on the channel.

2 Press and hold the channel Select switch for the flipped in-
sert or send you want to remove, until the channel scribble

« »

strip shows a right arrow (“>”) next to the assignment to indi-
cate the channel is in assign mode.

3 Press the encoder Bypass/Mute/Pre switch repeatedly until
you reach the top-level menu for the assignment.

4 Move the channel fader until no assignment is visible.

5 Do one of the following:

« Press the flashing channel Select switch to confirm the
removal.

— or —

o Press the flashing Escape switch to cancel the removal
and restore the assignment.



Working with Automation

Setting the Automation Mode of Channels

To cycle a channel forward through the automation modes:

» Press the Automation Mode switch on the channel.

To cycle a channel backward through the automation modes:

= Hold the Shift (add) Modifier switch and press the Automa-
tion Mode switch on the channel.

To toggle a channel in and out of Trim mode:

s Press the Trim switch on the channel.

To set the automation mode of one or more channels:
1 Hold an Automation Mode switch (Write, Touch, Latch,
Trim, Read, or Off).

2 Press the Select switches or Auto switches on the channels
whose automation mode you want to set.

To set the automation mode of all or all selected channels:

1 Press the Do To All or Do To Selected switch.

2 Press an Automation Mode switch (Write, Touch, Latch,
Trim, Read, or Off).

To toggle the write enable status of an automation type across all
channels:

= Press the switch for the corresponding automation type
(Volume, Pan, Mute, Send level, Send pan, Send mute, or
Insert) in the Automation Enable section.

To suspend automation for all tracks:

= Press the Auto Suspend switch in the Channel Strip Master
Function controls. The Auto Suspend switch flashes to indicate
that automation is suspended.

To suspend Trim automation for all tracks:

= Hold Control (Windows) or Command (Mac) and press the
Auto Suspend switch in the Channel Strip Master Function
controls. The Auto Suspend switch flashes to indicate that au-
tomation is suspended.

Displaying the Automation Playlist for a
Control

To display the automation playlist on-screen for a parameter
controlled by a fader:

= Hold Control+Start (Windows) or Command+Control (Mac)
and touch the fader.

To display the automation playlist on-screen for a parameter
controlled by an encoder:

= Hold Control+Start (Windows) or Command+Control (Mac)
and touch the encoder.

To display all automation playlists on-screen for a parameter
type:

= Hold Alt+Control+Start (Windows) or Option+Com-
mand+Control (Mac) and touch a fader or encoder controlling
the parameter type.

Previewing Automation

You can audition changes to a mix and compare them to exist-
ing automation values without committing them to the auto-
mation playlist by using Preview mode.

To preview a new automation value for a control:

1 Press the Auto switch on each channel you want preview so
that it is in a write-enabled state (Write, Touch, Latch,
Touch/Latch).

2 In the Automation Enable controls, press the corresponding
switch to enable each automation type you want to preview
(Volume, Pan, Mute, Send level, Send pan, Send mute, or
Plug-In).
3 Do one of the following:
o Press the Preview Soft Key in the Actions Soft Keys Page.
« Hold Control (Win) or Command (Mac) and press the Off

switch in the Automation Mode controls. The Off switch
flashes to indicate Preview mode.

4 Isolate a control by moving it.

5 Start playback and adjust the isolated control to audition the
new automation values.
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To suspend Preview mode:

= Do one of the following:

o Press the Suspend Preview Soft Key in the Actions Soft
Keys Page.
—or-

« Hold Control (Win) or Command (Mac) and press the
Read switch in the Automation Mode controls.

To punch a preview value to the automation playlist:

= Do one of the following:
o Press the Punch Preview Soft Key in the Actions Page.
—or-
« Hold Control+Start (Windows) or Command+Control

(Mac) and press the flashing Off switch in the Automa-
tion Mode controls.

Capturing and Recalling Automation

You can capture the current automation values of actively
writing controls and store them as snapshots. On D-Com-
mand, up to 48 snapshots can be stored and recalled. These
stored snapshots are saved with the Pro Tools session, and can
be imported into other sessions using the Import Session Data
command.

Capturing Automation Values

Before you can store automation values as a snapshot, they
must be loaded into the Capture buffer.

To capture automation values:

1 Press the Auto switch on each channel whose automation
values you want to capture so that it is in a write-enabled state
(Write, Touch, Latch, or Touch/Latch).

2 In the Automation Enable controls, press the corresponding
switch to enable each automation type you want to capture
(Volume, Pan, Mute, Send level, Send pan, Send mute, or
Plug-In).

3 In the Management area of the Soft Keys section, press the
Snapshot key to display the Capture commands in the Soft
Keys section.

4 Start playback, and if necessary, touch a write-enabled con-
trol to start writing automation. The Capture switch in the Soft
Keys section lights to indicate that a capture is possible.

5 When the currently writing controls reach a value you want
to capture, press the Capture switch in the Soft Keys section.

The Punch Capture switch lights in the Soft Keys section lights
to indicate captured values are available to punch.
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Storing and Recalling Captured Automation Values

After automation values are captured, the captured state can
be stored in any of 48 available snapshots. These can then be
recalled to the Capture buffer, where they are available to
punch.

To store a snapshot:

1 Capture the automation values you want to store. (See “Cap-
turing Automation Values” on page 114.)

2 In the Management area of the Soft Keys section, press the
Snapshot key repeatedly until the desired snapshot number
appears. The bottom four Soft Keys show four snapshot num-
bers at a time (1-4, 5-8, etc.).

3 Hold the Soft Key that corresponds to the desired snapshot
number for more than one second. The Soft Key display tem-
porarily reads “Saved” to indicate that the snapshot is stored.

The automation values currently in the Capture buffer are
stored in the snapshot. Any previously saved snapshot is over-
written.

The Soft Key lights to indicate that an automation snapshot is
stored.

To name a shapshot:

1 In the Management area of the Soft Keys section, press the
Snapshot key repeatedly until the desired snapshot number
appears.

2 Double-press the Soft Key that corresponds to the snapshot
you want to name.

3 Type the name of the snapshot and press the Soft Key that
corresponds to Enter.

To recall a snapshot:

1 In the Management area of the Soft Keys section, press the
Snapshot key repeatedly until the desired snapshot number
appears. The bottom four Soft Keys show four snapshot num-
bers at a time (1-4, 5-8, etc.).

2 Press the Soft Key that corresponds to the snapshot you want
to recall. The switch flashes to indicate that the snapshot is
loaded into the Capture buffer, and available to punch.

To clear a stored snapshot:

= Hold Control+Alt+Start (Windows) or Command+Op-
tion+Control (Mac) and press the Soft Key that corresponds to
the snapshot you want to clear.



Punching Recalled Automation Values

When a snapshot is loaded into the Capture buffer, it is ready
to punch at a different location.

To punch arecalled snapshot:

1 Move to alocation where you want to apply the snapshot. You
can do this during playback or while the transport is stopped.

2 Press the Punch Capture switch in the Soft Keys section to
apply the snapshot. The captured automation states are ap-
plied to all automation types that are currently enabled in the
Automation window.

Using Snapshots in Preview Mode

On D-Command, you can punch snapshots while in Preview
Mode. This lets you audition the automation values in a snap-
shot without committing them to the automation playlist.

To punch snapshots while in Preview mode:

1 Press the Auto switch on each channel you want preview so
that it is in a write-enabled state (Write, Touch, Latch,
Touch/Latch).

2 In the Automation Enable controls, press the corresponding
switch to enable each automation type you want to preview
(Volume, Pan, Mute, Send level, Send pan, Send mute, or
Plug-In).

3 Hold Control (Win) or Command (Mac) and press the Off
switch in the Automation Mode controls to enter Preview
mode.

4 Press the Snapshot key repeatedly until the desired snapshot
number appears in the Soft Keys.

5 Press the Soft Key that corresponds to the snapshot you want
to recall.

6 Start playback.

7 Press the Punch Capture switch in the Soft Keys section to
punch the snapshot and audition the new automation values.

8 Adjust controls or punch additional snapshots to audition
the new automation values.

9 When you are ready to commit the preview value, press the
Punch Preview Soft Key.

Joining Automation Values

D-Command remembers the automation write status of all
writable parameters when you stop the transport during an
automation pass. It stores this information in the Join buffer.

When you press the Join switch during playback, writing re-
sumes at the current value for all controls that were previously
writing automation.

To Join automation values:
1 Make sure the controls you want to join are in a write-en-
abled state.

2 Stop playback during an automation pass.

3 Start playback. The Join switch lights to indicate that the
Join buffer

4 When you want to resume writing automation at the current
values, press the Join switch.

To clear the Join buffer:

= Hold Control+Start (Windows) or Command+Control (Mac)
and press the Join switch.

AutoMatching Automation Values

To AutoMatch all currently writing controls:

1 Make sure the automation types you want to AutoMatch are
write-enabled.

2 Start playback.

3 When you reach a point in the session where you want to re-
turn controls to their previously written values, do one of the
following:

o Press the AutoMatch switch in the Automation area of the
Soft Keys section.

« Hold Alt (Windows) or Option (Mac) and press the Auto
switch on a channel.

o Press the Do to All switch and press the Auto switch on a
channel.
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AutoMatching Individual Controls

On D-Command, you can invoke AutoMatch on individual
controls or control types on single channels.

To AutoMatch all controls of atype on a channel:

= Hold Control (Windows) or Command (Mac) and press any
of the following in the Channel Strip Mode controls for the
track whose controls you want to AutoMatch:

« Inserts
« Sends

« Pan

To AutoMatch the volume fader on a channel:

= Hold Control (Windows) or Command (Mac) and press the
Auto switch in the Channel Strip Function controls for the
channel.

To AutoMatch a pan control or the controls for an individual
insert or send on a channel:

1 Press the switch in the Channel Strip Mode controls to dis-
play the Pan controls or the top level of Inserts or Sends for the
channel.

2 Hold Control (Windows) or Command (Mac) and press the
Rotary Encoder Select switch for the control you want to Au-
toMatch:

« For Sends, the Send level, pan, and mute will AutoMatch.

« For Inserts, all automated controls will AutoMatch.

« For Pan, all pan sliders on the channel will AutoMatch.
To AutoMatch all controls for aplug-in displayed in the Dynamics

or EQ section:

= Hold Control (Windows) or Command (Mac) and press the
Auto switch in the Dyn or EQ section of the console.
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Chapter 12: Assigning Inserts, Sends and I/O with the

Assign Matrix

D-Command provides a means of quickly assigning inserts,
sends, and I/0 routing to tracks in a session. Instead of mak-
ing assignments by drilling down multiple levels on a single
encoder, the Assign Matrix feature temporarily usesa 2 x 8
section of encoders to show multiple layers of navigation at
one time.

Enabling Assign Matrix Operation

The Assign Matrix Enable (“AsnMtx”) console preference de-
termines whether standard Assign mode behavior (which uses
a single encoder for assignments) or the Assign Matrix is used
for assigning Inserts, Sends, or I/O routing on the control sur-
face.

+ When this preference is enabled, the Assign Matrix is used
for making assignments.

& When the preference is not enabled, standard Global and lo-
cal Assign modes are used for making assignments.

To toggle Assign Matrix operation on and off:

1 In the Soft Keys section, press the Operation switch repeat-
edly to display the page that includes the Assign Matrix pref-
erence (“AsnMtx”).

2 Press the Soft Key that corresponds to “AsnMtx” to toggle the
setting between “On” and “Off.”

3 Hold Control (Windows) or Command (Mac) and press the
Operation switch to exit.

Assign Matrix Preferences

The following settings and preferences affect the appearance
and operation of the D-Command Assign Matrix.

Assign Matrix Select Area Justification

The Assign Matrix Select Area Justification preference deter-
mines whether the items in the Assign Matrix Select area are
displayed in order from top-to-bottom or bottom-to-top on
D-Command rotary encoders.

This preference does not affect the display order of items in
the Menu area. (Display of Inserts and Sends in the Menu area
follow the Encoder Order preference.)

To set the Assign Matrix Select area justification:

1 In the Soft Keys section, press the Operations switch repeat-
edly to display the page that includes Matrix Select Area Justi-
fication (“Mtx]Jst”).

2 Press the Soft Key that corresponds to “Mtx]Jst” to choose be-
tween “Bot-Tp” (bottom-to-top ordering) and “Tp-Bot”
(top-to-bottom ordering).

3 Hold Control (Windows) or Command (Mac) and press the
Operations switch to exit.

Assign Matrix Column Width

The Assign Matrix Column Width preferences determine how
many items appear in each row of the Assign Matrix Select
Area.

Assign Matrix Column Width is set independently for I/0 as-
signments (I/O paths and Sends) and Plug-Ins.

Options include 6 items (one Encoder display for each item), 3
items (two displays per item), 2 items (three displays per
item) or 1 item (six displays per item) per row. When you
choose more items, the displayed names are more abbrevi-
ated; when you choose fewer items, names are more fully
spelled out.

To set the Assign Matrix Column Width preferences:

1 In the Soft Keys section, press the Operations switch repeat-
edly to display the page that includes I/O Column Width
(“IOCIms”) and Plug-In Column Width (“PIClms”).

2 Do any of the following:

« Press the Soft Key that corresponds to “IOClms” to decre-
ment the number of I/O assignments or Send positions to
display per row. (Hold Shift to increment the number.)

o Press the Soft Key that corresponds to “PIClms” to decre-

ment the number of Insert positions to display per row.
(Hold Shift to increment the number.)

3 Hold Control (Windows) or Command (Mac) and press the
Operations switch to exit.
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Assign Matrix Lock

The Assign Matrix Lock Enable preference lets you set the As-
sign Matrix to automatically be in Lock mode whenever it is
opened.

+ When this preference is set to “On,” the Assign Matrix al-
ways opens in Lock mode, so that it remains open after assign-
ments are made. The Assign Matrix remains in Lock mode
until you unlock it.

+ When this preference is set to “Off,” the Assign Matrix must
be put into Lock mode manually.

To set the Assign Matrix Lock Enable preference:

1 In the Soft Keys section, press the Operations switch repeat-
edly to display the page that includes Matrix Lock Enable
(“MtxLck”).

2 Press the Soft Key that corresponds to “MtxLck” to toggle the
setting On an Off.

3 Hold Control (Windows) or Command (Mac) and press the
Operations switch to exit.

Overview of the Assign Matrix

The Assign Matrix is divided into three main areas: the Menu area, Select area, and Navigation area.

Select Area

Menu Area
Track [ |6
Name R

Arrangement of controls in the Assign Matrix

Menu Area

The Menu area is a column of encoders that shows the insert,
send, or I/0 assignments on the track where you are making

the assignment. These encoders let you select the insert posi-
tion, send position, or I/O path you want to assign, as well as
select different tracks for assignment.

Select Area

The Select area consists of six columns of encoders that show
the names of available inserts, sends or I/O paths. These en-
coders let you navigate quickly through submenus and indi-
vidual inserts, sends, and I/0 paths.

Navigation Area

The Navigation area is a column of encoders that provides
commands for navigating in the Select area. These encoders
let you page through available items, go back to previous
menu levels, lock the display of the Select area, and exit Assign
mode.
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Assign Matrix Lock Mode

In normal operation, the Assign Matrix closes after you make
or remove an assignment. You can set the Assign Matrix to re-
main open after an assignment is made or removed, so you can
make additional assignments.

To set the Assign Matrix to remain open after an assignment is
made (“Lock mode”):

1 Display an Insert, Send, or I/O assignment in the Assign Ma-
trix.

2 In the Assign Matrix Navigation area, press the encoder Se-
lect switch labeled “Lock.”

The “Lock” switch lights and the encoder display turns red to
indicate locked status.
To take the Assign Matrix out of Lock mode:

= In the Assign Matrix Navigation area, press the lit “Lock”
switch.



Assign Matrix Multi-Assign Mode
(Sends and Outputs Only)

In normal operation, the Assign Matrix lets you make one as-
signment at a time, toggling the previous assignment off. You
can set the Assign Matrix to allow multiple output assign-
ments.

To set the Assign Matrix to allow multiple assignments:

1 Display an Insert, Send, or I/O assignment in the Assign Ma-
trix.

2 In the Assign Matrix Navigation area, press the B/M/P switch
labeled “+” (below the “Lock” encoder”) to latch output as-
signments.

Insert Assign Matrix

The Insert Assign Matrix lets you display, assign, change, and
remove inserts from a session. The Insert Assign Matrix shows
insert positions (A-J), Insert type, plug-in categories, plug-in
manufacturer, and insert or plug-in names in the Assign Ma-
trix Select area.

Displaying Inserts

To display an Insert in the Assign Matrix:

1 Press the Inserts switch on the channel with the insert you
want to display. Insert positions are displayed on the channel
encoders.

2 Press the Page Up and Page Down switches to show the insert
position you want to display.

3 Do one of the following for the Insert position you want to
display:
« Ifnoinsert is present at the Insert position, press the en-
coder Select switch.

- or —

o Ifaninsertis already present at the Insert position, press
and hold the encoder Select switch.

The Assign Matrix opens, showing the track name in the top
encoder and the selected Insert position in the bottom en-
coder in the Menu Area. The encoder Select switch lights to in-
dicate display of the selected Insert position.

+ If no insert is present at the Insert position, the Select Area
shows the top-level Insert menu items, along with any default
or favorite plug-ins on the top level.

o If an insert is already present at the Insert position, the Se-
lect Area shows bottom level Insert menu items, with the cur-
rent insert indicated by a lit Select switch.

To page through options in the Assign Matrix Select area:

= Press the Page Up and Page Down switches under the bottom
encoder (labeled “Back” or “Exit”) in the Assign Matrix Navi-
gation area. To page continuously, press and hold the switches.

To scroll through options in the Assign Matrix Select area:

= Turn the bottom encoder knob (labeled “Back” or “Exit” in
the Assign Matrix Navigation area.

To move down through Insert menu levels:

= Press the encoder Select switch for a menu item in the As-
sign Matrix Select area.

To move up through Insert menu levels:

= In the Assign Matrix Navigation area, press the bottom en-
coder Select switch (labeled “Back”).

To momentarily display the full name of a menu item or insert in
the encoder displays:

= Touch the encoder knob for the item.

To open/close the window for an insert:

= Hold Start (Windows) or Control (Mac) and press the en-
coder Select switch for the Insert position in the Assign Matrix
Menu area.

Changing Insert Display for a Track in the Assign
Matrix

To display a different Insert in the Assign Matrix by paging
through inserts:
1 In the Assign Matrix Menu Area, do one of the following:

o Press the lit Page Up or Page Down switch under the bot-
tom encoder in the Assign Matrix Menu area.

o Turn the bottom encoder in the Assign Matrix Menu area.

2 Press the flashing encoder Select switch to display the new
Insert position.

To display a different Insert in the Assign Matrix by displaying
insert names:

1 In the Assign Matrix Menu Area, press the B/M/P switch on
the bottom encoder. The Insert positions are displayed in the
Assign Matrix Select area.

2 Press the encoder Select switch for the Insert position you
want to display.
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Changing Track Display in the Assign Matrix

To display inserts for a different track in the Assign Matrix by
scrolling through track names:

1 In the Assign Matrix Menu Area, press the top encoder (track
name) Select switch.

2 Turn the top encoder to scroll through the tracks in the ses-
sion.

3 Press the flashing Select switch to display the inserts for that
track in the Assign Matrix.

To display inserts for a different track in the Assign Matrix by
displaying track names:

1 In the Assign Matrix Menu Area, press the top encoder (track
name) B/M/P switch. The track names are displayed in the As-
sign Matrix Select area.

2 If necessary, use the bottom encoder or the Page Up and Page
Down switches in the Assign Matrix Navigation area to locate
the track you want to display.

3 Press the encoder Select switch for the track you want to dis-
play.

Closing the Assign Matrix

To close the Assign Matrix, do any of the following:

s Press the bottom encoder Select switch (when labeled
“Exit”) in the Assign Matrix Navigation Area. This exits the
Assign Matrix even when the Matrix is locked.

= Hold Control (Windows) or Command (Mac) and press the
bottom encoder Select switch (when labeled “Back”) in the As-
sign Matrix Navigation Area. This exits the Assign Matrix even
when the Matrix is locked.

= Press the flashing Escape switch. This works only when the
Assign Matrix is not locked.

Assigning Inserts

To assign an Insert (where no insert is present):

1 Press the Inserts switch on the channel where you want to as-
sign the insert. Insert positions are displayed on the channel
encoders.

2 Press the Page Up and Page Down switches to show the insert
position you want to assign.

3 Press the encoder Select switch for the Insert position where
you want to make an assignment. The Assign Matrix opens,
with the top-level Insert menu items displayed in the Select
Area.

4 Press the encoder Select switch for the type of insert you
want to assign.

5 Press the encoder Select switch for the next level menu
choice (for example, Plug-In Category or Manufacturer).
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6 Press the encoder Select switch for the insert you want to as-
sign.

To assign a different Insert (where an insert is present):

1 Press the Inserts switch on the channel where you want to as-
sign the insert. Insert positions are displayed on the channel
encoders.

2 Press the Page Up and Page Down switches to show the insert
position you want to assign.

3 Press and hold the encoder Select switch for the Insert posi-
tion where you want to change the assignment. The Assign Ma-
trix opens, with the current insert displayed in the Select Area,
indicated by a lit Select switch.

4 If necessary, use the bottom encoder or the Page Up and Page
Down and Back switches in the Assign Matrix Navigation area
to locate the insert you want to assign.

5 Press the encoder Select switch for the insert you want to as-
sign.

To remove an insert:

1 Press the Inserts switch on the channel where you want to re-
move the insert. Insert positions are displayed on the channel
encoders.

2 Press the Page Up and Page Down switches to show the insert
position you want to remove.

3 Press and hold the encoder Select switch at the Insert posi-
tion where you want to remove the assignment. The Assign
Matrix opens, with the insert displayed in the Select Area, in-
dicated by a lit Select switch.

4 Do one of the following:

« Hold the Set to Default switch and press the encoder Se-
lect switch for any insert in the Assign Matrix Select area.

—or -

 In the Assign Matrix Navigation area, press the bottom
encoder Select switch (labeled “Back”) until you reach the
top level of menu items, then press the encoder Select

switch that corresponds to “--” (No Insert) in the Assign
Matrix Select area.



Send Assign Matrix

The Send Assign Matrix lets you display, assign, change, and
remove sends from a session. The Send Assign Matrix shows
send positions (A-J), Send type (Interface or Bus), and send

names in the Assign Matrix Select area.

Displaying Sends

To display a Send in the Assign Matrix:

1 Press the Sends switch on the channel with the send you
want to display. Send positions are displayed on the channel
encoders.

2 Press the Page Up and Page Down switches to show the Send
position you want to display.

3 Do one of the following for the Send position you want to
display:
« If no send is present at the Send position, press the en-
coder Select switch.

—or -
« Ifasendisalready present at the Send position, press and

hold the encoder Select switch.

The Assign Matrix opens, showing the track name in the top

encoder and the selected Send position in the bottom encoder
in the Menu Area. The encoder Select switch lights to indicate
display of the selected Send position.

+ If no send is present at the Send position, the Select Area
shows the top-level Send types (Interface and Bus).

+ If a send is already present at the Send position, the Select
Area shows send paths, with the current send path indicated
by a lit Select switch.

To page through options in the Assign Matrix Select area:

= Press the Page Up and Page Down switches under the bottom
encoder (labeled “Back” or “Exit”) in the Assign Matrix Navi-
gation area. To page continuously, press and hold the switches.
To scroll through options in the Assign Matrix Select area:

» Turn the bottom encoder knob (labeled “Back” or “Exit” in
the Assign Matrix Navigation area.

To move down through Send menu levels:

» Press the encoder Select switch for Interface (“intrfc”) or
Bus (“bus”) in the Assign Matrix Select area.

To move up to the top Send menu level:

= In the Assign Matrix Navigation area, press the bottom en-
coder Select switch (labeled “Back”).

To momentarily display the full name of amenu item or send path
in the encoder displays:

= Touch the encoder knob for the item.

To open/close the window for a send:

= Hold Start (Windows) or Control (Mac) and press the en-
coder Select switch for the Send position in the Assign Matrix
Menu area.

Changing Send Display for a Track in the Assign
Matrix

To display a different send in the Assign Matrix by paging
through Sends:
1 In the Assign Matrix Menu Area, do one of the following:

« Press the lit Page Up or Page Down switch in the Assign
Matrix Menu area.

o Turn the bottom encoder in the Assign Matrix Menu area.

2 Press the flashing encoder Select switch to display the new
Send position.

To display a different send in the Assign Matrix by displaying
Send names:

1 In the Assign Matrix Menu Area, press the B/M/P switch on
the bottom encoder. The Send positions are displayed in the
Assign Matrix Select area.

2 Press the encoder Select switch for the Send position you
want to display.

Changing Track Display in the Assign Matrix

To display sends for a different track in the Assign Matrix by
scrolling through track names:

1 In the Assign Matrix Menu Area, press the top encoder (track
name) Select switch.

2 Turn the top encoder to scroll through the tracks in the ses-
sion.

3 Press the flashing Select switch to display the sends for that
track in the Assign Matrix.

Chapter 12: Assigning Inserts, Sends and 1/O with the Assign Matrix 121



To display sends for a different track in the Assign Matrix by
displaying track names:

1 In the Assign Matrix Menu Area, press the top encoder (track
name) B/M/P switch. The track names are displayed in the As-
sign Matrix Select area.

2 If necessary, use the bottom encoder or the Page Up and Page
Down switches in the Assign Matrix Navigation area to locate
the track you want to display.

3 Press the encoder Select switch for the track you want to dis-
play.

Closing the Assign Matrix

To close the Assign Matrix, do any of the following:

» Press the bottom encoder Select switch (when labeled
“Exit”) in the Assign Matrix Navigation Area. This exits the
Assign Matrix even when the Matrix is locked.

= Hold Control (Windows) or Command (Mac) and press the
bottom encoder Select switch (when labeled “Back”) in the As-
sign Matrix Navigation Area. This exits the Assign Matrix even
when the Matrix is locked.

= Press the flashing Escape switch. This works only when the
Assign Matrix is not locked.

Assigning Sends

To assign a send (where no send path assignment is present):

1 Press the Sends switch on the channel where you want to as-
sign the send. Send positions are displayed on the channel en-
coders.

2 Press the Page Up and Page Down switches to show the Send
position you want to assign.

3 Press the encoder Select switch for the Send position where
you want to make an assignment. The Assign Matrix opens,
with the top-level Send types (Interface and Bus) displayed in
the Select Area.

4 Press the Page Up and Page Down switches to show the Send
position you want to assign.

5 Press the encoder Select switch for the type of send you want
to assign.

6 Press the encoder Select switch for the send path you want to
assign.
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To assign a different send (where a send path assignment is
present):

1 Press the Sends switch on the channel where you want to as-
sign the send. Send positions are displayed on the channel en-
coders.

2 Press the Page Up and Page Down switches to show the Send
position you want to assign.

3 Press and hold the encoder Select switch for the Send posi-
tion where you want to change the assignment. The Assign Ma-
trix opens, with the current send path displayed in the Select
Area, indicated by a lit Select switch.

4 If necessary, use the bottom encoder or the Page Up and Page
Down and Back switches in the Assign Matrix Navigation area
to locate the send path you want to assign.

5 Press the encoder Select switch for the send path you want to
assign.

To assign a send to multiple output paths:

1 Follow the above procedures to use the Assign Matrix to as-
sign or change a send path assignment.

2 If you want to make multiple assignments, enable Assign
Lock mode by pressing the encoder Select switch labeled
“Lock” in the Assign Matrix Navigation area.

3 In the Assign Matrix Navigation area, press the B/M/P switch
labeled “+” (below the “Lock” encoder) to latch output assign-
ments.

4 If necessary, use the bottom encoder or the Page Up and Page
Down and Back switches in the Assign Matrix Navigation area
to locate the send paths you want to assign.

5 Press the encoder Select switches for the additional output
paths you want to assign.

To remove a send:

1 Press the Sends switch on the channel where you want to re-
move the send. Send positions are displayed on the channel
encoders.

2 Press the Page Up and Page Down switches to show the Send
position you want to assign.

3 Press and hold the encoder Select switch for the Send posi-
tion where you want to remove the assignment. The Assign
Matrix opens, with the send displayed in the Select Area, indi-
cated by a lit Select switch.

4 In the Assign Matrix Navigation area, press the encoder Se-
lect switch labeled “Back” on the bottom encoder until you
reach the top level of Sends, then press the encoder Select
switch that corresponds to “--” (No Send) in the Assign Matrix
Select area.



I/0 Assign Matrix

The I/0 Assign Matrix lets you display, assign, change, and re-
move I/0 assignments on different types of tracks, as follows:

 Audio tracks and Auxiliary Input tracks: audio input and
output paths

o MIDI tracks: MIDI input and output channels

o Instrument tracks: MIDI input and output channels, audio
input and output paths

« VCA Master tracks: Group assignments

« Master Faders: output paths

Displaying 1I/O Paths

To display an I/O path in the Assign Matrix:

1 Press and hold the Sends switch on the channel whose I/0
routing you want to display.

2 Press the encoder Select switch for the Input or Output you
want to display.

The Assign Matrix opens, showing the track name in the top

encoder and the selected I/O path in the bottom encoder in the
Menu Area. The encoder Select switch lights to indicate dis-

play of the selected Send position.

To page through options in the Assign Matrix Select area:

= Press the Page Up and Page Down switches under the bottom
encoder (labeled “Back” or “Exit”) in the Assign Matrix Navi-
gation area. To page continuously, press and hold the switches.
To scroll through options in the Assign Matrix Select area:

» Turn the bottom encoder knob (labeled “Back” or “Exit” in
the Assign Matrix Navigation area.

To move down through I/O menu levels (for audio paths):

» Press the encoder Select switch for Interface (“intrfc”) or
Bus (“bus”) in the Assign Matrix Select area.

To move up to the top I/O menu level (for audio paths):

= In the Assign Matrix Navigation area, press the bottom en-

coder Select switch (labeled “Back™).

To momentarily display the full name of amenu item or send path
in the encoder displays:

s Touch the encoder knob for the item.

To open/close atrack Output window (for audio paths):

= Hold Start (Windows) or Control (Mac) and press the en-
coder Select switch for the Output in the Assign Matrix Menu
area.

Changing I/O Display for a Track in the Assign
Matrix

To display a different I/O path in the Assign Matrix:

1 In the Assign Matrix Menu Area, press the B/M/P switch for
any path. The I/0 paths are displayed in the Assign Matrix Se-
lect area.

2 Press the encoder Select switch for the I/0 path you want to
display.

Changing Track Display in the Assign Matrix

To display I/0 paths for a different track in the Assign Matrix by
scrolling through track names:

1 In the Assign Matrix Menu Area, press the top encoder (track
name) Select switch.

2 Turn the top encoder to scroll through the tracks in the ses-
sion.

3 Press the flashing Select switch to display the sends for that
track in the Assign Matrix.

To display I/0 paths for a different track in the Assign Matrix by
displaying track names:
1 In the Assign Matrix Menu Area, press the top encoder (track
name) B/M/P switch. The track names are displayed in the As-
sign Matrix Select area.

2 If necessary, use the bottom encoder or the Page Up and Page
Down switches in the Assign Matrix Navigation area to locate
the track you want to display.

3 Press the encoder Select switch for the track you want to dis-
play.

Closing the Assign Matrix

To close the Assign Matrix, do any of the following:

= Press the bottom encoder Select switch (when labeled
“Exit”) in the Assign Matrix Navigation Area. This exits the
Assign Matrix even when the Matrix is locked.

= Hold Control (Windows) or Command (Mac) and press the
bottom encoder Select switch (when labeled “Back”) in the As-
sign Matrix Navigation Area. This exits the Assign Matrix even
when the Matrix is locked.

= Press the flashing Escape switch. This works only when the
Assign Matrix is not locked.
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Assigning I/O Paths

To assign an I/O path:

1 Press and hold the Sends switch on the channel where you
want to assign the path. I/0 paths are displayed on the channel
encoders.

2 Press the encoder Select switch for the I/0 path you want to
assign. The Assign Matrix opens, with the current path indi-
cated by a lit Select switch.

3 If necessary, use the switches in the Assign Matrix Naviga-
tion area to locate the I/O path you want to assign.

4 Press the encoder Select switch for the I/0 path you want to
assign.

To assign multiple output paths (audio or MIDI):

1 Follow the above procedures to use the Assign Matrix to as-
sign or change an output path assignment.

2 If you want to make multiple assignments, enable Assign
Lock mode by pressing the encoder Select switch labeled
“Lock” in the Assign Matrix Navigation area.

3 In the Assign Matrix Navigation area, press the B/M/P switch
labeled “+” (below the “Lock” encoder) to latch output assign-
ments.

4 If necessary, use the bottom encoder or the Page Up and Page
Down and Back switches in the Assign Matrix Navigation area
to locate the output paths you want to assign.

5 Press the encoder Select switches for the additional output
paths you want to assign.

6 Press the encoder Select switches for the additional output
paths you want to assign.

To remove an /O path:

1 Press and hold the Sends switch on the channel where you
want to remove the path. I/0 paths are displayed on the chan-
nel encoders.

2 Press the encoder Select switch for the I/0 path you want to
remove. The Assign Matrix opens, with the current path indi-
cated by a lit Select switch.

3 In the Assign Matrix Navigation area, press the encoder Se-
lect switch labeled “Back” on the bottom encoder until you
reach the top level of I/0 paths, then press the encoder Select
switch that corresponds to “--” (No I/0) in the Assign Matrix
Select area.
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Chapter 13: Custom Fader Modes

With the Custom Faders feature, you can temporarily set aside
channel strips on D-Command and focus them on your own
customized groups of tracks, on Pro Tools Mix and Edit
groups, on specific track types, or on plug-in controls. Custom
Fader modes are only accessible on D-Command, and are not
displayed on-screen in Pro Tools.

On D-Command, Custom Fader channels are completely sepa-
rate from the surrounding channels on the control surface. All
tracks in the session bank around the Custom Fader channels,
and continue to behave normally in Pro Tools and on D-Com-
mand.

When channels are in use by any of the Custom Fader modes,
the blue indicator marked “CF,” located to the left of the chan-
nel fader, is lit.

The status of Custom Fader modes is saved with the Pro Tools
session. If you save and close a session with a Custom Fader

mode active, the session will reopen with the same mode ac-

tive.

Overview of Custom Fader Modes

The three Custom Fader modes are covered in detail later in
this section:

Groups Mode Lets you access Custom Groups or Mix/Edit
Groups functions.

The Custom Group functions let you create and recall up to
eight custom arrangements of tracks on D-Command that are
independent of the Mix or Edit groups in Pro Tools.

The Mix/Edit Group functions let you recall Pro Tools Mix or
Mix/Edit groups and display them on the Custom Fader chan-
nel strips. You can also activate and delete Mix or Mix/Edit
groups.

Tracks Mode Lets you bring all tracks of a particular type to
the Custom Fader channel strips. Track Types include Audio
tracks, Auxiliary Input tracks, MIDI tracks, Instrument
tracks, and Master Fader tracks.

Plug-In Mode Lets you focus the controls of a plug-in on the
Custom Fader channel strips, and any plug-in meters on the
channel strip’s meters.

A special expanded Plug-In view focuses the plug-in header
controls (such as Bypass, Compare and Safe) on the channel
strip Mute switches.
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Custom Fader Preferences
Setting the Number of Custom Fader Channels

You can set the size of the Custom Fader bank for each of the
Custom Fader modes. See “Maximum Custom Fader Bank
Size” on page 27.

Setting the Custom Fader Justification

You can set the location of the Custom Fader bank on the con-
trol surface. See “Custom Fader Justification” on page 27.

Displaying Hidden Tracks in Custom Faders

You can set D-Command to show hidden tracks in the Custom
Fader views. See “Display of Hidden Tracks in Custom Faders”
on page 28.

Custom Fader Controls

The Groups switch, Tracks switch, and Plug-In switch in the
Custom Faders section light when the corresponding Custom
Fader mode is active.

The Map switch works in combination with the Custom Fader
modes, and has no independent effect.

The Lock switch and Window switch function both in the Cus-
tom Fader modes and independently. See “Lock Switch” on
page 49.

Focus Channel
CUSTOM FADERS

Groups switch —() ()— Map switch

Groups . Map

Tracks switch 7(_) ()7 Lock switch

Tracks = Lock

Plug-In switch 7() ()7 Window switch

Plug-In /. Win

Q\i

Bank/Cycle

Focus Channel
display

Bank/Cycle switch

Custom Fader controls
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Custom Groups Mode

Custom Groups mode lets you create a custom collection of
tracks and arrange them in any order in the Custom Fader
channels. You can create up to eight independent Custom
Groups in a session.

Custom Groups are useful for temporarily associating tracks
that are not part of a Pro Tools Mix/Edit group. Also, because
you can add multiple instances of the same track to a Custom
Group, you can use this mode to map multiple parameters
from a single track onto adjacent channel faders.

Custom Groups are created and recalled entirely on D-Com-
mand, and are independent of Mix/Edit groups in Pro Tools.
D-Command Custom Groups are not reflected on-screen in
Pro Tools.

Custom Groups are saved in the Pro Tools session file, and
move with the session to any other system that supports
D-Command operation.

To create a Custom Group:

1 Hold the Groups switch in the Custom Faders section until it
flashes.

2 Press the Bank/Cycle switch until the Focus Channel display
indicates “Custom” for Custom Groups mode. The eight avail-
able Custom Groups appear on the encoders in the Custom
Fader channels.

3 If the Custom Group you want to access is not visible on the
encoders in the Custom Fader channels, press the Page Up or
Page Down switches to step through available Custom Groups.

4 Press the encoder Select switch that corresponds to the Cus-
tom Group you want to define. The Focus Channel display in-
dicates the selection.

5 Hold Control (Windows) or Command (Mac) and press the
Groups switch in the Custom Faders section. The Groups
switch flashes.

6 Add or subtract channels from the Custom Group by doing
any of the following:

« To add a channel to the Custom Group:

o Pressthe channel Select switch for the source channel you
want to add to the Custom Group. Tracks are added to the
Custom Group in the order you select them, and are
right-justified in the Custom Fader channels.

« To add multiple copies of a channel to the Custom Group:

« Hold Shift and press the channel Select switch once for
each copy of the source channel that you want to add to
the Custom Group.



« To insert a channel between existing channels in a Custom
Group:
 Press the channel Select switch of the Custom Fader chan-
nel following the position where you want to insert a new
channel. The switch will light indicating that the next
channel will be placed before the selected channel.

o Pressthe channel Select switch for the source channel you
want to add to the Custom Group.

o To remove a track from the Custom Group, do one of the fol-
lowing:
o Press the channel Select switch for the source channel
that you want to remove from the Custom Group.

« Hold Control+Start (Windows) or Command+Control
(Mac) and press the channel Select switch of the Custom
Fader channel you want to remove from the Custom
Group.

o Press the Default switch and press the channel Select
switch of the Custom Fader channel you want to remove
from the Custom Group.

7 Press the flashing Group switch when you are finished.

To recall a Custom Group:

1 Hold the Groups switch in the Custom Faders section until it
flashes.

2 Press the Bank/Cycle switch until the Focus Channel display
indicates “Custom” for Custom Groups mode. The eight avail-
able Custom Groups appear on the encoders in the Custom
Fader channels.

3 If the Custom Group you want to access is not visible on the
encoders in the Custom Fader channels, press the Page Up or
Page Down switches to step through available Custom Groups.

4 Press the encoder Select switch that corresponds to the Cus-
tom Group you want to recall.

To recall a Custom Group from the Soft Keys:

1 If the Soft Keys are in another display mode, return to the
top-level Soft Key display by holding Control (Windows) or
Command (Mac) and pressing the currently lit Soft Key
switch.

2 Hold the Groups switch in the Custom Faders section until it
flashes.

3 Press the Bank/Cycle switch until the Focus Channel display
indicates “Custom” for Custom Groups mode. The Custom
Group names appear in the Soft Keys.

4 Press the Soft Key that corresponds to Page Up or Page Down
to display the Custom Group you want to recall.

5 Press the Soft Key that corresponds to the Custom Group you
want to recall.

To name a Custom Group:

1 Recall the Custom Group you want to name.

2 Hold Alt (Windows) or Option (Mac) and press the Groups
switch.

3 Enter a name for the Custom Group in the Pro Tools dialog
and click OK.

To edit a Custom Group:

1 Recall the Custom Group you want to edit.

2 Hold Control (Windows) or Command (Mac) and press the
Groups switch. The Groups switch flashes.

3 Add or remove channels from the Custom Group by pressing
the appropriate channel Select switches.

4 Press the flashing Groups switch when you are finished.

To delete a Custom Group:

1 Recall the Custom Group you want to delete.

2 Hold Start+Alt+Control (Windows) or Control+Op-
tion+Command (Mac) and press the Groups switch.

3 Press Enter.

To exit Custom Groups Mode:

= Press the Escape switch.

Custom Fader Mix/Edit Groups Mode

Mix/Edit Groups mode lets you create, display, and edit

Pro Tools Mix and Mix/Edit groups on the Custom Fader
channels. This mode is useful for quickly calling the members
of a group to a set of faders for mixing and automation.

To recall a Mix/Edit group to the Custom Fader channels:

1 Hold the Groups switch in the Custom Faders section until it
flashes.

2 Press the Bank/Cycle switch until the Focus Channel display
indicates “Groups” for Mix/Edit Groups mode. The Mix/Edit
Group letters and names appear on the encoders in the Custom
Fader channels.

3 If the Mix/Edit group you want to access is not visible on the
encoders in the Custom Fader channels, press the Page Up or
Page Down switches to step through available Mix/Edit
groups.

4 Press the encoder Select switch that corresponds to the
Mix/Edit group you want to display.
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To recall a Mix/Edit Group to the Custom Fader channels from the
Soft Keys:

1 If the Soft Keys are in another display mode, return to the
top-level Soft Key display by holding Control (Windows) or
Command (Mac) and pressing the currently lit Soft Key
switch.

2 Hold the Groups switch in the Custom Faders section until it
flashes.

3 Press the Bank/Cycle switch until the Focus Channel display
indicates “Groups” for Mix/Edit Groups mode. The Mix/Edit
group letters and names appear in the Soft Keys.

4 Press the Soft Key that corresponds to Page Up or Page Down
to display the Mix/Edit group you want to recall.

5 Press the Soft Key that corresponds to the Mix/Edit group
you want to recall.

To activate/deactivate a Mix/Edit group:

= Do one of the following:

« When all Mix/Edit groups are displayed in the Custom
Group encoders, press the Bypass/Mute/Pre switch that
corresponds to the Mix/Edit group you want to acti-
vate/deactivate.

o When a Mix/Edit group is selected, hold Start+Control
(Windows) or Control+Command (Mac) and press the
Groups switch.

A deactivated group is indicated by inverted text in the Cus-
tom Faders display.

To activate/deactivate a Mix/Edit group from the Soft Keys:

1 If the Soft Keys are in another display mode, return to the
top-level Soft Key display by holding Control (Windows) or
Command (Mac) and pressing the currently lit Soft Key
switch.

2 Hold the Groups switch in the Custom Faders section until it
flashes.

3 Press the Bank/Cycle switch until the Focus Channel display
indicates “Groups” for Mix/Edit Groups mode. The Mix/Edit
group letters and names appear in the Soft Keys.

4 Press the Soft Key that corresponds to Page Up or Page Down
to display the Mix/Edit group you want to activate/deactivate.

5 Hold Start+Control (Windows) or Control+Command (Mac)
and press the Soft Key that corresponds to the Mix/Edit group
you want to activate/deactivate.
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To create a Mix/Edit group:

1 Make sure you are in Select mode.

2 Select the tracks you want to group by pressing their Select
switches.

3 Press the Group switch in the Management Soft Key section.

4 Choose the type of group to create: Edit Group, Mix Group,
or Edit/Mix Group.

5 Enter a name for the Group and click OK.

To edit a Mix/Edit group:

1 In Mix/Edit Groups mode, recall the Mix/Edit group you
want to edit.

2 Hold Control (Windows) or Command (Mac) and press the
Groups switch.

3 Add or remove channels from the Mix/Edit group by pressing
the appropriate Channel Select switches.

4 Press the flashing Escape switch when you are finished.

To delete a Mix/Edit group:
1 Recall the Mix/Edit Group you want to delete.

2 Hold Start+Alt+Control (Windows) or Control+Op-
tion+Command (Mac) and press the Groups switch.

3 Press Enter.

To delete a Mix/Edit group from the Soft Keys:

1 If the Soft Keys are in another display mode, return to the
top-level Soft Key display by holding Control (Windows) or
Command (Mac) and pressing the currently lit Soft Key
switch.

2 Hold the Groups switch in the Custom Faders section until it
flashes.

3 Press the Bank/Cycle switch until the Focus Channel display
indicates “Groups” for Mix/Edit Groups mode. The Mix/Edit
group letters and names appear in the Soft Keys.

4 Press the Soft Key that corresponds to Page Up or Page Down
to display the Mix/Edit group you want to delete.

5 Hold Alt+Start+Control (Windows) or Control+Op-
tion+Command (Mac) and press the Soft Key that corresponds
to the Mix/Edit group you want to delete.

To exit Mix/Edit Groups Mode:

= Press the Escape switch.



Displaying Mix/Edit Group Tracks On-Screen

In the top level of Mix/Edit Groups mode, you can display the
tracks in a Mix/Edit group and hide all other tracks from
D-Command.

To display tracks in a Mix/Edit group on-screen:

= Hold Start (Windows) or Control (Mac) and press the Select
switch for the Mix/Edit group to perform the “Show Only
Tracks In Group” command.

Displaying or “Spilling” VCA Slave Tracks to
Custom Faders

You can display all of the slave tracks for a VCA Master track
into the Custom Faders. This feature uses Mix/Edit Groups
mode to replicate a “VCA spill” command.

Whenever a VCA Master track is assigned to group, its By-
pass/Spill switch lights.
To spill VCA slave tracks in Custom Faders:

= Press the lit Bypass/Spill switch on a VCA Master track. The
Bypass/Spill switch flashes to indicate that the VCA Group is
spilled.

To exit display of VCA slave tracks in Custom Faders, do one of
the following:

= Press the flashing Bypass/Spill switch in the VCA Master
track.

= Press the Groups switch in the Custom Fader controls.

Custom Fader Tracks Mode

Tracks Mode lets you bring all tracks of a particular type to the
Custom Fader channel strips. Track Types include Audio
tracks, Auxiliary Input tracks, MIDI tracks, Instrument
tracks, VCA Master tracks, and Master Fader tracks.

To bring a Track type to the Custom Fader channels:

1 Hold the Tracks switch in the Custom Faders section until it
flashes.

2 Press the Bank/Cycle switch until the Focus Channel display
indicates the Track type you want to display.

To bring a Track type to the Custom Fader channels from the Soft
Keys:

1 If the Soft Keys are in another display mode, return to the
top-level Soft Key display by holding Control (Windows) or
Command (Mac) and pressing the currently lit Soft Key
switch.

2 Press the Tracks switch in the Custom Faders section.

3 Press the Soft Key that corresponds to the track type you
want to display in the Custom Fader channels.

The name of the Track type appears in the Custom Fader dis-
play. Tracks of the designated type appear in the Custom
Fader channels.

To exit Tracks mode:

= Press the lit Tracks switch.

Custom Fader Plug-In Mode

Plug-In mode focuses the first plug-in on the focused channel
on the Custom Fader Channels. This places all of the plug-in’s
parameters on the Custom Fader channel encoders, and any
plug-in meters on the Custom Fader channel meters.

This mode is useful for controlling plug-ins with a large num-
ber of controls, such as virtual instruments.

To focus a plug-in on the Custom Fader channels:

1 Focus the plug-in’s track in the Focus Channel section by
pressing the track’s Select switch. The name of the first plug-in
that is not a dynamics or EQ plug-in appears in the Focus
Channel display.

2 Press the Plug-In switch in the Custom Fader section. The
switch lights to indicate the mode is active. The plug-in name
and channel format appear in the Custom Fader channel dis-
plays, and the plug-in’s parameters appear in the Custom Fader
channel encoders.

3 In the Custom Faders section, press the Bank/Cycle switch to
cycle through the plug-ins on the focused channel. (The No In-
sert option is always available.)
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Custom Faders and Display of Plug-In Parameters

There are three view options available for display of plug-in
parameters in the channel displays of the Custom Faders.
These options, or view definitions, are accessible from the
D-Command operation preferences. See “Custom Fader
Plug-In Mode View Definitions” on page 28 for more informa-
tion.

Display of Parameter Types in the Rotary Encoders

In general, continuous plug-in parameters map to the Custom
Fader encoder knobs, and switched parameters functions map
to the B/M/P (Bypass/Mute/Pre) encoder switches. The pres-
ence of a switched parameter is indicated by the Pre indicator
above the corresponding B/M/P switch.

To display the parameter controlled by the B/M/P switches:

» Press the Switch Info switch.

Q In some cases, the same control may be mapped to both
" anencoder knob and its corresponding switch, allowing
you to use either control to adjust the parameter.

Plug-In meters map to the Custom Fader channel meters.
Plug-In input and output meters appear as standard level me-
ters. Any dynamics gain reduction meters (for example, in a
compressor or limiter plug-in) are shown as top-to-bottom
meters.

Expanded Plug-In View

Expanded Plug-In view lets you access additional plug-in con-
trols and manage individual channels (also called streams) of
a multi-mono plug-in. This mode places the following stan-
dard header controls in the Custom Fader channel displays:

 Plug-In Bypass
+ Plug-In Compare
+ Plug-In Automation Safe

« Plug-In Automation Enable

Q If the Custom Fader Plug-In Mode View Definition is set
" to Expanded view, then you are automatically in
Expanded Plug-In View when you enter Plug-In mode.

To enter Expanded Plug-In view:

= Press and hold the Plug-In switch in the Custom Fader sec-
tion until the switch flashes.
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The plug-in header controls are mapped as follows:

Plug-In Bypass To bypass the currently displayed plug-in,
press the Mute switch that corresponds to “Bypass” in the
channel displays. This toggles the Effect Bypass button in the
Plug-In window.

Plug-In Compare To toggle between the original saved plug-in
setting and any changes you have made to it, press the Mute
switch that corresponds to “Comp” in the channel displays.
This toggles the Compare button in the Plug-In window.

Plug-In Automation Safe To prevent existing plug-in automa-
tion from being overwritten, press the Mute switch that corre-
sponds to “Safe” in the channel displays. This toggles the Safe
button in the Plug-In window.

Plug-In Automation Enable To enable individual plug-in con-
trols for automation, press the Mute switch that corresponds
to “AutoEn” in the channel displays. This lists the automat-
able plug-in controls on the Custom Fader encoders. Choose
the controls to automate by pressing their encoder Select
switches. This toggles the Auto button in the Plug-In window.

Multi-Mono Plug-Ins and Expanded Plug-In View

With multi-mono plug-ins, the following plug-in channel con-
trols are mapped to the Custom Fader channel displays:

Link To link channels of a multi-mono plug-in, press the Mute
switch that corresponds to “Link” in the channel displays.
This toggles the Master Link button in the Plug-In window.

Target Stream To target a particular multi-mono plug-in
channel for editing, press the Mute switch that corresponds to
“TargtS” in the channel displays. This lists the plug-in chan-
nels on the Channel Fader encoders. You can then choose a
channel by pressing its encoder Select switch. The switch
lights to indicate the targeted channel.

Group Stream To group individual multi-mono plug-in chan-
nels for editing, press the Mute switch that corresponds to
“GroupS” in the channel displays. This lists the plug-in chan-
nels on the Channel Fader encoders. You can then group any
number of streams by pressing their encoder Select switches.
The Select switches light to indicate grouped channels.

Bypass Stream To bypass individual multi-mono plug-in
streams, press the Mute switch that corresponds to “BypS” in
the channel displays. This lists the plug-in channels on the
Channel Fader encoders. You can then bypass a stream by
pressing its encoder B/M/P switch. The B/M/P switch lights to
indicate the bypassed stream.

To exit Expanded Plug-In view:

= Press the flashing Plug-In switch.



Custom Fader Flip Mode

When in Custom Groups, Mix/Edit Groups, or Plug-In mode,
you can flip Custom Fader encoder rows to the faders with
Custom Fader Flip mode. Custom Fader Flip mode only affects
Custom Fader channels, and has no effect on channels in Nor-
mal mode.

To enter Custom Fader Flip mode:

= When in Groups, Tracks, or Plug-In mode, hold Win (Win-
dows) or Control (Mac) and press the Flip switch for the en-
coder row you want to flip to the faders.

To exit Custom Fader Flip mode:

= Press the lit Flip switch.

Custom Fader Map Modes

When in Groups or Plug-In mode, you can map individual en-
coder controls to faders on a track-by-track basis with Custom
Fader Map modes.

This mapping feature works differently depending on which of
the Custom Fader modes you are in. (Mapping is not available
in Tracks mode.)

Custom Fader Maps are saved with the session.

Map Mode for Custom Groups or Mix/Edit Groups

When in Custom Groups mode or Mix/Edit Groups mode, you
can map any encoder parameter to the fader on the same Cus-
tom Fader channel. In these Map modes, the rotary encoder
control swaps with the channel fader, and the encoder By-
pass/Mute/Pre switch swaps with the channel Mute switch.

Mapping while in these modes is vertically restricted to en-
coders and faders in the same channel strip.

To map an encoder to a fader (Custom Groups mode or Mix/Edit
Groups mode):

1 While in Custom Groups mode or Mix/Edit Groups mode,
press and hold the Map switch in the Custom Faders section
until the switch flashes.

2 In the Custom Fader channels, touch any rotary encoders
that you want to map to their corresponding channel fader.
3 Do one of the following:

o Press the flashing Map switch to confirm the mapping.

 Press the Escape switch to cancel the mapping and leave
Map edit mode.

The Map switch lights solid to indicate that the mapping is ac-
tive.

To bypass mapping (Custom Groups mode or Mix/Edit Groups
mode):

= Press the lit Map switch. Even when it is not displayed, map-
ping is remembered for each Custom Group or Mix/Edit
Group.

To recall mapping (Custom Groups mode or Mix/Edit Groups
mode):

1 Press the Groups switch in the Custom Faders section. The
Focus Channel display indicates “Custom” for Custom Groups
mode, and the eight Custom Groups appear on the encoders in
the Custom Fader channels.

2 While holding the Groups switch, press the Bank/Cycle
switch to toggle between “Groups” (Mix/Edit Group Mode) and
“Custom” (Custom Group Mode) if necessary. The Focus Chan-
nel display indicates the selection.

3 Press the Select switch that corresponds to the Custom Fader
group you want to recall.

4 Press the Map switch.

Plug-In Map Mode

When in Custom Faders Plug-In mode, you can map any
plug-in parameter to any of the faders in the Custom Fader
channels, including faders on different channels. In Plug-In
Map mode, a mapped rotary control is duplicated on the fader,
and a mapped switch is duplicated on the channel Mute
switch. (Because Plug-In mode does not use the faders, no
swapping takes place.)

Mapping while in this mode has no restriction on the vertical
relationship between encoders and faders.

How Plug-In Mapping is Stored

+ When you map a plug-in, all other instances of that plug-in
in the session will use the same mapping.

# Plug-In mapping is saved as a preference file with a .pim ex-
tension.

« Plug-In mapping for the last opened session is remembered
by the Pro Tools system (saved in the Pro Tools application

preferences file), so when you create a new session on the sys-
tem, all instances of the same plug-in will use the stored map-

ping.

+ Plug-In mapping files (.pim) files can be imported and ex-
ported for use with other D-Command and D-Control con-
soles.

To map an encoder to a fader (Plug-In mode):

1 While in Plug-In mode, press the Map switch in the Custom
Faders section.

2 In the Custom Fader channels, press the channel Select
switch on the channel where you want to map the encoder. The
Select switch flashes to indicate Map mode.
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3 Do one of the following:

+ In the Custom Fader channels, touch any rotary encoder
that you want to map to the selected channel’s fader.

— or —

« In the Custom Fader channels, press any switch that you
want to map to the selected channel’s Mute switch.

The mapped control appears on the selected channel’s fader.
Plug-In parameter mapping is remembered for that plug-in,
and is usable on any channel where it occurs.

To bypass mapping (Plug-In mode):

= Press the lit Map switch. Even when it is not displayed, map-
ping is remembered for each plug-in.

To recall mapping (Plug-In mode):

1 Focus the plug-in in the Focus Channel section.

2 Recall the plug-in by pressing the Plug-In switch in the Cus-
tom Faders section.

3 Press the Map switch.

To clear mapping (Plug-In mode):

1 Focus the plug-in in the Focus Channel section.

2 Recall the plug-in by pressing the Plug-In switch in the Cus-
tom Faders section.

3 Press the Map switch.

4 Press and hold the Set to Default and Do to All switches.

5 Press the channel Select switch on any Custom Fader chan-
nel.

Exporting and Importing .pim Files

To export plug-in mapping:

1 Press the Operation Console Prefs Soft Keys switch twice to
view the second page of Soft Key functions.

2 Press the Soft Key that corresponds to “Export PIMaps.”

3 Enter a name for the Plug-In Map (.pim) file, choose a loca-
tion, and click Save.

4 Press the Operation Soft Key twice to exit.

To import plug-in mapping:

1 Press the Operation Console Prefs Soft Keys switch twice to
view the second page of Soft Key functions.

2 Press the Soft Key that corresponds to “Import PIMaps.”

3 Locate the plug-in mapping (.pim) file you want to use and
click Import.

4 Press the Operation Soft Key twice to exit.
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Appendix A: Utility Mode

D-Command Utility mode lets you view system information,
run diagnostic tests, set hardware preferences, and reset sys-
tem settings.

Entering Utility Mode

You can enter Utility mode at any time to change D-Command
settings. Utility mode can be accessed from the D-Command
Main Unit and also on individual D-Command Fader Modules.

Entering Utility Mode from a Main Unit

When putting a D-Command Main Unit into Utility mode, the
behavior of connected Fader Modules depends on whether or
not the units are online.

A D-Command unit is online if Pro Tools is running and the
unit is declared in the Peripherals page of the Setups dialog. A
unit is offline when Pro Tools is not running, or if it is not de-
clared on a system that is running Pro Tools.

To enter Utility mode from the Main Unit:

= Press the Utility switch in the Session Management section.
The Utility switch and the Soft Keys flash to indicate Utility
mode is active.

o Ifthe Main Unit is online, any Fader Modules declared on
the same Pro Tools system also enter Utility mode.

« If the Main Unit is offline, all offline Fader Modules on
the same Ethernet network enter Utility mode.

Entering Utility Mode on a Fader Module

You can put individual Fader Modules into Utility mode to
test them independently of other D-Command units.

To put an individual Fader Module into Utility mode:
1 If Pro Tools is running, do one of the following:
e Quit Pro Tools.
—or -

« Choose Setups > Peripherals, click Ethernet Controllers,
and make sure the Fader Module is not declared.

2 Press and hold the Modifier Keys in the lower left of the
Fader Module in the following sequence: Shift + Alt/Command
+ Win/Option. The encoder Select switches in the bottom row
flash to indicate Utility mode is active.

Shitt/Shit  Ci/Ctl  Opt/Win  38/At

_E <
A |

3

Fader Module Modifier Key sequence for Utility mode

Navigating Utility Mode
When the unit is in Utility mode, the Utility Setup Page is dis-
played on the Soft Key displays (Main Unit) or on the bottom
row of encoders (Fader Module).
The Utility Setup page has five top-level options:

+ System: System Info Page

« Name: Name Setup Page

o Test: Test Setup Page

o Reset: Reset D-Command to Defaults

o Pref: Preference Setup Page

To access an option on the Utility Setup Page:

= Press the Soft Key (Main Unit) or the encoder Select switch
(Fader Module) that corresponds to the option.

To move back up to the Utility Setup Page:

= Press the Soft Key (Main Unit) or the encoder Select switch
(Fader Module) that corresponds to “Escape.”
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Exiting Utility Mode

To exit Utility mode, do one of the following:

= Press the flashing Utility switch (Main Unit).
—or -

= Press the Soft Key (Main Unit) or encoder Select switch
(Fader Module) that corresponds to “Escape.”

D-Command System Info Page

The System Info page provides access to the system firmware
version and Ethernet information.

To display the System Info page:

= From the Utility Setup page, press the Soft Key (Main Unit)
or the encoder Select switch (Fader Module) that corresponds
to “System.”

To exit the System Info page:

= Press the Soft Key (Main Unit) or encoder Select switch
(Fader Module) that corresponds to “Escape.”

Firmware Version

In the System Info page, hold the Soft Key (Main Unit) or en-
coder Select switch (Fader Module) that corresponds to “FW
ver.” This shows the Comm board and Motor Control board
firmware versions.

Ethernet Info

In the System Info page, hold the Soft Key (Main Unit) or en-
coder Select switch (Fader Module) that corresponds to
“Ethrnt” to display the following information:

+ Unit Name (as named on the Name Page)
o ID: Ethernet address (Machine Address Code) for the unit
¢ Num: The serial number for the unit

+ Type: The Ethernet packet type used for control surface
communication
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D-Command Name Page

The Name page is used to view and change D-Command unit
names. These names appear in the Pro Tools Peripherals dia-
log, and must be unique so as to identify each D-Command

unit correctly. This is especially important if your system is on
an Ethernet network with multiple controllers connected to it.

To display the Name page for a D-Command unit:

1 Put the unit you want to name into Utility mode. Fader Mod-
ules must be put into Utility mode independently. (See “Enter-
ing Utility Mode on a Fader Module” on page 133.)

2 From the Utility Setup page, press the Soft Key (Main Unit)
or the encoder Select switch (Fader Module) that corresponds
to “Name.”

The Main Unit name appears in the Soft Keys section. The
Fader Module name appears in its encoder displays. The first
character of the name flashes to indicate text entry.

To change the unit name:

1 Turn the Scrub/Shuttle wheel (Main Unit) or any encoder
knob (Fader Module) to change the selected text.

2 To move forward and backward through the name field,
press the flashing Soft Keys (Main Unit) or encoder Select
switches (Fader Module) that correspond to the “<” and “>”
symbols.

3 When you are finished entering text, do one of the following:

« Confirm the new name by pressing the Soft Key (Main
Unit) or the encoder Select switch (Fader Module) that
corresponds to “OK.”

 Clear the name field by pressing the Soft Key (Main Unit)
or the encoder Select switch (Fader Module) that corre-
sponds to “Clear.”

« Cancel the new name by pressing the Soft Key (Main
Unit) or the encoder Select switch (Fader Module) that
corresponds to “Cancel.”



D-Command Test Pages

The Test pages let you test various mechanical and electronic
components of the unit.

To display the Test Setup page:

= From the Utility Setup page, press the Soft Key (Main Unit)
or the encoder Select switch (Fader Module) that corresponds
to “Test.”

The Test Setup page has five top-level test modes:
+ Ethernet: Ethernet Test Page
o LED: Switch and LED Test Pages
+ Display: Display Test Page
« Fader: Fader Test Page
+ Rotary: Rotary Encoder Test Page

To enter a test mode on the Test Setup page:

= Press the Soft Key (Main Unit) or the encoder Select switch
(Fader Module) that corresponds to the test mode name.

To exit the Test Setup page:

= Press the Soft Key (Main Unit) or encoder Select switch
(Fader Module) that corresponds to “Escape.”

Ethernet Test Page

There are three test levels for Ethernet communication on
D-Command: Internal, Mendec, and External. These tests can
assist Technical Support should you ever experience difficulty
with Ethernet communication between D-Command and

Pro Tools.

Each test sends data packets through that unit’s Ethernet sys-
tem. The Transmit (Xmit) and Receive (Recv) values for each
test show the number of packets sent and received in the test,
and the “Error” and “Retry” fields show percentage error in

the transmission and receiving process. An error rate of 1 per-
cent or less generally indicates acceptable performance. (In

normal operation, errors are retried and no data loss occurs.)

To display the Ethernet Test page:

1 Put the unit you want to test into Utility mode. Fader Mod-
ules must be put into Utility mode independently. (See “Enter-
ing Utility Mode on a Fader Module” on page 133.)

2 From the Test Setup page, press the Soft Key (Main Unit) or
encoder Select switch (Fader Module) that corresponds to
“Ethrnt.”

To exit the Ethernet Test page:

= Press the Soft Key (Main Unit) or encoder Select switch
(Fader Module) that corresponds to “Escape.”

Internal

The Internal test verifies the first stage of Ethernet communi-
cation by sending data packets through the unit’s Ethernet
link chip.

To perform the Internal Ethernet test:

1 From the Ethernet Test page, press the Soft Key (Main Unit)
or the encoder Select switch (Fader Module) that corresponds
to “Clear” to clear any values in the unit’s test data page.

2 Press the Soft Key (Main Unit) or the encoder Select switch
(Fader Module) that corresponds to “Intrnl.”

To exit the Internal Ethernet test:

= Press the flashing Soft Key (Main Unit) or encoder Select
switch (Fader Module).

Mendec

The Mendec (Manchester Encoder/Decoder) test verifies the
second stage of Ethernet communication by sending data
packets through the unit’s Ethernet encoder and decoder.

To perform the Mendec Ethernet test:

1 From the Ethernet Test page, press the Soft Key (Main Unit)
or the encoder Select switch (Fader Module) that corresponds
to “Clear” to clear any values in the unit’s test data page.

2 Press the Soft Key (Main Unit) or the encoder Select switch
(Fader Module) that corresponds to “Mendec.”

To exit the Mendec Ethernet test:

= Press the flashing Soft Key (Main Unit) or encoder Select
switch (Fader Module).

External

The External test verifies the third stage of Ethernet commu-
nication by sending data packets out of the unit’s external
Ethernet port and back into the unit using the Ethernet loop-
back connector (provided with the D-Command Main Unit).

To perform the External Ethernet test:

1 If Pro Tools is running, quit Pro Tools.
2 Disconnect the unit from the Ethernet network.

3 Plug the Ethernet Loopback connector into the unit’s Ether-
net port.

4 From the Ethernet Test page, press the Soft Key (Main Unit)
or the encoder Select switch (Fader Module) that corresponds
to “Clear” to clear any values in the unit’s test data page.

5 Press the Soft Key (Main Unit) or the encoder Select switch
(Fader Module) that corresponds to “Extrnl.”
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To exit the External Ethernet test:

= Press the flashing Soft Key (Main Unit) or encoder Select
switch (Fader Module).

Switch and LED Test Page

The Switch and LED Test page has five modes:
« Switch: Switch Test Mode
o Red: Red LED Test Mode
« Yellow: Yellow LED Test Mode
o Green: Green LED Test Mode
+ Vegas: Vegas Mode

To display the Switch and LED Test page:

= From the Test Setup page, press the Soft Key (Main Unit) or
encoder Select switch (Fader Module) that corresponds to
“LED”

To exit the Switch and LED Test page:

= Press the Soft Key (Main Unit) or encoder Select switch
(Fader Module) that corresponds to “Escape.”

To enter any of the Switch and LED Test modes:

= Press the Soft Key (Main Unit) or the encoder Select switch

(Fader Module) that corresponds to the mode name.

Switch Test Mode

Switch Test mode lets you test each switch on the unit individ-
ually.
To test any switch:

= Press the switch you want to test.

The switch LED lights as long as it is held and the Soft Key dis-
play (Main Unit) or encoder displays (Fader Module) show the
location information for the switch.

To exit Switch Test mode:

= Press the Soft Key (Main Unit) or encoder Select switch
(Fader Module) that corresponds to “Escape.”

LED Test Modes (Red, Yellow, Green)

The LED Test modes lets you test all red, yellow, and green
LEDs on the unit individually.

To test LEDs:

= Press the Soft Key that corresponds to “Red,” “Yellow,” or
“Green” to test all LEDs of the corresponding color.

To exit LED Test mode:

= Press the Soft Key (Main Unit) or encoder Select switch
(Fader Module) that corresponds to “Escape.”
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Vegas Mode

Vegas mode randomly lights every switch, meter, and display
on the unit, and runs the faders in sine wave mode.
To enter Vegas mode:

= Press the Soft Key that corresponds to “Vegas.”

To exit Vegas mode:

= Press any switch on the unit.

Display Test Page

The Display Test page has three modes:
o Text: Display Test
o Timecode: Timecode Display Test
« Meter: Meter Bridge LED Test

To display the Display Test page:

= From the Test Setup page, press the Soft Key (Main Unit) or
encoder Select switch (Fader Module) that corresponds to
“Disply.”

To exit the Display Test page:

= Press the Soft Key (Main Unit) or encoder Select switch
(Fader Module) that corresponds to “Escape.”

To enter any of the Display Test modes:

= Press the Soft Key (Main Unit) or the encoder Select switch

(Fader Module) that corresponds to the mode name.

Text (Display) Test

The Text test mode cycles through a series of display tests that
check all displays on the control surface.

To exit Text Test mode:

= Press any flashing Soft Key (Main Unit) or encoder Select
switch (Fader Module).

Meter Bridge LED Test

The Meter Bridge LED test cycles through a series of auto-
mated tests that check all LEDs on each meter.
To exit Meter Bridge LED Test mode:

= Press the Soft Key (Main Unit) or encoder Select switch
(Fader Module) that corresponds to “Escape.”



Timecode Display Test
(Main Unit Only)

The Timecode Display test cycles through a series of auto-
mated tests that check all LED segments on the Main Unit
Timecode display.

To exit Timecode Display Test mode:

= Press the Soft Key that corresponds to “Escape.”

Fader Test Page

The Fader Test page provides four test modes and a calibra-
tion mode:

« Step: Fader Step Test Mode
 Cycle: Fader Cycle Test Mode

« Group: Fader Group Test Mode
« Touch: Fader Touch Test Mode

« Recal: Recalibrates Faders

To display the Fader Test page:

= From the Test Setup page, press the Soft Key (Main Unit) or
encoder Select switch (Fader Module) that corresponds to
“Fader.”

To exit the Fader Test page:

= Press the Soft Key (Main Unit) or encoder Select switch
(Fader Module) that corresponds to “Escape.”

To enter any of the Fader Test modes:

= Press the Soft Key (Main Unit) or the encoder Select switch

(Fader Module) that corresponds to the test name.

Step Test Mode

In Step Test mode, faders jump together, in stepped fashion,
to positions that are adjustable with the Scrub/Shuttle wheel
(Main Unit) or any encoder knob (Fader Module).

To exit Step Test mode:

= Press the Soft Key (Main Unit) or encoder Select switch
(Fader Module) that corresponds to “Escape.”

Cycle Test Mode

In Cycle Test mode, faders move together, from the bottom to
top, in a continuous cycle, at a speed that is adjustable with
the Scrub/Shuttle wheel (Main Unit) or any encoder knob
(Fader Module).

Fader position values are shown in the channel displays and
are updated in real time as the faders move.

To exit Cycle Test mode:

= Press the Soft Key (Main Unit) or encoder Select switch
(Fader Module) that corresponds to “Escape.”

Group Test Mode

In Group Test mode, faders can be moved to test group re-
sponse.

This mode displays which faders are currently being touched
by showing the letter “I” in their channel displays.

To exit Group Test mode:
= Press the Soft Key (Main Unit) or encoder Select switch

(Fader Module) that corresponds to “Escape.”

Touch Test Mode

The Touch Test page lets you test the touch sensitivity of each
fader. The channel displays show when a fader is touched and
what frequency the fader is currently recognizing. The fader
frequency value is updated in real time.

This mode displays which faders are currently being touched
by showing the letter “T” in their channel displays.

To exit Touch Test mode:
= Press the Soft Key (Main Unit) or encoder Select switch

(Fader Module) that corresponds to “Escape.”

Recal

The Recal command recalibrates D-Command fader touch
sensitivity and position to factory specifications.

In addition, under conditions of heavy use, the D-Command
fader motor protection feature may disengage a fader if it is in
danger of overheating. The Recal command reengages any dis-
engaged faders.

To recalibrate the faders:

= From the Fader Test page, press the Soft Key (Main Unit) or
the encoder Select switch (Fader Module) that corresponds to
“Recal’

Appendix A: Utility Mode 137



Rotary Test Page

The Rotary Test page lets you test the touch-sensitive encoder
knob and the LED ring in each rotary encoder, as well as the
Scrub/Shuttle wheel on the Main Unit.

To enter Rotary Test mode:

= From the Test Setup page, press the Soft Key (Main Unit) or
encoder Select switch (Fader Module) that corresponds to
“Rotary”

To exit Rotary Test mode:
= Press the Soft Key next to “Escape” (Main Unit) or the flash-
ing encoder Select switch.

To test the rotary encoders:

+ Touch any encoder knob. When the encoder knob is
touched, the encoder’s display turns red and the “Auto” indica-
tor LED below the knob lights.

+ Turn any encoder knob. When the encoder knob is turned,
each LED in the LED ring lights in order.
To test the Scrub/Shuttle wheel:

= Turn the Scrub/Shuttle wheel. The numerical value in the
lower left display of the Soft Key section value changes de-
pending on which way you turn the wheel.

Resetting D-Command to Factory
Defaults

The Reset (Factory Default) page lets you reset the D-Com-
mand Main Unit and Fader Modules to their factory default
settings.

To reset D-Command:

1 From the Utility Setup Page, press the Soft Key (Main Unit)
or the encoder Select switch (Fader Module) that corresponds
to “Reset.”

2 Press the Soft Key (Main Unit) or the encoder Select switch
(Fader Module) that corresponds to “OK.”
3 Do one of the following:

+ Confirm your choice by pressing OK again.

—or-

 Cancel the reset operation by pressing the Soft Key (Main

Unit) or the encoder Select switch (Fader Module) that
corresponds to “Cancel”
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D-Command Preferences

D-Command Preferences let you set various display and oper-
ation preferences for the unit.

To display the Preferences page:

= From the Utility Setup Page, press the Soft Key (Main Unit)
or the encoder Select switch (Fader Module) that corresponds
to “Prefs.”

The D-Command Preferences page has five preferences:
« Bright: Display Brightness
« Contrast: Display Contrast
o Foot 1: Footswitch 1 Settings
» Foot 2: Footswitch 2 Settings
« Sleep: Sleep Mode Settings

To access a preference on the Preferences page:

= Press the Soft Key (Main Unit) or the encoder Select switch
(Fader Module) that corresponds to the preference name.

Display Brightness Page

The Display Brightness page lets you adjust the brightness of
the display LED displays.

To set the display brightness:

1 From the Preferences page, press the Soft Key (Main Unit) or
the encoder Select switch (Fader Module) that corresponds to
“Bright”

2 Turn the Scrub/Shuttle wheel (Main Unit) or any encoder
knob (Fader Module) to change the brightness value. Bright-
ness values range from 0-127.

3 Do one of the following:

« Confirm the new brightness value by pressing the Soft
Key (Main Unit) or the encoder Select switch (Fader Mod-
ule) that corresponds to “OK.”

o Cancel the new brightness value by pressing the Soft Key
(Main Unit) or the encoder Select switch (Fader Module)
that corresponds to “Cancel”



Display Contrast Page

The Display Contrast page lets you adjust the level of back-
lighting in the display LED displays.

To set the display contrast:

1 From the Preferences page, press the Soft Key (Main Unit) or
the encoder Select switch (Fader Module) that corresponds to
“Contrast.”

2 To adjust the overall contrast for all displays, press the Soft
Keys (Main Unit) or the encoder Select switches (Fader Mod-
ule) that correspond to “>>” or “<<” to increase or decrease
the contrast value. Overall contrast values range from 0-9.

3 To adjust the relative contrast for individual rows of dis-
plays, turn the Flip encoder knobs (Main Unit) or any encoder
knobs in a given row (Fader Module). Individual contrast val-
ues are shown as “Step” numbers ranging from 0-62.

4 To cycle the displays through inverted text display, repeat-
edly press the Soft Key (Main Unit) or the encoder Select
switch (Fader Module) that corresponds to “Invert.”

5 Do one of the following:

« Confirm the new contrast values by pressing the Soft Key
(Main Unit) or the encoder Select switch (Fader Module)
that corresponds to “OK.”

« Reset the contrast values to their defaults by pressing the
Soft Key (Main Unit) or the encoder Select switch (Fader
Module) that corresponds to “Reset.”

« Cancel the new contrast values by pressing the Soft Key
(Main Unit) or the encoder Select switch (Fader Module)
that corresponds to “Cancel”

Footswitch 1 and 2 Settings Pages
(Main Unit Only)

The Footswitch Settings pages for Footswitch 1 and Foot-
switch 2 let you set the function for each. For each setting,
pressing the footswitch is the functional equivalent of press-
ing the corresponding switch on the D-Command Main Unit.

Each Footswitch Settings page has four options:

« Flip + / Flip - : Changes the polarity of the footswitch
connection to positive (+) or negative (-).

« Play: Simulates pressing the Play switch on the transport

o Record: Simulates pressing the Record switch on the
transport

« Talkback: Simulates pressing the Talkback switch on the
D-Command Main Unit

To set the function of the footswitches:

1 From the Preferences page, press the Soft Key that corre-
sponds to “Foot 1” or “Foot 2.”

2 Press the Soft Key that corresponds to the function you want
to assign to the footswitch. The Soft Key for the selected func-
tion lights continuously.

= Press the Soft Key that corresponds to “Escape.”

Sleep Mode Settings Page

Sleep mode saves power by dimming the LEDs on the D-Com-
mand unit. The Sleep Mode Settings page lets you set the
amount of idle time before the LEDs on the unit dim automat-
ically.

To set the time before the D-Command unit sleeps:

1 From the Preferences page, press the Soft Key (Main Unit) or
the encoder Select switch (Fader Module) that corresponds to
“Sleep.”

2 Turn the Scrub/Shuttle wheel (Main Unit) or any encoder
knob (Fader Module) to change the time before the unit goes
to sleep. Times range in 1-minute increments from 1 to 59
minutes, then in 1-hour increments from 1 to 12 hours, to Off
(the unit never goes to sleep).
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Appendix B: Audio Connections and Pinouts

All external D-Command audio connections are made to the back panel of the XMON interface, shown below. All audio connec-
tors are standard female DB-25 connectors. The connector for communication with D-Command is a 15-pin female connector.

Cue Inputs Main Inputs

Surround Inputs

Stereo Inputs

cuE I[ipuTs MAIN [VPUTS SURROUI|D INPUTS

17 digidesign

CUE OUTPUTS MAIN OUTPUTS ALT OUTPUTS

TB/LB/UTIL l— METER CAL

---------- )> 20006006006

STERE(| INPUTS

ACIO024015060H2, 54 45W

— @

Cue Outputs Main Outputs

XMON back panel connectors

Alt Outputs

25-Pin Female Connector Pinouts

All XMON DB-25 connector pinouts conform to the pin num-

bering scheme shown below.

Talkback/Listenback/Utility

Main Inputs

D-Command connector

Main Inputs
Signal Name Hot (+) (C_C))Id Ground (shield)
Main Input 1 (L) 24 12 25
[Main Input 2 (Lc)]* 10 23 11
Main Input 3 (C) 21 9 22
[Main Input 4 (Rc)]* 7 20 8
Main Input 5 (R) 18 6 19
Main Input 6 (Ls) 4 17 5
Main Input 7 (Rs) 15 3 16
Main Input 8 (LFE) 1 14 2
GND 13
SHIELD GND connector housing

13 1
25 14
DB-25 Connector (user view)
Cue Inputs
Cue Inputs
Signal Name Hot (+) E:_())Id Ground (shield)
Cue Input 1 (Left) | 24 12 25
Cue Input 1 (Right) | 10 23 11
Cue Input 2 (Left) | 21 9 22
Cue Input 2 (Right) | 7 20 8
[Not Connected] 18 6 19
[Not Connected] 4 17 5
[Not Connected] 15 3 16
[Not Connected] 1 14 2
GND 13
SHIELD GND connector housing

* Main Inputs 2 and 4 are active on XMON, but the corre-
sponding Lc and Rc outputs cannot be controlled indepen-
dently from the D-Command monitor section.
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Surround Inputs Cue Outputs

Surround Inputs Cue Outputs

Signal Name Hot (+) Ei())ld Ground (shield) Signal Name Hot (+) (Ci())ld Ground (shield)

Surround Input 1 (L) 24 12 25 SLS Output (Left) 24 12 25

[Surround Input 2 (Lc)]* | 10 23 11 SLS Output (Right) 10 23 11

Surround Input 3 (C) 21 9 22 Cue Output 1 (Left) | 21 9 22

[Surround Input 4 (Rc)]* | 7 20 8 Cue Output 1 (Right) | 7 20 8

Surround Input 5 (R) 18 6 19 Cue Output 2 (Left) 18 6 19

Surround Input 6 (Ls) 4 17 5 Cue Output 2 (Right) | 4 17 5

Surround Input 7 (Rs) | 15 3 16 [Not Connected] 15 3 16

Surround Input 8 (LFE) | 1 14 2 [Not Connected] 1 14 2

GND 13 GND 13

SHIELD GND connector housing SHIELD GND connector housing
* Surround Inputs 2 and 4 are active on XMON, but the corre- Main Speaker Outputs

sponding Lc and Rc outputs cannot be controlled indepen-

dently from the D-Command monitor section. Main Speaker Outputs

Signal Name Hot (+) Cold Ground (shield)
Stereo Inputs =)
Stereo Inputs Main 1 (L) 24 12 25
Main 2 (Lc)]* 10 23 11
Signal Name Hot (+) Ei())ld Ground (shield) [ (Lol
Main 3 (C) 21 9 22
Stereo Input 1 (Left) 24 12 25 -
[Main 4 (Rc)]* 7 20 8
Stereo Input 1 (Right) | 10 23 11 -
Main 5 (R) 18 6 19
Stereo Input 2 (Left) 21 9 22 -
Main 6 (Ls) 4 17 5
Stereo Input 2 (Right) | 7 20 8 -
Main 7 (Rs) 15 3 16
Stereo Input 3 (Left) 18 6 19 -
Main 8 (LFE) 1 14 2
Stereo Input 3 (Right) | 4 17 5
P (Right GND 13
[Not Connected] 15 3 16 -
SHIELD GND connector housing
[Not Connected] 1 14 2
* Main Speaker Outputs 2 and 4 are active on XMON, but Lc
GND 13 .
and Rc outputs cannot be controlled independently from the
SHIELD GND connector housing D-Command monitor section. Global Volume, Solo, and Mute

controls affect all outputs.
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Alt Speaker Outputs

Alt Speaker Outputs

Signal Name Hot (+) (Ci())ld Ground (shield)
Alt 1 (L) 24 12 25

[Alt 2 (Lc)]* 10 23 1

Alt 3 (C) 21 9 22

[Alt 4 (Re)]* 7 20 8

Alt 5 (R) 18 6 19

Alt 6 (Ls) 4 17 5

Alt 7 (Rs) 15 3 16

Alt 8 (LFE) 1 14 2

GND 13

SHIELD GND connector housing

* Alt Speaker Outputs 2 and 4 are active on XMON, but Lc and

Rc outputs cannot be controlled independently from the

D-Command monitor section. Global Volume, Solo, and Mute

controls affect all outputs.

Talkback/Listenback Pinouts

Talkback/Listenback
Signal Name Hot (+) ?_())Id Ground (shield)
Ext Talkback Mic 24 12 25
Input
Listen Mic 1 Input 10 23 11
Listen Mic 2 Input 21 9 22
AFL Input 1 20 7 8
AFL Input 2 6 18 19
Mini Speaker Out (L) | 4 17 5
Mini Speaker Out 15 3 16
(R)
Talkback/Slate Out 1 14 2
GND 13
SHIELD GND connector housing

15-Pin Connector Pinouts

The XMON 15-pin connector pinouts conform to the pin num-

bering scheme shown below.

8 1

15 9

15-pin connector (user view)

XMON to D-Command Connector Pinouts

XMON to D-Command Pinouts

Signal Name Hot (+) ?_()Jld Ground (shield)
RS422 Input 1 9

RS422 Output 2 10

MIDI Input 12 4

MIDI Output 11 3

Headphones L 5 13

Headphones R 6 14

Internal Talkback Mic | 15 8

GND 7

SHIELD GND connector housing
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Appendix C: Compliance Information

Environmental Compliance

Disposal of Waste Equipment by Users in the
European Union

X
iy

This symbol on the product or its packaging indicates that this product must not
be disposed of with other waste. Instead, it is your responsibility to dispose of
your waste equipment by handing it over to a designated collection point for the
recycling of waste electrical and electronic equipment. The separate collection
and recycling of your waste equipment at the time of disposal will help conserve
natural resources and ensure that it is recycled in a manner that protects human
health and the environment. For more information about where you can drop off
your waste equipment for recycling, please contact your local city recycling
office or the dealer from whom you purchased the product.

Proposition 65 Warning

A This product contains chemicals, including lead, known to the State
of California to cause cancer and birth defects or other reproductive

harm. Wash hands after handling.

Perchlorate Notice

This product may contain a lithium coin battery. The State of California requires
the following disclosure statement: “Perchlorate Material — special handling may
apply, See www.dtsc.ca.gov/hazardouswaste/perchlorate.”

Recycling Notice

4y
L

EMC (Electromagnetic Compliance)

Avid declares that this product complies with the following standards regulating
emissions and immunity:

¢ FCC Part 15 Class A

EN55103-1 E4

EN55103-2 E4

AS/NZS CISPR 22 Class A

CISPR 22 Class A

FCC Compliance for United States

Radio and Television Interference

Communication Statement

Note: This equipment has been tested and found to comply
with the limits for a Class A digital device, pursuant to part
15 of the FCC Rules. These limits are designed to provide
reasonable protection against harmful interference when
the equipment is operated in a commercial environment.
This equipment generates, uses, and can radiate radio
frequency energy and, if not installed and used in
accordance with the instruction manual, may cause harmful
interference to radio communications. Operation of this
equipment in a residential area is likely to cause harmful
interference in which case the user will be required to
correct the interference at his own expense.

Any modifications to the unit, unless expressly approved by
Avid, could void the user's authority to operate the
equipment.

Australia and New Zealand EMC Regulations

N1709

Canadian Compliance

This Class A digital apparatus meets all requirements of the Canadian
Interference-Causing Equipment Regulations.

Cet appareil numérique de la classe A respecte toutes les exigences du
Reéglement sur le material brouilleur du Canada.

European Union Declaration of Conformity
(EMC and Safety)

C€.

Avid is authorized to apply the CE (Conformité Europénne) mark on this
compliant equipment thereby declaring conformity to EMC Directive
2004/108/EC and Low Voltage Directive 2006/95/EC.
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Safety Compliance

Safety Statement

This equipment has been tested to comply with USA and Canadian safety
certification in accordance with the specifications of UL Standards: UL60065 7th
/IEC 60065 7th and Canadian CAN/CSA C22.2 60065:03. Avid Inc., has been

authorized to apply the appropriate UL & CUL mark on its compliant equipment.

Warning

RISK OF ELECTRIC SHOCK
DO NOT OPEN

Important Safety Instructions

1) Read these instructions.

2) Keep these instructions.

3) Heed all warnings.

4) Follow all instructions.

5) Do not use this equipment near water.
6) Clean only with dry cloth.

7) Do not block any ventilation openings. Install in accordance with the
manufacturer’s instructions.

8) Do not install near any heat sources such as radiators, heat registers, stoves,
or other equipment (including amplifiers) that produce heat.

9) Do not defeat the safety purpose of the polarized or grounding-type plug. A
polarized plug has two blades with one wider than the other. A grounding type
plug has two blades and a third grounding prong. The wide blade or the third
prong are provided for your safety. If the provided plug does not fit into your
outlet, consult an electrician for replacement of the obsolete outlet.

10) Protect power cords from being walked on or pinched particularly at plugs,
convenience receptacles, and the point where they exit from the equipment.
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11) Only use attachments/accessories specified by the manufacturer.

12) For products that are not rack-mountable: Use only with a cart, stand, tripod,
bracket, or table specified by the manufacturer, or sold with the equipment.
When a cart is used, use caution when moving the cart/equipment combination
to avoid injury from tip-over.

13) Unplug this equipment during lightning storms or when unused for long
periods of time.

14) Refer all servicing to qualified service personnel. Servicing is required when
the equipment has been damaged in any way, such as power-supply cord or
plug is damaged, liquid has been spilled or objects have fallen into the
equipment, the equipment has been exposed to rain or moisture, does not
operate normally, or has been dropped.

15) For products that are a Mains powered device:
The equipment shall not be exposed to dripping or splashing and no objects
filled with liquids (such as vases) shall be placed on the equipment.

Warning! To reduce the risk of fire or electric shock, do not expose this
equipment to rain or moisture.

16) For products containing a lithium battery:
CAUTION! Danger of explosion if battery is incorrectly replaced. Replace only
with the same or equivalent type.

17) For products with a power switch:
The main power switch is located on the back panel of D-Command; it should
remain accessible after installation.

18) The equipment shall be used at a maximum ambient temperature of 40° C.

Do not attempt to service the equipment. There are no
user-serviceable parts inside. Please refer all servicing to
authorized Avid personnel.

WARNING

To reuce the risk of electic shock, do not expose this equipment
to rain or moisture.

Any attempt to service the equipment will expose you to arisk of
shock and will void the manufacturer’s warranty.

SPECIAL WARNING REGARDING VENTILATION:

Do not install D-Command anywhere or in any way that blocks
free air flow at any time around the back panel of the unit.

SPECIAL WARNING REGARDING AMBIENT TEMPERATURE:

Before powering on the D-Command unit, be sure to allow it to
reach room temperature. The unit includes some components
that are senstiveto cold temperatures, so itis recommended that
you unpack the unit and allow it to acclimate before turning it on
for the first time.
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A
Actions switch (automation) 91
After-Fader Listen (Monitor section) 99
All Notes Off switch 84
All switch (automation) 43
Alt outputs (Monitor section) 96
Arrow switches 80
Assign controls 51, 105

Inputs 51

Inserts 51

Outputs 51

Sends 51
Assign Matrix 117

/0 123

inserts 119

Lock Enable preference 118

preferences 117

sends 121
Assign Talkback switch 97
Attack/Q control (Dynamics plug-ins) 62
Audio Files switch 88
Audition Mode switch 78
Audition switches 78

Audition Mode 78

Mark In 79

Mark Out 79

Post-Roll 78

Pre-Roll 78
Auto Talkback switch 100
AutoMatch indicators 41
AutoMatch switch 91
AutoMatching automation 116
automation

AutoMatching 116

capturing 114

enabling for plug-ins 58, 130

encoder mode indicator 36

modes 113

plug-ins 53, 66, 73

previewing 113, 115

snapshots 114, 115

suspending 113
Automation controls 91

Actions switch 91

AutoMatch switch 91

Join 91, 115

Modes switch 92
Automation Enable controls 45

Inserts 45

Mute 45

Pan 45

Send Mute 45

Send Pan 45

Send Volume 45

Volume 45

Automation Mode controls 8, 49, 113

Latch 49

Off 50

Read 50

Touch 49

Trim 50

Write 49
Automation Mode indicators 41
Automation Mode switches 40
Automation Safe mode 54, 111, 130
Automation Safe switch (plug-ins) 66, 73
Automation Suspend switch 48
Automation switch (plug-ins) 66, 73
Automation Trim switch 40
Automation Write controls

Write to All 43

Write to End 44

Write to Next 44

Write to Punch 44

Write to Start 44
Automation Write To controls 43
Automation Write To switches

All 43

End 44

Next 44

Punch 44

Start 44

B
B/M/P (see Bypass/Mute/Pre)
Back and Play switch 79
Back switch 79
Bank Justification preference 26
bank size (Custom Faders) 126
Bank/Cycle switch
and Custom Fader mode 49
banking (tracks) 8
Broadcast mode (Monitor section) 99
Bypass switch (plug-ins) 66, 73
Bypass/Mute/Pre switch 111
Bypass/Mute/Pre switches (rotary encoders) 36
Show Values 45
Switch Info 45
Switch mode 45
Bypass/Spill switches (channel strips) 38

C

calibration
faders 31
meters 31

Calibration Mode switch 101
capturing automation 114
channel display modes 40
Channel Select switches
for channel strips 40
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for Monitor section 98
for plug-ins 64, 71
Channel Strip Function controls 39
Automation Mode 40
Automation Trim 40
Channel Select 40
display modes 40
Input Monitor Mode 39
Mute 40
Record Enable 39
Record Safe mode 39
Solo 40
Channel Strip Mode controls 37, 39
Bypass/Spill 38
Inserts 37
Mic Pre mode 38
Pan 38
Sends 39
channel strips 35
Channel Select switch 40
fader section 41
channels
focusing 40, 77, 109, 110
selecting 40
Clear Clip switch 84
clipping indication 84
Compare switch (plug-ins) 66, 73
connections
audio 20, 141
alt 143
control room 21
cue system 22, 141, 142
headphone 22
main 141, 142
solo outputs 143
stereo inputs 142
surround inputs 142
talkback/listenback 143
Ethernet 4, 9, 10, 19, 25
footswitch 9, 19
power 19
XMON 9, 12, 20, 143
Console Preferences 89
Meter 89
Operation 90
User 89
Custom Fader Flip mode 131
Custom Fader Hidden Tracks preference 28
Custom Fader Justification preference 27
Custom Fader Map modes 49, 131
and Custom Fader Plug-In mode 131
and Custom Groups mode 131
and Mix/Edit Groups mode 131
Custom Fader Mode indicators 41
Custom Fader modes 48, 125
Custom Groups 48, 126
Expanded Plug-In mode 130
Mix/Edit Groups 48, 127
Plug-In 48
Plug-in 129
Tracks 48, 129
Custom Faders 8
bank size 126
display 48
displaying plug-ins 49
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Groups switch 48
locking plug-ins 49
plug-in view definitions 28, 130

Custom Groups mode (Custom Fader) 48, 126

Cycle switch (plug-ins) 66, 73

D

D-Command Units
declaring 25
naming 26

Dim function 100
Dim Level control 101
Display Brightness 138
Display Contrast 139
Display Mode switch 47
Display preferences 29
Do To All switches 46, 47
Do To Selected switches 46, 47
Drive parameter (HEAT) 110
Dynamics (plug-ins) 8, 55, 61

gain reduction display 67
Dynamics plug-in controls

Attack 62

External Key 66

Filter Frequency 62

Gain 63

Hold 63

Hysteresis 62

Input 63

Key Listen 66

Knee 62

output 63

Q62

Range 62

Ratio 62

Release 62

Threshold 63

E
Edit controls 87

Edit Functions 87

Edit Modes 87

Edit Tools 88
Edit Function switches 87, 88
Edit window

navigation 8

playback of selections 75
Edit/Timeline switch 50
Enable Parameters switch 53
Encoder preferences 29
Encoder Select switches 36
End switch (automation) 44
EQ (plug-ins) 8, 55, 68
EQ plug-in controls

High 70

High-Mid 70

High-Pass 69

Level 70

Low Filter 69

Low-Mid 69

Low-Pass 70

Mid 69
Escape switch 46
Ethernet 4, 9, 10, 19, 25
External Key switch (Dynamics plug-ins) 66



=
Fader Module
attaching to Main Unit 17
back panel overview 10
components 3
hardware 15
placement 15
faders 41
calibration 31
Faders On/Off preference 26
Flip mode 43, 112
and Instrument tracks 43
Flip switches 43
Focus Channel 48
display 48
Focus mode (Channel Select switch) 40
focusing
channels 40, 77, 109, 110
plug-ins 56, 110
footswitch 9, 19
Footswitch settings 139
Forward and Play 79

G
Gain/Hold/Input control 63
Global Controls 8, 42
Global Modifier controls 46
Automation Suspend 48
Display Mode 47
Do To All 46
Do To Selected 46
Escape 46
Select/Focus 46
Set To Default 47
Solo Clear 48
Suspend Groups 48
Go To End switch 79
Go To Start switch 79
Go To switch 84
Group Status indicators 41
Group switch 86
groups
creating 128
deleting 128
editing 128
Groups switch (Custom Faders) 48

H
Headphone/Cue controls

Output controls 97
High Filter controls (EQ plug-ins) 70
High-Mid Filter controls (EQ plug-ins) 70
High-Pass controls (EQ plug-ins) 69

|
I/O Assign Matrix 123
I/O paths
assigning 124
Input controls (Monitor section) 96

Input Level Trim controls (Monitor section) 96

Input Monitor Mode switches 39

Input Source Sum controls (Monitor section) 96

inputs

assigning 105, 106

making inactive 108
inputs (Monitor section)

main 96

selecting 96

stereo 96

summing 96

surround 96

trimming 96
Insert Assign Matrix 119
Inserts 110
inserts

assigning 105, 112, 120

making inactive 108
Inserts switch (automation) 45
Inserts switches 37
Instant Playback switch 79
Instrument tracks 35, 36, 37, 52
into Utility 133

J
Join switch 91, 115

K

Key Listen switch (Dynamics plug-ins) 66
keyboard modifiers 42

Knee/Hysteresis/Q control (Dynamics plug-ins) 62

L
Latch switch (automation) 49
latching
solos 40
transport controls 75
Level controls (EQ plug-ins) 70
levels
inputs (Monitor section) 96
output channels (Monitor section) 98
outputs (Monitor section) 96
Solo modes (Monitor section) 99
Link Edit and Timeline switch 50
Listen controls 101
listenback
connections 143
Locate switches 79
Back 79
Back and Play 79
Forward and Play 79
Go To End 79
Go To Start 79
Instant Playback 79
location display 103
Lock Enable preference (Assign Matrix) 118
Lock switch (Custom Fader Plug-In mode) 49
Lock switch (plug-ins) 64, 71
Loop Playback switch 78
Low Filter controls (EQ plug-ins) 69
Low-Mid Filter controls (EQ plug-ins) 69
Low-Pass controls (EQ plug-ins) 70



M
Machine switch 78
Main Counter switch 50
Main inputs (Monitor section) 96
Main outputs (Monitor section) 96
Main Unit
components 3
top panel overview 7
Utility mode 133
Make Inactive controls 52, 108
Inputs 53
Inserts 53
Outputs 53
Sends 53
Management controls 86
Map switch (Custom Fader mode) 49
mapping
Custom Fader Map modes 131
plug-in mapping 59
Mark In switch 79
Mark Out switch 79
Master Link switch (plug-ins) 65
Master Record Enable switch 77
Maximum Custom Fader Bank Size preference 27
Memory Location switch 88
Memory Locations 94
Memory/MIDI controls
Memory Location 88
MIDI switch 88
meter display 103
Meter preferences 30
Meter switch 89
meters 8
calibration 31
plug-ins 73
reference levels 104
Mic Pre mode 38
Mic Select switches 101
Mid Filter controls (EQ plug-ins) 69
MIDI controls 37
MIDI switch 88
Mini (stereo) outputs (Monitor section) 96

Mix/Edit Groups mode (Custom Fader) 48, 127, 129

Modes switch (automation) 92
modifier switches 42
Monitor Output Mode controls
Calibration switch 101
Dim switch 102
Mono switch 102
Mute switch 102
Monitor section 95
Dim Level control 101
Input controls 96
Input Level Trim controls 96
Input Source Sum controls 96
Output Channel Select switches 98
Output controls 96
Output Level Trim controls 96
Studio controls 97
Talkback/Listen controls 100
monitoring 8, 95
Mono switch 102
multi-mode 81
Mute switch (automation) 45
Mute switch (Monitor section) 102
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Mute switches (channel strips) 40

N

Navigate Mode switch 80
navigation controls 8

Next switch (automation) 44
Nudge/Bank switches 8, 80
nudging (tracks) 8

O

Off switch (automation) 50
Operation switch 90
Output Channel Select switches (Monitor section)
Mute 98
Solo 98
Output Channel Trim mode (Monitor section) 98
Output controls (Monitor section) 96
Output Level Trim controls (Monitor section) 96
Output meter (plug-ins) 67
outputs
assigning 105
making inactive 108
outputs (Monitor section)
Alt 96
calibrating 101
channels 98
main 96
Mini (stereo) 96
selecting 96
trimming 96, 98

P
Page switch (plug-ins) 66, 73
Page switches (channel strips) 37
Pan switch (automation) 45
Pan switches 38
pinout diagrams 141
Playlist switch 86
Plug-In Automation controls 53
plug-in controls
Dynamics 8, 55, 61
EQ 8, 55, 68
Plug-In mode (Custom Fader) 48
Plug-in mode (Custom Fader) 129
plug-ins 8, 55, 61, 68
assigning 55
Automation Safe 54, 130
Automation Safe switch 66, 73
Automation switch 66, 73
Bypass switch 66, 73
bypassing 66, 73, 111, 130
Channel Select switches 64, 71
Compare switch 66, 73, 130
copying settings 58
Custom Fader mode 129
Cycle switch 66, 73
Dynamics 61
enabling automation 53, 58, 130
EQ 68
focusing 28, 56, 110, 129
Lock switch 64, 71
making inactive 57, 111
mapping 59
Master Link switch 65



meters 73
multichannel 55, 65, 71, 72
multi-mono 55, 65, 71, 72, 130
multiple plug-in windows 57
opening plug-in windows 56, 66, 73
Output meters 67
Page switch 66, 73
Save As switch 64, 71
Save switch 64, 71
Select/Link/Bypass Mode switch 65, 72
targeting 57
Window switch 66, 73
Post-Roll switch 78
Pre- or post-insert (HEAT) 110
Pre-Fader Listen (Monitor section) 99
Preferences (D-Command) 26, 138
Assign Matrix 117
Bank Justification 26
Custom Fader Hidden Tracks 28
Custom Fader Justification 27
Display 29
Display Brightness 138
Display Contrast 139
Encoders 29
Faders On/Off 26
Footswitch settings 139
Maximum Custom Fader Bank Size 27
Meters 30
Select Switch Latch mode 27
Sleep Mode settings 139
Touch Value 27
Pre-Roll switch 78
previewing automation 113, 115
Pro Tools Online switch 78
Publish switch 84
Punch Capture command 115
Punch switch (automation) 44

Q

QuickPunch switch 78

R
Ratio/Range/Frequency control (Dynamics plug-ins) 62
Read switch (automation) 50
Record Enable switches 39
Record Safe mode 39
Redo switch 84
reference level preference (meters) 104
Release/Frequency control (Dynamics plug-ins) 62
requirements
connections 4, 20, 141
operational 4
resetting D-Command units (Utility mode) 138
rotary encoders 35
automation mode indicator 36
Bypass/Mute/Pre Switch mode 45
display color 36

S

Save As switch (plug-in settings) 64, 71
Save switch (plug-in settings) 64, 71
Save switch (sessions) 84

saving settings 64, 71

scrolling
Scrub/Shuttle wheel 76
Scrub switch 77
Scrub/Shuttle controls 76
Scrub switch 77
Scrub/Shuttle wheel 76
Shuttle switch 77
Trim switch 77
Scrub/Shuttle wheel 76
moving windows 76
nudging tracks 77
scrolling 76
selecting 76
zooming 76
Select mode (Channel Select switch) 40
Select Switch Latch mode 27
Select/Focus switch 46
Select/Link/Bypass Mode switch (plug-ins) 65, 72
selecting
Scrub/Shuttle wheel 76
selections
playback from transport controls 75
Send Assign Matrix 121
Send Mute switch (automation) 45
Send Pan mode 39
Send Pan switch (automation) 45
Send Volume switch (automation) 45
sends
assigning 105, 112, 122
Automation Safe 54
making inactive 108
muting 111
setting pre- or post-fader 111
Sends switches 39
Session Management switches 8, 84
All Notes Off 84
Clear Clip 84
Publish 84
Redo 84
Save 84
Undo 84
Set To Default switch 47
Set Up switch (Monitor section) 98
Show Values switch 45
Show/Hide switch 89
Shuttle switch 77
slave tracks 37
Sleep Mode settings 139
Snapshot switch 86
snhapshots 114, 115
Soft Keys 8, 85
Automation controls 91
Console Preferences 89
Edit controls 87
Management controls 86
solo
focusing tracks 110
latching 40
output connections 143
Solo Clear switch 48
Solo Mode controls (Monitor section) 99
After-Fader Listen 99
Broadcast 99
Pre-Fader Listen 99
Solo Safe mode 40
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Solo switches 40

Solo/Mute switch (Monitor section) 98
Start switch (automation) 44

Stereo inputs (Monitor section) 96
Studio controls 97

Sum mode (Monitor section) 96
Surround inputs (Monitor section) 96
Suspend Groups switch 48

Switch Info switch 45

System Info (Utility mode) 134

T
talkback 97
connections 143
Dim function 100
External level control 100
Level control (built-in) 100
microphone (built-in) 103
Talkback switch 50, 100
Talkback/Listen controls 100
Auto Talkback switch 100
Listen 101
Mic Select switches 101
Talkback switch 100
targeting plug-ins 57
Test pages (Utility mode) 135
Threshold/Output control 63
time scale display 8, 103
Tone parameter (HEAT) 110
Touch switch (automation) 49
Touch Value preference 27
Track Size switches 93
Track switch 86
TrackPunch switch 78
tracks
Automation Safe 54
focusing 40, 77, 109, 110
making inactive 108
nudging 77
selecting 40, 109
Tracks mode (Custom Fader) 48, 129
transport controls 8, 75
latching behavior 75
Transport Master switch 78
Transport Mode switches 78
Loop Playback 78
Machine 78
Pro Tools Online 78
QuickPunch 78
TrackPunch 78
Trim mode (Monitor section) 98
Trim switch (automation) 50
Trim switch (Scrub/Shuttle controls) 77

)
Undo switch 84
Unit Name (Utility mode) 134
User switch 89
Utility mode 133
Reset Unit 138
System Info 134
Test pages 135
Unit Name 134
Utility switch 93
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VCA Master tracks 35, 36, 37, 38, 129
view definitions 28, 130
Volume switch (automation) 45

w

Window Configurations 94
Window Management switches 8, 83

Window switch (Custom Fader Plug-In mode) 49

Window switch (plug-ins) 66, 73
windows

moving 76

opening 83, 86
Write switch (automation) 49
Write to All (automation) 43
Write to End (automation) 44
Write to Next (automation) 44
Write to Punch (automation) 44
Write to Start (automation) 44

X

XMON 141
back panel overview 12
components 3
connections 9, 12, 20, 143
front panel overview 11

Z

Zoom Mode switch 80
Zoom Preset switches 80
Zoom/Navigate section
Arrow switches 80
Navigate Mode switch 80
Zoom Mode switch 80
Zoom Preset switches 80
zooming
Scrub/Shuttle wheel 76
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